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eZ-Analyst 926990  

Manual Layout 
This document is a reference manual for eZ-Analyst, its Menu options, associated Toolbar 
buttons, and resulting GUI screen images.  When deemed beneficial, examples were placed to 
supplement the primary material.  The document discusses eZ-Analyst in relation to 
ZonicBook/618E, WaveBooks, and IOtech 600 Series dynamic signal analyzers.  Differences in 
functionality are pointed out when of importance to the user. 

Ch 1 – Software Installation  
WaveBooks 
ZonicBook/618E 
IOtech 600 Series 

 

Ch 2 –  An Introduction to eZ-Analyst  Discusses eZ-Analyst’s measurement and 
playback modes. 

Ch 3 – Menus discusses the following menus: Task, File, Control, Export, and Window.   
The Edit Menu is discussed in chapter 4. 

Ch 4 – Edit Menu discusses the following windows: Configuration, Playback Setup, Display 
Preferences, and Output Channel Setup.  Note that the 640e and 640u analyzers have a 
relatively extensive section pertaining to output waveforms. 

Ch 5 – Toolbar Buttons identifies and shows the location of the toolbar buttons and 
provides a brief synopsis of their purpose. 

Ch 6 – Interactive Features of the Plot Display Window explains how to change plot 
display characteristics, including display functions, by using the window’s interactive 
features.  The chapter includes a section on cursor types and annotation options. 

Ch 7 – Waterfalls, Order Tracking, &  Slice Views discusses these display options 
available to eZ-Analyst users. 

Appendix A – Keyboard Controls for eZ-Analyst identifies keys for controlling plot 
display, menus, windows, and record/playback functions.  

Glossary 
 

 

Check the README.TXT file, if present, for information that may not 
have been available at the time this manual was released. 
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Software Installation  1 

 
WaveBooks …… 1-1 
ZonicBook/618E …… 1-3 
IOtech 600 Series …… 1-5 
 

WaveBooks 

System Requirements 
 

 

Certain WBK options are not supported by eZ-Analyst.  If you are using 
WBK options with WaveBook and intend to use eZ-Analyst, refer to the 
WBK support table on page 1-2.   

 
Before setting up the hardware or installing the software, verify that you have the following items. 

• WaveBook data acquisition system 
• Power supply with cord  
• For WaveBook/516E: Ethernet patch cable 
• Dynamic Signal Analysis CD 
• License Key for eZ-Analyst 
  

In addition, verify that your computer meets the following minimum requirements. 

• Monitor: SVGA, 1024 x 768 resolution 
• For WaveBook/516E: 10/100BaseT Ethernet port 
• Requires 32-bit version of Windows: Windows 2000 SP4, Windows XP, or Windows Vista (x86) 

     Windows 2000 SP4 and Windows XP Users: 
       PC with Intel™ Pentium 4 or equivalent;  1 GB memory; 10 GB disk space 

     Windows Vista (x86) users: 
PC must be Windows Vista Premium Ready 

• Optional, but recommended: 
      EPP (Enhanced Parallel Port), or 
      ECP (Extended Capabilities Port) 

 

Software Installation for WaveBooks 

 

Remove any previous-installed versions of WaveBook software before installing 
a new version. 

1. Start Windows. 

2. Close all running applications. 

3. Insert the Dynamic Signal Analysis CD into your CD-ROM drive and wait for the CD to 
auto-run. 

If the CD does not start on its own: 

(a) click the desktop’s <Start> button 
(b) choose the Run command 
(c) select the CD-ROM drive, then select the setup.exe file 
(d) click <OK> 

An Opening Screen will appear. 
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4. Click the <ENTER SETUP> button. 

5. From the hardware selection screen [which follows a licensing agreement], select 
WaveBook Systems from the drop-down list and follow the on-screen instructions. 

 

WBK Support for WaveBooks using eZ-Analyst 
 

WBK Option Supported 

WBK10A – Analog Expansion Module  - no - 
WBK11A – Simultaneous Sample & Hold (SSH) Card 3  
WBK12A and WBK13A – Programmable Filter Cards 3  
WBK14 – Dynamic Signal Conditioning Module 3  
WBK15 – 5B Isolated Signal Conditioning Module - no - 
WBK16 – Strain Gage Module - no - 
WBK17 – Counter-Input Module, with Quadrature Encoder Support - no - 
WBK18 – Dynamic Signal Conditioning Module 3  
WBK20A – PCMCIA/EPP Interface Card and Cable 3  
WBK21 – ISA/EPP Interface Plug-In Board 3  
WBK23 – PCI/EPP Interface Plug-In Board 3  
WBK25 – Ethernet Interface Module 3  
WBK30 – WaveBook Memory Options 3  
WBK40 and WBK41 – Thermocouple and Multi-Function I/O Modules - no - 
WBK61 and WBK62 – High Voltage Adapters - no - 

Information pertaining to these products is included in The WBK Options Manual, p/n 
489-0902.  
 

 

Reference Notes: 
 
 Adobe Acrobat PDF versions of documents pertaining to WaveBook are 

included on the Dynamic Signal Analysis CD and are automatically installed 
onto your PC’s hard-drive as a part of product support at the time of software 
installation.  The default location is the Programs group, which can be 
accessed via the Windows Desktop Start Menu. 
 

 After your software is installed you can setup your WaveBook device and 
connect it to the host computer.  Instructions for Hardware Setup are included 
in your WaveBook User’s Manual. 
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ZonicBook/618E 
 

WBK Support 

When used with ZonicBook/618E, eZ-Analyst supports WBK18 and WBK30. 

System Requirements 

Before setting up the hardware or installing the software, verify that you have the following 
items. 

•   ZonicBook/618E Data Acquisition System 
•   Power Supply with cord 
•   Dynamic Signal Analysis CD 
•   License Key for eZ-Analyst 
•   Ethernet Patch Cable 
•   Dynamic Signal Analysis CD 
•   License Key for eZ-Analyst 

 

In addition, verify that your computer system meets the following minimum requirements. 

• Monitor: SVGA, 1024 x 768 screen resolution 
• Ethernet jack [on PC or on a hub connected to the Ethernet] 
• Requires 32-bit version of Windows: Windows 2000 SP4, Windows XP,  

      or Windows Vista (x86) 
Windows 2000 SP4 and Windows XP Users: 

     PC with Intel™ Pentium 4 or equivalent;  1 GB memory; 10 GB disk space 
Windows Vista (x86) users: 

Software Installation for ZonicBook/618E 

PC must be Windows Vista Premium Ready 
 
 

 

 

Remove any previous-installed versions of eZ-Analyst software before 
installing a new version. 

1. Start Windows. 

2. Close all running applications. 

3. Insert the Dynamic Signal Analysis CD into your CD-ROM drive and wait for the CD 
to auto-run. 

If the CD does not start on its own: 

(a) click the desktop’s <Start> button 
(b) choose the Run command 
(c) select the CD-ROM drive, then select the setup.exe file. 
(d) click <OK>. 

 

An Opening Screen will appear. 

4. Click the <ENTER SETUP> button. 

5. From the hardware selection screen [which follows a licensing agreement], select 
ZonicBook/618E from the drop-down list and follow the on-screen instructions. 
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Reference Notes: 
 
o Adobe Acrobat PDF versions of documents pertaining to ZonicBook/618E 

are included on the Dynamic Signal Analysis CD and are automatically 
installed onto your PC’s hard-drive as a part of product support at the 
time of software installation.  The default location is the Programs 
group, which can be accessed via the Windows Desktop Start Menu. 
 

o After your software is installed you can setup your ZonicBook/618 and 
connect it to the host computer.  Instructions are included in the 
ZonicBook/618E User’s Manual, p/n 1106-0901. 
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IOtech 600 Series 
Dynamic Signal Analyzers for Vibration Analysis & Monitoring 

USB2.0 Models 
Applies to 640u, 650u, 652u, 655u, and 672u 
 
In addition to your 600 Series USB2.0 device, verify that you have the following items: 

• USB Cable 
• Dynamic Signal Analysis CD 
• License Key for eZ-Analyst 
• 32-bit version of Windows (Required):  

Windows 2000 SP4, Windows XP, or Windows Vista (x86) 
Windows 2000 SP4 and Windows XP Users: 
      PC with Intel™ Pentium 4 or equivalent 
      1 GB memory 
      10 GB disk space 
Windows Vista (x86) users: 
      PC must be Windows Vista Premium Ready 

 

Ethernet Models 
Applies to 640e and 650e  

In addition to your 600 Series Ethernet device, verify that you have the following items: 

• TR-2U Power Supply 
• Ethernet Patch Cable 
• Dynamic Signal Analysis CD 
• License Key for eZ-Analyst 
• 32-bit version of Windows (Required):  

Windows 2000 SP4, Windows XP, or Windows Vista (x86) 
Windows 2000 SP4 and Windows XP Users: 
      PC with Intel™ Pentium 4 or equivalent 
      1 GB memory 
      10 GB disk space 
Windows Vista (x86) users: 
      PC must be Windows Vista Premium Ready 

 
 

 
To Install the Software 
(Applies to all 600 Series devices) 

 
1. Close all running applications on the host PC. 

2. Insert the Dynamic Signal Analysis CD into your CD-ROM drive and wait for the CD to auto-run.  
An Opening Screen will appear. 

4. Click the <ENTER SETUP> button. 

5. From the hardware selection screen [which follows a licensing agreement], select the applicable 
600 Series device from the drop-down list and follow the on-screen instructions. 
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Reference Notes: 
 
o After the software is installed you can setup your 600 Series device and connect it to the 

host computer.  Instructions are included in a Quick Start shipped with the device. 

o Adobe Acrobat PDF versions of documents pertaining to 600 Series devices are included on 
the Dynamic Signal Analysis CD.  In addition, they are automatically installed onto your 
PC’s hard-drive as a part of product support at the time of software installation.  The 
default location is the Programs group, which can be accessed via the Windows Desktop 
Start Menu. 
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An Introduction to eZ-Analyst                                             2  

 
Features …… 2-1 
Measurement Mode …… 2-3  
Playback Mode  …… 2-5  
A Word About Configuration …… 2-6 

 

 
 

eZ-Analyst is the result of more than ten years of software 
development and customer input. This software adds real-
time continuous and transient data acquisition to Wave-
Books, ZonicBook/618E, and to 600 Series* dynamic 
signal analyzers.  Analysis can be in the time, frequency, or 
order domain. 

 
eZ-Analyst is operated through a series of  setup windows 
that display only the information deemed important to your 
test.  Acquisition configuration involves selecting desired 
acquisition parameters from user-friendly menus. 

 
 
 

 

Features 

• Real-time FFT analysis  

• Easy-to-use graphical user interface provides fast setup 

• Large number of display options: Time Waveform, Spectrum, Auto Spectrum,  
FRF, Cross, PSD, Transfer Function, Coherence, Octave, and Waterfall 

• Order Normalization and Order Tracked Plots 

• Multiple Plot Overlays using exported data files 

• Export to Excel, ME Scope, SMS Star, or UFF Type 58 ASCII or Binary 

• Save/Recall display setups with multiple display windows and overlays 

• Wide selection of real-time analysis features, including integration/differentiation 
averaging, and much more 

  
 

 
 

* Note: eZ-Analyst can be used for the dynamic channels of the 655 device, but not for the temperature channels.  If you will be   
using a 655 for temperature applications you will need to use other software, such as eZ-TOMAS or DASYLab. 
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Measurement Mode 
The Measurement Mode is an active data-collecting mode, which, for that reason, requires the use of 
data acquisition hardware.  The Measurement Mode can only be selected if an appropriate data acquisition 
device is used; otherwise, eZ-Analyst will run in the Playback Mode. 

The Measurement Mode acquires data using one of the following three methods:   
(1) Scope-Continuous, (2) Scope-Single, (3) Record.  

The Scope-Continuous and Scope-Single methods display data, but do not log data.  The scope 
methods are useful for signal validation and checkout. The Record method, in addition to displaying data, 
logs data-to-disk based on user-defined start and stop criteria. 

In addition to being selected from the Task Menu, the Measurement Mode can be selected from the 
Task Tool Bar by clicking the <Change Task Mode> button while in the Playback Mode.  Clicking this 
button from Measurement Mode will change the task mode tool bar to Playback. 

 
 

Measurement Mode Task Bar 

Note that grayed-out buttons indicate that the associated function is not available due to a prerequisite not being met. 

Change Task Mode 
 
Changes the task from Measurement Mode to Playback Mode, and visa versa. 
The Task Bar buttons will change accordingly. 

Record 
 

Starts recording data-to-disk in continuous time.   

Scope-Continuous 
 

Starts a block-time data acquisition.  This scope method is typically used to acquire impact data or 
to take measurements when data storage is not required. 

Scope-Single 
 

Starts a single-time run data acquisition.  This scope method is typically used to acquire impact 
data or to take measurements when data storage is not required. 

Signal Generator  The Signal Generator button toggles between two images and is only active when hardware is 
present.   

The sine wave button indicates that the generator is ON.  Clicking on it will turn the generator OFF 
and the button image will change to a circled red line, indicating that the generator is OFF.   

Clicking the button, while the “Off Status” image is present, will turn the Signal Generator back ON, 
and will change the button to show the sine wave image.  

Note:  For WaveBook applications you must set the applicable output channel  
(that is to generate the signal) to “Active.”  See, Output Channel Setup in chapter 4. 

Indicates that 
the Generator 
is turned ON 

 

Indicates that 
the Generator 
is turned OFF 

 

Cursor Lock 
 

An active cursor lock button will have the image of an opened or locked padlock.  When the 
padlock is locked (closed), cursors in multiple windows will be synchronized and locked, providing 
that the windows are of the same time domain, frequency domain, or have the same octave band 
data.  

An opened padlock image indicates that cursors in multiple windows have independent cursor 
movement, i.e., they are unsynchronized.  

Export 
 

This button exports data, if export conditions are set.  For details, see the section, 
Export Menu> Export Function Data. 

 

Scope-Continuous      Scope-Single      Record      Cursor Lock 

Change  
Task Mode 
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In addition to the preceding, the Measurement Mode can also display the following information: 
 
 

Averaging Status This field appears below the Change task Mode button when the Averaging Mode is used, during the Scope 
method.  A display of 2/5 would indicate that 2 averages have been performed out of a total of 5 averages to 
be performed. 

Error Indication If applicable, an error indication and button will display to the right of the buttons.  Examples of possible 
messages are: Double Hammer Rejected, Overload Rejected, Reject (Manual Reject Mode), and GAP.  If such 
an error is present, you can click the button to clear the erroneous data. 

Acquisition Status This status text appears to the right of the buttons to indicate the status of the acquisition. 

Waiting Trigger indicates that a trigger has not been recognized since the Acquire button was clicked. 

Triggered indicates eZ-Analyst is capturing and processing data based on the setup conditions. 

Acquiring indicates that data is being acquired, but is not being recorded to disk. 

Recording indicates that data is being recorded-to-disk, as it is being acquired. 

Completed indicates eZ-Analyst has finished processing the frame of data.  
The “Averages Count” increments by 1 at this time. 

Date/Time The Date and Time is indicated to the far right of the task bar.  While in the measurement mode it provides 
the current time in the following format:  Day-Month-Year, Hour: Minutes: Seconds. 
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Playback Mode 
The Playback Mode does not require the presence of physical hardware. When in Playback Mode,  
eZ-Analyst is strictly a post-acquisition display and analysis program.  Raw time-domain data, that has 
been recorded-to-disk, can be played back for analysis repeatedly. For example, a raw signal could be 
played back several times, each time using a different FFT Window algorithm to manipulate the 
original signal. Once the desired results have been achieved the new data can be exported in a new 
format and to a different file.  The original file can remain unchanged, and kept for future analysis. 

To activate the Playback Mode, select Playback/Review on the Task Menu.  An option is to click 
the <Change Task Mode> button (the first button in the tool bar) while in the Measurement Mode.  
If an analyzer (acquisition hardware) is not available eZ-Analyst will automatically enter the Playback 
mode and will display the data that was most recently recorded to disk. 

 

 

 

 
 

 

Averaging 
Status 

This field appears when the Averaging Mode is used, during the Scope Mode or the Playback Mode.  A 
display of 2/5 would indicate that 2 averages have been performed out of a total of 5 averages to be 
performed. 

Slider The slider indicates the record number of the displayed data. The record number and the number of 
records in the file are listed to the right of the slider bar.  The slider can be used to quickly locate a specific 
record.  The slider indicates the current record, except for when Averaging is enabled, at which time the 
slider indicates the next record to be averaged.  

Playback  
Status 

This status display shows the current record* and the total number of records

* With Averaging enabled the first number in the status display indicates the next record to be averaged.   

 in the data.   Example, 
 “Rec 12/25” means that the record currently displayed is the 12th record, out of a total of 25 records.  
 Time equivalents are included in parenthesis.   

Time Presented at the far right of the task bar (see figure, preceding page).  When in Playback Mode the 
measured time is displayed in Hours: Minutes: Seconds.   

 

You can modify three aspects of Engineering Units (EU) to customize 
your playback of data: EU Mode, mV/EU and EU Offset.   To change 
the settings navigate as follows:  Edit Menu >> Configuration >> Input 
Channels Tab; and then make the desired changes.  The new settings 
will be applied to your playback session.  Upon a reload of the project 
the original settings will be restored.  Chapter 4 includes additional 
information about the Configuration Input Channels tab.   

 
Section of Configuration 

Input  Channels Tab 

 

 

 

 

 1 Step Back plays backward one frame at a time. 
 2 Step Forward plays forward one frame at a time. 

Averaging Status                     Slider                                                         Playback Status 

Change                   Step       Play             Stop         Play       Step 
Task  Mode           Back1     Backward                    Fwd.      Fwd.2 
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A Word About Configuration 

 
Configuring Input Channels 

eZ-Analyst makes use of various menus and related windows for the purpose of configuration.  
Chapter 4 is devoted exclusively to the Edit menu.  It is that menu which provides access to 
the Configuration Window (see figure).  It is from the Configuration Window that the majority 
of acquisition related settings are made. 
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Menus  3 

 
Task Menu ……  3-1 

Measurement Mode…….3-1 
Playback Mode…….3-1 
Input Range (Auto/Manual)……..3-2 
Calibration………..3-3 

File Menu …… 3-7 
Control Menu …… 3-7 
Export Menu ……  3-8 
Window Menu ……  3-10 
Edit Menu …… see chapter 4 
Waterfalls, Order Tracking, and Frequency 

Slices ….. see chapter 7 
 

 

Reference Note: 
Refer to chapter 4 for information 
regarding the Edit Menu. 

  

Note! The “Edit Menu>Configuration> 
Preferences tab” section of chapter 4 
discusses a Measurement Mode panel.  
This panel is of importance to file 
overwrite protection, and should be 
read (see page 4-38).  

 
Refer to Chapter 7 for details regarding 
three spectrum only views: 3D Waterfall, 
Frequency Slice, and Spectrum Display 
Split View. 

Foreword 
The menus, with exception of the Task Menu and the Edit Menu, are presented in the order that they 
appear on eZ-Analyst’s main window.  The Task Menu is discussed first since it is from this menu that the 
user (1) selects Measurement Mode or Playback Mode and (2) makes use of the Auto-Ranging 
feature for input channels.   

The Edit Menu is perhaps the most significant of all eZ-Analyst menus and is the most frequently used.  
Chapter 4 is dedicated solely to the Edit Menu.  

 

Task Menu 

Task Menu >  Measurement Mode 
The Measurement Mode is an active data-collecting mode, which, for that reason, requires the use of 
data acquisition hardware.  The Measurement Mode can only be selected if an appropriate data 
acquisition device is used; otherwise, eZ-Analyst will run in the Playback Mode.  The Measurement Mode 
acquires data using one of the following three methods:   
(1) Scope-Continuous, (2) Scope-Single, and (3) Record.  

See the Measurement Mode

 

 section of chapter 2 for details. 

Task Menu >  Playback / Review Mode 
The Playback Mode does not require the presence of physical hardware. When in Playback, eZ-Analyst 
is strictly a post-acquisition display and analysis program.  Raw time-domain data, that has been 
recorded-to-disk, can be played back for analysis repeatedly. For example, a raw signal could be played 
back several times, each time using a different FFT Window algorithm to manipulate the original signal. 
Once the desired results have been achieved the new data can be exported in a new format and to a 
different file.  The original file can remain unchanged, and kept for future analysis. 

See the Playback Mode

 

 section of chapter 2 for details. 
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Task Menu > Input Range (Auto/Manual) * 

Auto-ranging is a procedure that 
automatically sets the input full-scale voltage 
(FSV) range for input channels.  The FSV is 
set by measuring a representative sample of 
real-time data.  Auto-ranging is only 
performed on active channels. 

Auto-ranging works best if you supply the 
maximum expected voltage range for the 
data that will be captured during the 
acquisition.  Therefore, make the Auto Range 
Duration long enough to apply a typical 
signal.  In addition, make sure that the Auto 
Range Analysis Frequency is fast enough 
to capture the high frequency component.  
Typically the Analysis Frequency will be 
the same setting as eZ-Analyst’s Acquisition 
Analysis Frequency. 

 

 

* You can access the dialog box by clicking the <Auto Range> button, which is located on the 
Input Channels tab, when in the “Measurement Mode.” 

 

Mode 
The Mode panel consists of three radio buttons, which are used to select one of the following 
range modes:  AutoRange(%), AutoRange(V), or ManualRange(V). 

Starting FSV 
The Starting FSV (Full Scale Voltage) panel consists of three radio buttons, which are used to 
set the starting FSV to Maximum, Minimum, or Current. 

Channel Gauges 
The channel gauges, one per channel, display the instantaneous peak value as percentage or 
voltage, depending on the mode that was selected.  The color of the vertical bar has the 
following significance: 

Yellow The signal range is from 0 to the minimum Full-Scale Voltage set in the Auto-range Setup 
window. 

Green The signal range is from the minimum to the maximum of the Full-Scale Voltage set in the 
Auto-range Setup window. 

Red The signal range is over the maximum of the Full-Scale Voltage set in the Auto-range Setup 
window. 

 

%, FSVF, & Factors Display 
Maximum FSV is the high-end limit for the input voltage.  
Note that 25.7 V is the highest possible FSV for a ZonicBook 
Medallion. 

Minimum FSV is the low-end limit for the input voltage.  In 
the figure at the right Minimum FSV is set to 0.2 volts. 

HI Accept % defines the highest acceptable percentage of 
peak input voltage for the selected FSV, i.e., Current, Minimum, or Maximum.  Thus, if 
our selected FSV was 0.2 V and we had an upper limit of 90%; then our upper limit in 
volts would be 0.18 V.  An example follows as to how exceeding this value causes a range 
adjustment. 

LO Accept % defines the lowest acceptable percentage of peak input voltage for the 
selected FSV, i.e., (Current, Minimum, or Maximum).  Thus, if our selected FSV was 0.2 V 
and we had a lower limit of 10%; then our actual low limit in volts would be .02 V. 

AutoRange Dialog Box, from a WaveBook 

Note that AutoRange Dialog Boxes for other analyzers are similar. 
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Incr Factor (Increasing Factor) is the factor by which the Current FSV will increase, should 
the peak exceed the upper limit.  In the figure we see that the Increasing factor is 1.5. 

Decr Factor (Decreasing Factor) is the factor by which the Current FSV will decrease, 
should the peak not reach the lower limit.  Keeping the decrease factor at “1” will result in no 
decrease of the Current FSV.  Setting the Decrease Factor to 0.8 would cause the Current FSV 
to decrease to 80% of its value if the peak fell short of the low limit.    

 

 Note:  These are the same values that were entered in the Vpeak column in the Channel Setup 
window. The values are immediately replaced when the Auto ranging process begins.   

An Example of Auto-Ranging 
Maximum FSV set at 25.7 V 
Minimum FSV set at 0.2 V 
Upper Limit set at 90% 
Lower Limit set at 10% 
Increasing Factor set at 1.5 
Decreasing Factor set at 1 

In this example we have set the radio button for 
Current FSV instead of Minimum or Maximum 
(note 2).  The starting value, in the example, is 0.20 V. 
 

 
In the first iteration we see 
that we have a peak of 0.19 V.  
This falls outside of our band of 
0.02 to 0.18 V that was 
established by our upper and 
lower limit percentages; i.e., 
90% of the Current FSV and 
10% of the FSV.  

 

An Example of Auto-Ranging 

As a result, the Current FSV is increased by a factor of 1.5 (our Increasing Factor) and the 
Current FSV becomes 0.30 V.  Our limits, in volts, also changed since we are now looking 
at percentages of 0.30 volts instead of the same percentages of 0.20 volts. 

In the second iteration of our example, we see a 0.22 volt peak.  This value is within our 
established limits so the Current FSV does not change. 

Note 1:  If the Capture Mode is the Input Channel (Trigger Mode), the Auto Range process waits for a 
trigger. 

Note 2:  A Start FSV of Minimum or Maximum can selected instead of Current FSV, as in our example.  
Minimum FSV is the default. 

 

Task Menu > Calibration  
When calibration is performed, a signal of known Peak level [or RMS value] is supplied to a 
transducer that is connected to an active input channel.  An accelerometer calibrator or piston 
phone is typically used to generate the calibration signal for vibration sensors and microphones, 
respectively. 

Examples: 

Accelerometer calibrators typically make use of linear engineering 
units and, as their name implies, are used for calibrating 
accelerometers.  

Piston phones are most often used for calibrating microphones.  Piston 
phones typically make use of decibel (dB) engineering units. 

 

eZ-Analyst includes a Calibration window for selecting the channels to be calibrated and for 
entering several signal-related parameters.  In addition, the calibration is actually started from 
the window. 
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When you are in “Measurement Mode” you can access the Calibration window from the Task 
Menu or from the Input/Output Channels tab. 

 
Calibration Display Screen 

 

When a channel is calibrated, the number of averages used will be 5, or the 
number that is designated in the “No. of Averages” field (located on the 
Analyzer Tab).  The greater of the two values will be used, automatically. 

 

A discussion of the various regions of the Calibration window now follows. 
The section concludes with an example. 

Calibration Process 

Single 
Channel 

Used to select one active channel at a time.  When the calibrator only has 
one channel output, the Single Channel method must be used.  When 
Single Channel is selected, the “Active” column shows a radio button next 
to each channel. 

Multiple 
Channel 

Used to select two or more channels for simultaneous calibration.  This is 
only an option when the calibrator offers more than one output.  When 
Multiple Channel is selected, the “Active” column shows a checkbox next to 
each channel. 

 

Calibration Domain 

With the use of Fourier Transform, any signal can be viewed from a time domain or a 
frequency domain.  Either domain can be selected for use in the calibration process.  

Time The overall value is computed using time domain data. 

Freq-
uency 

The overall value is computed with frequency domain data by summing up 
frequency component of FFT spectrum. 

 

Calibrator Frequency  (Hz) 
This field is used to enter the frequency setting of the calibrator. The analysis frequency, 
which is twice this frequency, is used if possible.  Otherwise, the maximum allowed 
analysis frequency is used. 
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Columns on the Calibration Window 

No. This column displays channel numbers [1, 2, 3, … etc.] for easy reference to 
their associated cells.   The channel numbers, being for display indication only, 
are fixed and can not be edited. 

 
Active   When “Single Channel” is selected, you can click on a radio button in the 

“Active” column to enable one channel for calibration.  When the calibration is 
complete, select the radio button for the next channel to be calibrated. 

When “Multiple Channel” is selected, the radio buttons are replaced by 
checkboxes.  Ensure that each channel to be calibrated has the associated box 
checked, and that the remaining channels remain unchecked.  For multiple 
channel applications note that you can click on the column label, i.e., the word 
“Active” to simultaneously check or uncheck all channel checkboxes in the 
column. 

Note:  The channel settings in the Calibration window are independent of the 
selections that appear in the Input Channel Setup window.  Only active 
channel shows up at calibration window. 

 
 

Calibrator 
Type 

This column is used to select Peak or RMS* as the calibrator type.   Highlight a 
cell, or range of cells, in the grid, then select Peak or RMS from the popup 
menu. 

Peak  Uses the peak amplitude of the spectrum around the specified frequency of the 
calibration signal. 

RMS  Uses a compensated overall level calculation to determine the RMS level of the 
calibration signal, as specified in the Units field. 
 
*RMS – Root-mean-square, is the square root of the arithmetic mean of the 

squares of a set of numbers. 
 

Calibrator 
Scale  

This column is used to select the calibrator scale to linear or to decibel. 

Lin  Select Lin if the calibrator is in linear scale. 

dB  Select dB if the calibrator scale is dB. 

Note:  While there are several definitions to dB, in our application we are 
using dB to express the ratio of the magnitudes of two quantities equal 
to 20 times the common logarithm of the ratio. 

The formula for dB is: 

 dB = 20 log (x/dBEUref) 

 
EU dB 
Reference  

This field is used to enter the Engineering Units dB reference. 

 dB EU Reference is applied to displayed data when the Y-axis scale is set to dB.   
This is valid only for frequency domain data. 
Note:  The dB Reference (Volt) can be changed simultaneously for all channels 

from the associated entry box in the FFT Setup Tab.  The tab is accessed 
from the Configuration Window [via the Edit pull-down menu]. 

 The formula for dB display for Unaveraged Spectrum, Averaged Spectrum, and 
FRF is: 

 dB = 20 log (x/dBEUref) 
 The formula for dB display for Autospectrum, Cross Spectrum, and PSD is: 

 dB =10 log [x/((dBEUref)^2)] 
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Calibrator 
EU 

This field is used to set the Calibrator’s Engineering Units. 

 
Measured 
mV 

Displays the measured value of the channel in milli-volts. 

 
Transducer 
mV/EU 

 

The Transducer mV/EU value can be entered manually, or by the 
measurement process.  Highlight a cell, or cells, in the grid before typing a 
value in the data entry box. Then press the <OK> button to accept the 
value. All other fields linked to this value are updated when the value is 
accepted. 

mV/EU= Volts/Units * Transducer Gain 

 
EU Offset EU Offset is used for DC signal compensation.  Offset is added to, or 

subtracted from the measured EU value. 

 
Transducer 
Gain 

Transducer Gain is used as auxiliary scaling to compensate for the 
transducer amplifier gain.  Gain is a multiplied function. 

 
 

Calibration 
Date  

This column displays the date and time of the last calibration.  If any 
channel value changes, even if the original number is restored, the 
calibration date and time are automatically removed for that channel. 

 
Start 
Calibration 
Measurement  

Clicking this button starts the calibration process for all selected channels.  
At the completion of the calibration, the measured mV and the Transducer 
mV/EU value for the applicable channels are automatically updated. 

 

Calibration Procedure, an Example 
Accelerometer type - Piezotronics 303A03 
Calibrator - Piezotronics 394B05 - 1.02 G (RMS) at 80Hz  
Unit of acceleration - in/sec^2 

Note: 1.02 G RMS is equivalent to 393.811 in/sec^2 (1G=386.089in/sec^2).  
This is a linear scale, thus we will be selecting Lin in the Calibrator Scale column. 

 
In this example we will be calibrating channel 1. 

1. Attach the accelerometer to the calibrator (signal source).  Connect the other end of the 
accelerometer cable to the channel 1. 

2. Set the FSV into a proper range (i.e. 32.4 mV) in the Input Channels Setup window, 
then click the <Apply> button.  

3. Set the desired blocksize in the Analyzer Tab if a block size of greater than 4096 is 
desired.  

4. Set the “No. of Averages” in the Analyzer Tab if an average count of greater than 5 is 
desired. 

5. Open the Calibration Window from the Task Menu, or from the Input/Output Channels 
Tab. 

6. Select “Single Channel.” 

7. Select “Auto Range,” if desired. 

8. Select a Calibration domain.  In this case, either “Time” or “Frequency” can be selected. 

9. Enter 80 Hz in the Calibrator Frequency field. 

10. Ensure the radio button for Channel 1 is enabled (in the Active column.) 

11. Select RMS for the Calibrator Type.   

12. Select Linear in the Calibrator Scale field. 
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13. Leave EU dB Reference set at 1.000. Note that this step can be skipped when linear 
scale is used. 

14. Set Calibrator EU at 1.02 ; implying an engineering unit of 1G. 

15. Enter 393.811 in the Transducer mv/EU field.  

16. Leave the EU Offset at 0.0000.  We are assuming no offset in this example. 

17. Leave 1.000 as the Transducer Gain.  No amplifier or attenuator is being used in our 
example. 

18. Click <Apply> so your new values will not be lost. 

19. Click the <Start Calibration Measurement> button to begin calibration. 
 

 

File Menu 
The File Menu provides a means to print plotted data, as well as open, save, and export data files.    

Open Time History Data Used to locate and open saved .dsc files.   

Save [or Open]  
Multiple Data Set (.mds) 

These two menu items provide a means of saving [or opening] 
function files. Time and auto-spectrum data is saved. If there is 
any reference channel cross-spectrum is saved for all channel 
pairs. The file extension is .mds. 

Save [or Recall]  
Hardware Setup (.set) 

These menu items provide a means of saving [or recalling] current 
settings and processing conditions.  In addition, .mds files can be 
used to recall setup conditions, because these file-types include 
setup conditions in addition to measured data.  Note that only the 
setup condition is recalled. 

Save [or Recall]  
Plot Setup (.pset)  

 

These two menu items provide a means of saving [or recalling] the 
current plot condition, such as window locations and window 
content, including: channel numbers, function type, axis-type, and 
range.  These files can be recalled at a later date to process 
customized plot conditions. 

Without user intervention, the plot setup file is automatically saved 
with .mds and .dsc files. 

 

You can have plot setups automatically recalled whenever 
you recall data files.  To select this option, open the 
Preferences window [accessed through the Edit pull-down 
menu] and check the box labeled “Recall Plot Setup When 
Recall Data Files.”   

Print 

 

The standard print window associated with your specific computer 
will open.  Select a printer and the number of copies needed before 
clicking <OK>.  When printing, note that that black plot back-
grounds change to white. 

Authorization Opens an Authorization Dialog box that provides a means of 
entering a license key (authorization code).  Use of the key enables 
the features of purchased software, such as 
eZ-Analyst.  The dialog box includes an option to run a 30-day trial 
version of eZ-Analyst. 

Exit This menu item closes the eZ-Analyst application. 

Control Menu 
 

The Control Menu selections provide the same functionality as the Task Bar buttons previously 
discussed. 
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Export Menu 

Export Menu >  Time History Data … 
This window is used to export recorded files as 
one of four file formats: Text (ASCII),  
UNV Binary, UNV ASCII, and RPC III. 

Source Information Panel 

This panel, located at the top of the window, 
contains basic information about the source file 
(see figure). 

 

Destination Information Panel 

1. Select the radio button associated with the 
desired file format; i.e., the format you want 
to export the data as, for example: RPC III as 
in the figure.  (See notes below). 

2. In the Filename data entry box, type the 
directory path and file name for the recorded 
file, or use the <Browse> button to locate the 
desired file.  The correct file extension will be 
appended to the file name later, when the 
<OK> button is clicked. 

3. Specify the First (Starting) and Last (Ending) 
records (blocks) that you want saved.  In the 
figure, “1” (0.0000 sec) is specified for the  
Starting Block and “601” (240.4 sec) is 
specified for the Ending Block. 

 
Step 4 follows on page 3-12. 
 
 

 

The RPC III file format does not represent tach channel RPM data in a meaningful way.  If 
you (a) select RPC III as the export file format and (b) have a Tach channel in the list of 
channels selected for export, then the resulting tach channel in the RPC III file will 
contain invalid data.    

  

Note: When RPC III is selected you have the choice of exporting your data in either of two 
formats, Integer or Floating Point. 

 
 • Integer – When RPC III is selected, the 16-bit signed Integer format is set by 

default.  Integer is the preferred and more commonly used format for exporting data.   
 
Note that there may be clipping of data when a high EU Offset value is present.  A channel’s EU Offset 
is configured in the Input Channels tab of the Configurations Settings window. 
 

• Floating Point – As an alternative to Integer, you can choose to export data to RPC III double precision 
Floating Point format.   Floating Point provides greater resolution and dynamic range than that provided 
by the Integer format.  Floating Point is a more recent format that may not be supported by all third party 
software.   

 
  

Export Window 
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4. Specify the channels of interest.  Click to place a checkmark in the channel box for each of 
the channels you want to export.  The selected channels will be adjusted to continuous 
channels starting with channel 1, but all the properties [including labels] will retain the old 
definition.  For example, selected channels 1,3,5,6,8,16 would be adjusted to channels 
1,2,3,4,5,6 in the exported file. 

5. If desired, change the gain and/or offset values on a per-channel basis. 

 6.   Click the <OK> button. 
 

Export Menu >  Function Data Set(s) 
This menu item is for exporting function files. 

 
Export Function Data 

 
1. Select the type of file you want. 

2. Type the directory path and file name for the function file, or use the <Browse> button to 
locate the desired file.  

3. If you want to have records automatically appended to the specified file, select Automatic 
Save after Averaging. 

4. Specify either All Ch. Pairs, or Displayed Ch. & Functions. 

• All Ch. Pairs - exports all the data for all the channels pairs so that all functions 
can be retrieved if desired. 

• Displayed Ch. & Functions - exports only the data for the displayed functions. 

5. Click to place a checkmark by each of the functions to be saved.  See the following note. 

6. Click <OK>. 
 

 
Note:  Selected functions can not be saved without the display of a warning prompt.  This is in 

case the selection is not valid.   For example: if the functions FRF, Cross, and Coherence 
were selected, but no reference channels were selected, then the three functions could 
not be saved.  This is because these three functions require a reference channel. 
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Window Menu 
Menu Items 

Add Function View (FV) …… 3-10 
Add Strip Chart …… 3-10 
Delete Window …… 3-11 
Input Channels …… 3-11 

Buttons ……3-11 
Status  …… 3-11  
Locations….… 3-12 
Tachometer …… 3-12 

Acquisition Setup …… 3-12 
Measurement Status …… 3-17 
User Comments ……3-13 
Cascade …… 3-14 
Tile Vertically ……3-14 
Tile Horizontally …… 3-15 
Refresh Windows …… 3-15 
 

 

Reference Note: 
For information regarding the interactive features of Plot Display Windows, 
including the Graphic Toolbar buttons, refer to chapter 5.  The interactive features 
are not selected from the Window Menu, but are accessed via toolbar buttons, the 
mouse and/or hotkeys.  Appendix A provides tables of the various hotkey 
functions. 

 

Window Menu  > Add Function View (FV) 
This menu selection opens an additional plot window. 

Example of an Added Function View 

 
 

 

Reference Note: 
Three buttons become enabled at the right side of the main window toolbar for 
most single-display function views (FV), i.e., when frequency is used for the x-axis 
scale instead of time.   
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Window Menu  > Add Strip Chart 

This menu selection opens a strip chart plot window.   

 
Example of an Added Strip Chart 

Window Menu  > Delete Window 
Deletes the window that is currently in focus.  When multiple plot windows are open, one is 
always the “focus window.  When a window does not have focus, its title bar is dimmed.  To 
change the “focus window,” simply click on top or side border of the window of interest. 
 

Window Menu  > Input Channels 
The Input Channels window is selected from the Windows pull-down menu.  

Buttons 

When selected, “Buttons” removes the channel button boxes from the toolbar and displays 
them in a floating window.  The buttons are used in the exact same manner as when they were 
located on eZ-Analyst’s main window.  Removing the checkmark from “Buttons” places the 
channel buttons back onto the toolbar.  Note that the <Input Channel Buttons> button [located 
on the toolbar, just to the left of where the channel buttons reside] provides the same 
functionality.  See chapter 5 for location. 

• To add a channel: use the mouse to click and drag a channel box from the 
complete channel button display into the plot area. 

• To remove a channel: use the mouse to click and drag a channel box (from the 
right-side of the plot) into the plot area. 

Status 

The Status dialog box (following figure) uses a chart to indicate the followings:  

• Volts linear 
• percent of the Full-Scale Voltage (FSV) 

The status box includes “maximum” bars to show the highest level of signal value reached by 
each channel during the measurement process. 

 
Status 

 Meas V Measured Voltage 

 +/- FSV The Full-Scale Voltage 

 Delta % The percentage difference between the measured voltage 
and the Full-Scale voltage, such that Meas V is n% of FSV; 
with n being the value of Delta %. 
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Locations  
This window displays the current modal locations.  

 
Modal Locations Window 

Clicking on the left or right arrow keys increments or decrements the modal locations based on 
the bank setup criteria set in the Configuration - FFT Setup Tab.  The change in locations is 
dependent upon the active reference and response channels, and whether Response Increase or 
Reference Increase is selected. 

Tachometer                                                    

 

Tachometer 

This window displays three fields: tachometer channel number, measurement, and units.  
Tachometer channels are set up in the Input Channels Window.  See the Tach Channels 
section of chapter 4 for additional information.   

    Window Menu  > Acquisition Setup 
Selecting “Acquisition Setup” brings up a display of setup information pertaining to the 
acquisition, e.g., Analysis Frequency, Blocksize, Trigger, Mode, etc.   

 

Acquisition Setup 
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Window Menu  > Measurement Status Panel 

 
The Measurement Status Panel and Modal Locations Window 

on Top of a Plot Window 
 

Note: The bracketed letters pertain to definitions provided in the following text. 

The panel provides basic, but important information, including trigger and processing 
conditions, and reference and response coordinates.  Status Areas of the panel are as follows: 

[A] – Averaging Status.  Displays the number of measurements completed followed by the total 
number of measurements.  For example, “1/6” indicates that 1 of 6 measurements has 
been completed. 

[B] – Trigger/Processing Status.  Displays the following: 
T – Triggered 
W- Waiting for Trigger 
S – Saved the data 
C – Completed measurement 
O – Overload rejected 
D (with yellow background) – Double Hammer Rejected 
  

[C] – First Response Coordinate.  Shows the channel number and the modal location.  (Note 1) 
[D] – First Reference Coordinate.  Shows the channel number and the modal location.  (Note 1) 

Note 1:  A Response or a Reference Coordinate with a yellow background indicates that the 
field is used for the “increasing” method.  For example, the Response Field (figure, 
item “C”) with a yellow background means that the response increase method is 
being used.  This is discussed in the FFT Setup Tab section of chapter 4. 

Note 2: Measurement Status indicators are disabled when recording.  

The large size of the status areas allows the user to see the measurement status from a 
relatively long distance, i.e., as compared to the very limited viewing range offered by 
standard-sized GUI text display fields.  The feature has proven useful in one-man “impact-
testing” operations pertaining to modal type measurements.  

 

Window Menu  > User Comments 
Selecting “User Comments” brings up a size-adjustable 
dialog box, which consists of a text field.  User Comments 
provides the user a means by which he or she may review 
previous comments and add new ones. 
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Window Menu  > Cascade 
When you have multiple plot windows open, this menu selection arranges them on you screen 
as shown. 

Example of using Cascade with three Plot Windows 

 

Window Menu  > Tile Vertically 
When you have multiple plot windows open, this menu selection arranges them on your screen 
as shown.  The Graph Toolbar, discussed in chapter 5, includes a button to allow for quick 
vertical tiling. Refer to that chapter for button descriptions and locations. 

 
Example of using Vertical Tile with two Plots 

Each plot is longer in the “vertical” direction. 
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Window Menu  > Tile Horizontally 
When you have multiple plot windows open; this menu selection arranges them on your screen 
as shown.  The Graph Toolbar, discussed in chapter 5, includes a button to allow for quick 
horizontal tiling. Refer to that chapter for button descriptions and locations. 

 

 
Example of using Horizontal Tile with two Plots 

Each plot is longer in the “horizontal” direction. 

 

Window Menu  > Refresh Windows 
Used to refresh a window; for example, to refresh a Strip Chart.  In this case, the 
refresh function blanks out the present Strip Chart, essentially providing you with 
a new, clean window. 
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Edit Menu   4 

 

 

The “Edit Menu>Configuration> Preferences tab” section discusses a  
Measurement Mode panel.  This panel is of importance to file overwrite 
protection; and should be understood (see page 4-41).  

 

The Edit Menu provides a means of configuring eZ-Analyst in regard to both functionality 
and appearance.  The menu contains the following selections: 

 
Configuration Window …… 4-1 

Analyzer Tab …… 4-3 
Input Channels Tab …… 4-16 
     Analog Input Channels …..4-17 

        Tach Channels ….. 4-20 
FFT Setup Tab …… 4-26 
Recording Setup Tab …… 4-33 
Block Rejection Tab …… 4-36 
Octave Setup Tab …… 4-38 
Preferences Tab …… 4-40 

Output Channel Setup ….. 4-44 
ZonicBook/618E and WaveBook Waveform Output …… 4-44 
640u and 640e Waveform Output …… 4-46 

Playback Setup Window ……  4-56 
Display Preferences Window …… 4-57  
 
 

Edit Menu  > Configuration . . .  
 

Configuration provides a means of changing the majority of eZ-Analyst settings in regard to 
how data is collected and conditioned.  

The Configuration selection displays one of several tab dialogs as listed in the preceding 
contents and discussed in the following pages.  Before reading about the Analyzer tab you 
should read page 4-2, which contains important information on frequency resolution.     
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A Note Regarding Frequency Resolution  
 
This note pertains to frequency resolution and is related to the values seen in the Analyzer Tab’s 
Acquisiton Panel (next two figures).  The frequency resolution is related to the Analysis Frequency 
(bandwidth), the number of spectral lines, and the Nyquist factor (a user-selected variable).  
It is also related to the number of data points in one block of data (the blocksize).  The program 
automatically adjusts the blocksize to maintain the selected spectral lines. 
The following equations apply. 
 
b = S (n)  and   S = b / n 
w = b  /  (n x f)  and   w = S / f 
Where: 

S = Spectral Lines 
w = Frame Width (in seconds) 
b = Blocksize 
n = one of 3 selectable  
   Nyquist Factors.  These are: 
   2.56, 5.12 and 10.24 
f = Analysis Frequency 

 
“Delta X” Frequency = 1 / w 
Where: 

“Delta X” Frequency is the frequency resolution 
w = Frame Width 
 

 
With these equations we can see how the Frame Width and Delta X (Frequency) are calculated. 
 

Example 1 (see figure) 
 
Given: 
Analysis Frequency 2000 Hz 
Spectral Lines 800 
Nyquist Factor  

 
Acquisition Panel on 

the Analyzer Tab 
The values shown pertain to example 1. 

 
Speed Range and Order Range are the 
theoretical limits for RPM and Orders 
based on the current settings for  
Analysis Frequency, Spectral Lines, 
and the Nyquist Factor. 

2.56 
 
w = S  / f 
     = 800 / 2000  
        = 0.4 seconds 
 
Also, since blocksize equals 
Spectral Lines times Nyquist 
factor ( S x n) we would have 
a blocksize of 2048, i.e.,  
800 x 2.56.  Thus: 
 
 w = b  / 2.56 x freq. 
     = 2048 / (2.56)(2000)  
        = 0.4 seconds 

 
Delta X (Freq)  = 1/w 
                         = 1 / 0.4 
                         = 2.5 Hz 

Example 2 (no figure) 
 
Given: 
Analysis Frequency 5000 Hz 
Spectral Lines   50 
Nyquist Factor 

Note:  A “Delta X” Freq. of 2.5 Hz indicates a higher frequency resolution than a “Delta X” Freq. of 100 Hz. 

2.56 
  
w = S / f 
        = 50 / 5000  
        = 0.01 seconds 

 
Delta X (Freq)   = 1/w 
                           = 1 / 0.01 
                           =  100 Hz 

 
Higher frequency resolutions indicate that the signal trace will be based on more data 
points for a given time frame.  The higher the frequency resolution, the smoother the trace 
will be. 

 
  

With other factors unchanged . . . 
 Increasing Spectral Lines increases Frequency 

Resolution. 
 Increasing Analysis Frequency decreases Frequency 

Resolution. 
 Increasing the Nyquist Factor results in a higher 

blocksize (more data points).  The number of spectral 
lines remains constant, unless changed by the user. 

 
The lower the “Delta X” frequency, the higher the 
Frequency Resolution.  Thus, a “Delta X” Frequency of 
6.25 Hz indicates a higher frequency resolution than does 
a “Delta X” Frequency of 100 Hz. 
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Edit Menu > Configuration >                                                    Analyzer Tab    

 
 

The Analyzer Tab 
consists of four 
panels: 

Acquisition 

Filters 

Trigger 

Averaging 

 
  

Analyzer Tab 

Edit Menu > Configuration > Analyzer Tab:  Acquisition Panel 

The Acquisition Panel provides a means of setting Analysis Frequency (in Hz or CPM), Spectral 
Lines, and Nyquist Factor.  The Acquisition frame has a note stating the calculated values for 
Frame Width, Delta X (Time), and Delta X (Frequency).  Two examples are presented on the 
preceding page.   "Speed Range" and "Order Range" are included in the on-screen note.  They 
are the theoretical limits for RPM and Orders based on the current settings for Analysis 
Frequency, Spectral Lines, and the "Nyquist Factor. 

Analysis Frequency:  This section of the Acquisition Panel is used to set the maximum 
bandwidth for analysis. Frequency components above the Analysis Frequency setting will 
result in aliasing errors in the data. The bandwidth measurement can be set for Hertz (Hz) or 
Cycles Per Minute (CPM) by use of radio buttons.  Note that the processing time for a selected 
blocksize is fixed by CPU speed. 

Increasing the analysis frequency results in:  
(a) the hardware streaming packets of data more frequently to the software 
(b) a greater demand placed on the software to process the data blocks, and  
(c) less time between data blocks available for task performance. 

Spectral Lines:  This section of the Acquisition Panel is used to set the number of spectral 
lines.  You can multiply the spectral lines by the nyquist factor to find out the number of data 
points in a frame or block of data.  Blocksizes, which are automatically determined (spectral 
lines times nyquist), can range from 128 to 16384 data points.  A blocksize can be viewed as 
a chunk, or packet of data that moves through software algorithms.   

As the number of spectral lines increases, the amount of data increases, the time required to 
acquire a block of data increases, and the amount of space required to save the data 
increases.   

Nyquist Factor:  A user-selected factor, for which waveform frequency is multiplied by, to 
ensure that a sampled analog signal is accurately reconstructed.  eZ-Analyst has up to three 
selectable Nyquist Factors: 2.56,  5.12,  and 10.24, depending on the hardware being used.    
The 2.56 Nyquist Factor should be used in most cases as it is the most efficient in FFT 
Analysis.  However, if you suspect signal aliasing, a Nyquist factor of 5.12 or 10.24 should be 
selected.  Higher Nyquist Factors result in more time data in the FFT Analysis.   

Note: The maximum available Analysis Frequency is reduced for higher Nyquist Factors. 

Note: WaveBook and ZonicBook systems may run at an analysis frequency which differs 
slightly from the user setting.  The difference is due to the fact that these two devices use a 
discrete interval pacer clock to control the acquisition scan rate.  Consult the respective 
hardware manuals for specifications. 
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Effects of Changing Analysis Frequency, Spectral Lines, or Nyquist Factor 

The effects indicated by these two tables are based on changing one parameter only.  If the 
Analysis Frequency, Spectral Lines, and/or Nyquist Factor are changed [for the same 
acquisition], then the tabled-effect from the other variables can differ, depending on the 
magnitude and direction of change of those variables. 

Analysis Frequency  or  Nyquist Factor 

Direction 
of Change 

File Size 
(Recorded 
Data) 

Data Block 
Acquisition-
Time* 

Data Displayed in 
Scope Mode 

Frequency 
Resolution 

Increase Larger 
disk file 

Faster Faster screen 
updates 

Lower (higher Delta X) 

Decrease Smaller 
disk file 

Slower Slower screen 
updates 

Higher (lower Delta X) 

 
Spectral Lines 

Direction 
of Change 

File Size 
(Recorded 
Data) 

Data Block 
Acquisition-
Time* 

Data Displayed in 
Scope Mode 

Frequency 
Resolution 

Increase Larger 
disk file 

Slower Slower screen 
updates 

Higher (lower Delta X) 

Decrease Smaller 
disk file 

Faster Faster screen 
updates 

Lower (higher Delta X) 

*Data Block Acquisition-Time: The time it takes to acquire one block of data. 

 

Edit Menu > Configuration > Analyzer Tab:  Filters Panel 

Filter Panel functionality does not apply to WaveBook direct channels. 

 

 
Filters Panel 

 

Apply Low Pass Filter:  When selected, a low pass filter provides alias protection and 
removes undesired frequencies from the measured response for each associated channel.   

 

AC Coupling (High Pass Filter):  When AC Coupling is selected in the Input Channels tab, 
the associated input signals will pass through a 0.1 Hz or a 1 Hz High Pass Filter, depending 
on the product and on which radio button is selected (see note). 

 

 

The AC coupling option of selecting  0.1 Hz or 1 Hz is available only on 
ZonicBook/618E and WBK18 modules [that are being used in conjunction 
with a ZonicBook/618E].  When a  WBK18 is used with a WaveBook/516E, 
choosing AC Coupling [in the Edit Configuration menu] automatically 
enables filtering at 0.1 Hz. 



eZ-Analyst 937390 Edit Menu     4-5 

Edit Menu > Configuration > Analyzer Tab:  Trigger Panel 
The Trigger Panel provides a means of setting and defining trigger-related parameters. 

Triggering defines how eZ-Analyst is to begin the task of 
capturing and processing data.  To capture data without 
using a trigger, select Free Run from the pull-down list. To 
capture transient data, select Input Channel from the pull-
down list and set values for the applicable parameters. 

 

 
Trigger Panel 

on the Analyzer Tab 

A Breakdown of the Analyzer Tab’s Trigger Panel 
Category Description 

Type If  “Free Run” is selected as the Type, the data acquisition and processing will 
begin as soon as the <Acquire> button is clicked.   Select “Free Run” if you want 
to measure data in a continuous or Scope mode manner [from an active system]. 

If “Input Channel” is selected as the Type, the data acquisition and processing 
begin after the signal on the specified channel reaches the defined trigger 
conditions.  Select  “Input Channel” if you want to capture transient data. 

“TTL Pulse” applies to the TRIGGER INPUT BNC on ZonicBook/618E and to the 
TTL TRIGGER on WaveBook’s DB25 connector (pin # 13).  The input accepts a 0 
to 5 V TTL compatible signal.  Latency is 300 ns.  

Channel 
No. 

Specifies the channel that the trigger condition applies to. 

Level This value is the point that the signal must pass through to be considered as a 
candidate for a trigger.  This value is entered as volts and must be within the 
selected FSV. 

Slope Slope icon buttons are used to select a “Positive” rising (up arrow) or a 
“Negative” falling (down arrow) slope of the signal that defines a trigger 
condition.  The signal must be on the defined slope before it can be considered 
for use as a trigger 

Pre-
Trigger 

Selecting the “Pre-Trigger” icon button (arrow will point left) instructs the 
system to capture a specified percentage of data [a specified percent of the 
frame size] prior to the start of trigger event.  In the previous figure we see that 
“Pre-Trigger” is selected for 10.00 (%). 

 

Note: For IOtech 600 Series devices, a maximum pre-trigger percentage exists 
for each combination of analysis frequency, number of spectral lines, and 
number of analog input channels.  Entering too high of a percentage 
results in an error message.  You can use the following tables to see the 
allowed maximum pre-trigger percentage for your configuration. 
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Maximum Pre-trigger Percentages for 600 Series Devices 
 

 
This section is provided for individuals who want to know the maximum pre-trigger percentage for the configured number of 
input channels, spectral lines and the analysis frequency.   All twenty tables apply to the 20-channel 672u, the first ten tables 
apply to the 10-channel 652u and 655u devices, and the first five tables apply to 640 and 650 devices.  
 
To determine the percentage: 

1) Go to the table for the number of input channels being used (up to 20 channels). 
2) Select the row that matches the number of spectral lines. 
3) Look down the column that matches the selected analysis frequency.   
4) The result (where row and column intersect) is the maximum pre-trigger percentage.   
 

Example: with 1 channel, 500Hz, and 12800 spectral lines we have a maximum pre-trigger percentage of 47% . 
 

For 1 Channel 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 1 5 5 23 23 95 95 99 99 99 99 
12800 2 11 11 47 47 99 99 99 99 99 99 

6400 5 23 23 94 99 99 99 99 99 99 99 
3200 12 47 47 99 99 99 99 99 99 99 99 
1600 22 91 99 99 99 99 99 99 99 99 99 

800 45 99 99 99 99 99 99 99 99 99 99 
400 90 99 99 99 99 99 99 99 99 99 99 
200 99 99 99 99 99 99 99 99 99 99 99 
100 99 99 99 99 99 99 99 99 99 99 99 

50 99 99 99 99 99 99 99 99 99 99 99 
 

For 2 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 1 5 5 21 21 87 87 99 99 99 99 
12800 2 10 10 43 43 99 99 99 99 99 99 

6400 5 21 21 87 87 99 99 99 99 99 99 
3200 10 43 43 99 99 99 99 99 99 99 99 
1600 20 86 86 99 99 99 99 99 99 99 99 

800 41 99 99 99 99 99 99 99 99 99 99 
400 83 99 99 99 99 99 99 99 99 99 99 
200 99 99 99 99 99 99 99 99 99 99 99 
100 99 99 99 99 99 99 99 99 99 99 99 

50 99 99 99 99 99 99 99 99 99 99 99 
 

For 3 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 3 3 14 14 58 58 99 99 99 99 
12800 1 7 7 29 29 99 99 99 99 99 99 

6400 3 14 14 58 58 99 99 99 99 99 99 
3200 6 28 28 99 99 99 99 99 99 99 99 
1600 13 57 57 99 99 99 99 99 99 99 99 

800 27 99 99 99 99 99 99 99 99 99 99 
400 54 99 99 99 99 99 99 99 99 99 99 
200 99 99 99 99 99 99 99 99 99 99 99 
100 99 99 99 99 99 99 99 99 99 99 99 

50 99 99 99 99 99 99 99 99 99 99 99 
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For 4 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 2 2 10 10 43 43 99 99 99 99 
12800 1 5 5 21 21 87 87 99 99 99 99 

6400 2 10 10 43 43 99 99 99 99 99 99 
3200 4 21 21 87 87 99 99 99 99 99 99 
1600 9 42 42 99 99 99 99 99 99 99 99 

800 19 85 85 99 99 99 99 99 99 99 99 
400 39 99 99 99 99 99 99 99 99 99 99 
200 79 99 99 99 99 99 99 99 99 99 99 
100 99 99 99 99 99 99 99 99 99 99 99 

50 99 99 99 99 99 99 99 99 99 99 99 
 

For 5 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 2 2 8 8 34 34 99 99 99 99 
12800 0 4 4 17 17 69 69 99 99 99 99 

6400 1 8 8 34 34 99 99 99 99 99 99 
3200 3 17 17 69 69 99 99 99 99 99 99 
1600 7 34 34 99 99 99 99 99 99 99 99 

800 15 68 68 99 99 99 99 99 99 99 99 
400 31 99 99 99 99 99 99 99 99 99 99 
200 62 99 99 99 99 99 99 99 99 99 99 
100 99 99 99 99 99 99 99 99 99 99 99 

50 99 99 99 99 99 99 99 99 99 99 99 
 

 

For 6 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 1 1 7 7 29 29 99 99 99 99 

12800 0 3 3 14 14 58 58 99 99 99 99 

6400 1 7 7 28 28 99 99 99 99 99 99 

3200 3 14 14 57 57 99 99 99 99 99 99 

1600 6 28 28 99 99 99 99 99 99 99 99 

800 12 56 56 99 99 99 99 99 99 99 99 

400 25 99 99 99 99 99 99 99 99 99 99 

200 50 99 99 99 99 99 99 99 99 99 99 

100 99 99 99 99 99 99 99 99 99 99 99 

50 99 99 99 99 99 99 99 99 99 99 99 

 

For 7 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 1 1 6 6 24 24 99 99 99 99 

12800 0 3 3 12 12 49 49 99 99 99 99 

6400 1 6 6 24 24 99 99 99 99 99 99 

3200 2 12 12 49 49 99 99 99 99 99 99 

1600 5 24 24 99 99 99 99 99 99 99 99 

800 10 48 48 99 99 99 99 99 99 99 99 

400 21 96 96 99 99 99 99 99 99 99 99 

200 42 99 99 99 99 99 99 99 99 99 99 

100 84 99 99 99 99 99 99 99 99 99 99 

50 99 99 99 99 99 99 99 99 99 99 99 
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For 8 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 1 1 5 5 21 21 87 87 99 99 

12800 0 2 2 10 10 43 43 99 99 99 99 

6400 1 5 5 21 21 87 87 99 99 99 99 

3200 2 10 10 43 43 99 99 99 99 99 99 

1600 4 20 20 86 86 99 99 99 99 99 99 

800 9 41 41 99 99 99 99 99 99 99 99 

400 18 83 83 99 99 99 99 99 99 99 99 

200 36 99 99 99 99 99 99 99 99 99 99 

100 72 99 99 99 99 99 99 99 99 99 99 

50 99 99 99 99 99 99 99 99 99 99 99 

 

For 9 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 1 1 4 4 19 19 77 77 99 99 

12800 0 2 2 9 9 38 38 99 99 99 99 

6400 0 4 4 19 19 77 77 99 99 99 99 

3200 1 9 9 38 38 99 99 99 99 99 99 

1600 3 18 18 76 76 99 99 99 99 99 99 

800 7 36 36 99 99 99 99 99 99 99 99 

400 15 73 73 99 99 99 99 99 99 99 99 

200 31 99 99 99 99 99 99 99 99 99 99 

100 62 99 99 99 99 99 99 99 99 99 99 

50 99 99 99 99 99 99 99 99 99 99 99 

 

For 10 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 1 1 4 4 17 17 69 69 99 99 

12800 0 2 2 8 8 34 34 99 99 99 99 

6400 0 4 4 17 17 69 69 99 99 99 99 

3200 1 8 8 34 34 99 99 99 99 99 99 

1600 3 16 16 69 69 99 99 99 99 99 99 

800 6 33 33 99 99 99 99 99 99 99 99 

400 13 66 66 99 99 99 99 99 99 99 99 

200 27 99 99 99 99 99 99 99 99 99 99 

100 54 99 99 99 99 99 99 99 99 99 99 

50 99 99 99 99 99 99 99 99 99 99 99 

 

For 11 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 0 0 3 3 15 15 63 63 99 99 

12800 0 1 1 7 7 31 31 99 99 99 99 

6400 0 3 3 15 15 64 64 99 99 99 99 

3200 1 7 7 31 31 99 99 99 99 99 99 

1600 3 14 14 63 63 99 99 99 99 99 99 

800 6 29 29 99 99 99 99 99 99 99 99 

400 12 59 59 99 99 99 99 99 99 99 99 

200 24 99 99 99 99 99 99 99 99 99 99 

100 48 99 99 99 99 99 99 99 99 99 99 

50 96 99 99 99 99 99 99 99 99 99 99 
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For 12 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 0 0 3 3 14 14 58 58 99 99 

12800 0 1 1 7 7 29 29 99 99 99 99 

6400 0 3 3 14 14 58 58 99 99 99 99 

3200 1 6 6 28 28 99 99 99 99 99 99 

1600 2 13 13 57 57 99 99 99 99 99 99 

800 5 27 27 99 99 99 99 99 99 99 99 

400 10 54 54 99 99 99 99 99 99 99 99 

200 21 99 99 99 99 99 99 99 99 99 99 

100 43 99 99 99 99 99 99 99 99 99 99 

50 84 99 99 99 99 99 99 99 99 99 99 

 

For 13 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 0 0 3 3 13 13 53 53 99 99 

12800 0 1 1 6 6 26 26 99 99 99 99 

6400 0 3 3 13 13 53 53 99 99 99 99 

3200 1 6 6 26 26 99 99 99 99 99 99 

1600 2 12 12 52 52 99 99 99 99 99 99 

800 4 25 25 99 99 99 99 99 99 99 99 

400 9 50 50 99 99 99 99 99 99 99 99 

200 19 99 99 99 99 99 99 99 99 99 99 

100 38 99 99 99 99 99 99 99 99 99 99 

50 76 99 99 99 99 99 99 99 99 99 99 

 

For 14 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 0 0 3 3 11 11 49 49 99 99 

12800 0 1 1 6 6 24 24 99 99 99 99 

6400 0 2 2 12 12 49 49 99 99 99 99 

3200 1 5 5 24 24 99 99 99 99 99 99 

1600 2 11 11 49 49 99 99 99 99 99 99 

800 4 23 23 98 98 99 99 99 99 99 99 

400 8 46 46 99 99 99 99 99 99 99 99 

200 17 92 92 99 99 99 99 99 99 99 99 

100 34 99 99 99 99 99 99 99 99 99 99 

50 69 99 99 99 99 99 99 99 99 99 99 

 

For 15 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 0 0 2 2 11 11 46 46 99 99 

12800 0 1 1 5 5 23 23 93 93 99 99 

6400 0 2 2 11 11 46 46 99 99 99 99 

3200 0 5 5 22 22 92 92 99 99 99 99 

1600 1 10 10 45 45 99 99 99 99 99 99 

800 3 21 21 91 91 99 99 99 99 99 99 

400 7 42 42 99 99 99 99 99 99 99 99 

200 15 85 85 99 99 99 99 99 99 99 99 

100 31 99 99 99 99 99 99 99 99 99 99 

50 62 99 99 99 99 99 99 99 99 99 99 
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For 16 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 0 0 2 2 10 10 43 43 99 99 

12800 0 1 1 5 5 21 21 87 87 99 99 

6400 0 2 2 10 10 43 43 99 99 99 99 

3200 0 4 4 21 21 87 87 99 99 99 99 

1600 1 9 9 42 42 99 99 99 99 99 99 

800 3 19 19 85 85 99 99 99 99 99 99 

400 7 39 39 99 99 99 99 99 99 99 99 

200 14 79 79 99 99 99 99 99 99 99 99 

100 28 99 99 99 99 99 99 99 99 99 99 

50 57 99 99 99 99 99 99 99 99 99 99 

 

For 17 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 0 0 2 2 10 10 41 41 99 99 

12800 0 1 1 5 5 20 20 82 82 99 99 

6400 0 2 2 10 10 40 40 99 99 99 99 

3200 0 4 4 20 20 81 81 99 99 99 99 

1600 1 9 9 40 40 99 99 99 99 99 99 

800 3 18 18 80 80 99 99 99 99 99 99 

400 6 37 37 99 99 99 99 99 99 99 99 

200 12 74 74 99 99 99 99 99 99 99 99 

100 25 99 99 99 99 99 99 99 99 99 99 

50 51 99 99 99 99 99 99 99 99 99 99 

 

For 18 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 0 0 2 2 9 9 38 38 99 99 

12800 0 1 1 4 4 19 19 77 77 99 99 

6400 0 2 2 9 9 38 38 99 99 99 99 

3200 0 4 4 18 18 77 77 99 99 99 99 

1600 2 8 8 37 37 99 99 99 99 99 99 

800 2 17 17 75 75 99 99 99 99 99 99 

400 5 35 35 99 99 99 99 99 99 99 99 

200 11 70 70 99 99 99 99 99 99 99 99 

100 23 99 99 99 99 99 99 99 99 99 99 

50 47 99 99 99 99 99 99 99 99 99 99 

 

For 19 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 0 0 2 2 9 9 36 36 99 99 

12800 0 1 1 4 4 18 18 73 73 99 99 

6400 0 2 2 8 8 36 36 99 99 99 99 

3200 1 4 4 17 17 73 73 99 99 99 99 

1600 1 8 8 35 35 99 99 99 99 99 99 

800 2 16 16 71 71 99 99 99 99 99 99 

400 5 33 33 99 99 99 99 99 99 99 99 

200 10 66 66 99 99 99 99 99 99 99 99 

100 21 99 99 99 99 99 99 99 99 99 99 

50 43 99 99 99 99 99 99 99 99 99 99 
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For 20 Channels 
Frequency 

20Hz 50Hz 100Hz 200Hz 500Hz 1kHz 2kHz 5kHz 10kHz 20kHz 40kHz 

Spectral 
Lines 

25600 0 0 0 2 0 8 8 34 34 99 99 

12800 0 0 0 4 4 17 17 69 69 99 99 

6400 0 1 1 8 8 34 34 99 99 99 99 

3200 0 3 3 17 17 69 69 99 99 99 99 

1600 1 7 7 34 34 99 99 99 99 99 99 

800 2 15 15 68 68 99 99 99 99 99 99 

400 4 31 31 99 99 99 99 99 99 99 99 

200 9 62 62 99 99 99 99 99 99 99 99 

100 19 99 99 99 99 99 99 99 99 99 99 

50 39 99 99 99 99 99 99 99 99 99 99 

 
Continued from page 4-6 
 

Post- 
Trigger 

Selecting the “Post-Trigger” icon button (arrow will point right) instructs the 
system to skip a specified percentage of data [a specified percent of the frame 
size] after the start of trigger event.  If we selected “Post-Trigger” and entered 
10.00 in the percent box, we would see 10% of the data skipped, in relation to 
frame size. 

Beep 
Sound 

If desired, check a box so a “beep” will sound when the Trigger is Ready, or when 
the system has Triggered.   If rapid triggering/acquiring data events are taking 
place in succession, then the beep sound may become erratic. 

 

Select Free Run from the Analyzer Tab’s Trigger Panel if you want to 
measure data in a continuous or Scope mode manner [from an active 
system]. 

To capture transient data, go to the Configuration dialog found under the 
Edit menu and on the Analyzer tab select Input Channel and specify the 
applicable channel and conditions. 

 

 

Trigger-related items [in the Analyzer Tab or Recording Setup Tab] being 
locked-out indicates that the current mode is for playback operation.  If 
so, perform the following: 

(1) close the Configuration Window 

(2) select “Measurement Mode” from the Task pull-down menu 

(3) open the Configuration window 

 

Capturing Transient Data 
Setting eZ-Analyst to trigger on an Input Channel captures transient data when the 
associated parameters are correctly specified. The following sections discuss the associate 
parameter and how they apply to a signal such as an impact hammer striking an object. The 
signal show is from an accelerometer located in the hammer’s head. 

 
Set Trigger level: 
The first and most important parameter is the trigger level. This parameter specifies the level 
in which the signal must pass through in order for an acquisition process to begin. An ideal 
level will assure that the signal is well above any noise or erroneous movement that will cause 
a trigger.  An ideal level will also assure that the level is not above the maximum output of 
the signal source. Violating these ideal conditions can result in either a premature trigger or 
no triggering at all. For example, if a signal has a noise floor of 0.5 volts and the trigger level 
is set to 0.2 volts the acquisition will always trigger for obvious reasons. Conversely, if the 
maximum signal output is 5.0 volts and the trigger is set to 5.5 volts the acquisition will never 
trigger.  
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Shifting a Waveform with Pre-Trigger and Post-Trigger 

 

Note:   The trigger level is an absolute signal level that must be within the FSV. 

 

Reference Notes: 
The following sections of this document contain information that closely relates to 
the subject of Capturing Transient Data.  Reading over the following material should 
improve your understanding of the important concepts involved. 

 Capturing Transient Data, page 4-11. 
 Recording Setup, page 4-33. 
 Block Rejection Tab, page 4-36. 
 Considerations Regarding Double Hammer Rejection, page 4-37. 

 

(A)  Setting Signal Position 

Once an acceptable trigger level 
has been ascertained, 
positioning the signal within a 
block of sampled data (and in 
the display window) is the next 
consideration. Often it is 
necessary to capture the events 
that lead up to the trigger point. 
If this is the situation then 
positioning should be set for 
Pre-trigger capturing. On the 
other hand, if the signal of 
interest occurs after the trigger 
point, then positioning should be 
set for Post-Trigger capturing. 

(B)  Normal Trigger 

Normal Triggering is obtained by 
specifying zero for the Pre-
Trigger and zero for the Post-
Trigger; where the trigger point 
occurs at the first sample point 
as pictured in the figure to the 
left. 

(C)  Pre-Triggering 

To capture information before 
the trigger point, select Pre-
Trigger and specify a percentage 
of the frame size.  This has the 
effect of shifting the waveform 
to the right as pictured in the 
figure. 

(D) Post-Trigger 

Post-Trigger is the opposite of 
Pre-Trigger.  Post-Trigger 
causes eZ-Analyst to wait “n%” 
samples before it begins filling a 
block of data. This has the effect 
of shifting the signal to the left. 

(D) 
Post-Trigger 
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Edit Menu > Configuration > Analyzer Tab:  Averaging Panel 
The Averaging Panel is used to select the type of averaging that will be calculated during data 
acquisition. 

 

 To apply averaging to time-domain data, the Function View Window must 
be changed to a Windowed “Time Function,” otherwise all averaging will 
be applied to a spectral data. 

 Averaging can be used to decrease the noise in a measurement. 

 
In the figure below, the first scenario shows the pull-down menu expanded, revealing the 
types of averaging that can be selected.  The second scenario shows that “Exponential” has 
been selected.  Exponential makes use of a Weighting Factor, which is not used by the other 
averaging types. 
 
 

 
 

Averaging Panel of Analyzer Tab (2 Views) 
 

A brief description of averaging types and other panel terms now follows. 

Linear (+):  All blocks of data are treated equally in terms of their effect on the averaged 
result. 

Exponential: Similar to linear averaging, Exponential requires a weighting factor that either 
increases or decreases the effect of each new data block on the resultant average.  

Weighting Factor: The Weighting Factor either increases or decreases the effect of each 
new data block on the resultant average when Exponential Averaging is used. 

New Average = ((New Data) * A.W.F.) + (Old Average * (1-A.W.F)) 

Peak Hold: The resultant block of data is a collection of points that represent the peak 
amplitude for each point in the block.  With each new block of data, the current data is 
compared with the new data on a point by point basis.  The highest amplitude for each point 
in the block is retained. 

Linear (-): Also known as Negative Averaging; Linear (-) Averaging is a technique used to 
identify the natural frequencies of in-service machines that cannot be shut down for analysis.  
Linear (-) Averaging is a two step process.  First, a reference average is acquired.  Second, a 
normal linear average is acquired for each frame.  The running average is subtracted from the 
reference average and the result is displayed.  The first time you attempt to start data 
acquisition after you select Linear (-) averaging, the Negative Averaging Setup/ Measurement 
window opens.  An example of how to perform negative averaging follows these definitions. 
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Time Sync:  Time synchronous averaging uses a keyway, or a similar point of reference, as a trigger.  
The blocksize is set to allow enough time for at least one full revolution.  This must be performed in 
Scope Mode.  Channel trigger mode should be used in conjunction with this selection. 

Number of Averages: This number specifies the condition for terminating a data acquisition sample.  
After the number of averages (blocks/frames of data) have been captured and averaged, the eZ-
Analyst will automatically stop taking new data.  This sample can then be saved.  If the number of 
averages is set to zero, acquisition is continuous and must be halted by the user.  

Continuous Measurement:  Checking this option restarts the averaging process without user 
intervention.  Note that the data itself is not continuous between measurements. This option is not 
meaningful for non-averaging operations.  

Save after Averaging: When this option and continuous measurement are enabled, data will be 
exported to function data sets when the desired number of averages has been completed.  If this option 
is not enabled, user has the option of manually saving an MDS file or exporting data. 

  

 

How to Perform Negative Averaging 

1.  Perform an impact measurement, with Averaging set to “Linear +” and “Triggered 
Acquisition.”   Take 5 to 10 impacts on a running machine. 

2.  Select “Spectrum Display.”  View Results. 

3.  Then change to “Free Run Acquisition” with Averaging set to “Linear –.”    
Take 10 to 20 averages. 

4.  Start Scope Measurement.  Select “Use Current Spectrum as Reference.” 

Note that the Displayed Spectrum is a Negative Averaged Spectrum.  The running 
Spectra is subtracted from the Impact + Running, and you are left with the Impact 
vibration. 

 

In regard to the following three screen shots, the first shows the impact spectra on the non-
running motor; the second shows the impact spectra on a running motor; and the third shows 
the Negative Average spectra.  If you compare the Negative Average spectra to the non-
running impact you will notice that the Running Speed vibration has been subtracted out, 
leaving Resonances. 

  

 

Reference Notes: 
The following sections of this document contain information that closely relates to the 
subject of Averaging.  Reading over the following material should improve your 
understanding of the important concepts involved. 
 
 Function Data Sets, page 3-12 
 Capturing Transient Data, page 4-11. 
 How to Perform Negative Averaging, 4-14. 
 Recording Setup, page 4-33. 
 Block Rejection Tab, page 4-36. 
 Considerations Regarding Double Hammer Rejection, page 4-37. 
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Impact Measurement on a Non-running Motor 

 

 
Impact Measurement, 10 Averages on a Motor Running at 3600 RPM 
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Negative Averaging 

 

 

Edit Menu > Configuration >                      Input Channels Tab 

 
The Input Channels tab displays the current setup conditions of the 8 Analog Input Channels 
(CH1 through CH8) and the 4 Tachometer Channels (T1, T2, T3, and T4) on a channel-by-
channel basis.  It also provides a means of changing the input channel settings.  These 
changes are accepted as soon as the <Apply> or <OK> button is clicked.   

Note:  Output channel configuration is discussed on page 4-16. 

 

 

When using WaveBook hardware, eZ-Analyst supports up to 64 channels 
of input.  If your WaveBook’s hardware configuration has more than 64 
channels, eZ-Analyst will display an error message and enter the Playback 
mode.  If you wish to use Measurement mode you will have to reduce the 
channel count by removing expansion modules.  To remove the expansion 
modules you must physically disconnect them from the WaveBook system. 

 

When using ZonicBook/618E hardware, eZ-Analyst supports up to 56 
channels of input.  If your ZonicBook/618E hardware configuration has 
more than 56 channels, eZ-Analyst will display an error message and 
enter the Playback mode.  If you wish to run in the Measurement mode 
you will have to reduce the channel count by removing expansion modules 
by physically disconnecting them from the ZonicBook/618E system. 

 

If any ZonicBook Tach channel is set for Period Mode, all ZonicBook Tach 
channels may be out of phase with ZonicBook Dynamic channels.   If 
phase needs to be maintained, configure the Dynamic channels as Tach 
channels. 
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Configuring Analog Input Channels 

 
Input Channels Tab 

 

No. This column lists the available analog input channels; for example, channels 1 
through 8. 

Active   Initially all input channels are active.  To set unused channels to OFF, remove the 
check from the associated “Active” checkbox.   

Label  This should be a meaningful name.  Highlight a cell before typing a label.  When 
you press the <Enter> key, the <Apply> button, or the <OK> button the label is 
accepted. 

Ref / 
Resp 

There are two types of channels, Reference and Response.  All channels are 
initialized as Response channels.  If you are using a force channel, then (1) 
highlight that channel’s Response/Reference cell, and (2) select Reference on the 
resulting popup menu.   

FS Full-Scale Voltage.  The cells in this column are used to set the full-scale voltage 
value in Volts. 

  

 
Analog Input 
Channels 
(CH1 – CH8) 
 
 
 
 
 
 
 
Tachometer 
Channels 
(T1 – T4) 
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IEPE 
(Integral 
Electronics 
Piezoelectric) 

The Institute of Environmental Science and Technology adopted the term IEPE 
(Integral Electronics Piezoelectric) to identify what had been commonly referred 
to as ICP® (Integrated Circuit Piezoelectric).  The two terms are synonymous; 
however, ICP is registered by PCB Pizeotronics. 

IEPE supportive analog channels have a 4mA bias current available for continuous 
use by signal input transducers, as indicated in the following table: 

Device Total Number of 
Analog Channels 

Channels that 
support IEPE 

ZonicBook/618E 8 1 through 8 
640e, 640u 5 1 through 4 
650e, 650u 5 1 through 4 
652u 10 1 through 10 
655u 10 1 through 10 
672u 20 1 through 20 

 
The bias current is sourced through the center conductor of the input channel 
BNC connector and returns to the acquisition device [e.g., ZonicBook/618E, 
600 Series, or WBK18] via the BNC’s outer conductor 

 
The current source features an operating compliance of 24V and is protected in 
regard to both short-circuit and overvoltage.  Operating compliance refers to the 
highest voltage that can be applied without change of the current source value.   
In the absence of a transducer, the current source will output an open circuit 
voltage of 30V.  For applications that do not require bias, the current source can 
be disconnected from the input by un-checking IEPE in the Input Channels tab on 
a per-channel basis. 

When the IEPE cell is checked for a channel, the current source is enabled, and 
the input voltage is continuously monitored with level detection circuitry.  
Recognition of a voltage greater than 25V (transducer open) or less than 1V 
(transducer short) triggers a transducer fault condition for the affected channel.  
This error is communicated to the user via a front panel LED and is also available 
through a software status request at the end of an acquisition.  When recognized, 
an error is latched until the commencement of a new acquisition.  Consequently, 
even intermittent faults are detected and communicated.  Detection of a fault 
does not, however, alter the acquisition process or its data. 

When the IEPE function is not available to a channel a dash appears in the IEPE 
column for the associated channel. 
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 TEDS Info  

When IEPE is selected you have the option to use TEDS.  You can then hold down 
the <Ctrl> key and click the mouse button to bring up TEDS information as 
indicated in the following screen image. 

 

 
Example of TEDS Information 

 Note:  the Preferences Tab contains a checkbox with the associated text: 
“Check for TEDS sensors on Dynamic Input Channels.” 
 
If checked, every time eZ-Analyst is started, every channel [on each connected 
WBK18 or ZonicBook main channel] is scanned for the presence of a TEDS 
compliant accelerometer.  This scanning adds time to the eZ-Analyst startup.  
See Tip.  

 

TIP: If your acquisition system doesn't have [or is not making use of] TEDS 
accelerometers, then leave the associated checkbox in the Preferences Tab 
“unchecked.”  This will allow for a faster startup of eZ-Analyst. 

 
Coupling AC or DC coupling can be set on an individual channel basis from the Input 

Channels tab. Coupling is available for analog channels (CH1 through CH8) and 
for compatible expansion channels [e.g., from a WBK18].  AC Coupling can be set 
to a high pass filter value of 0.1 Hz or 1 Hz.  The value is selected in the Edit 
Menu’s Analyzer Tab (see page 4-4).  Note that when DC Coupling is selected the 
high pass filter is bypassed.  

When the Coupling function is not available to a channel, or not used by a 
channel, a dash appears in that channel’s Coupling column. 
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Pct 
OvrRng 

 

EU Mode*  

The percent of Full-Scale Voltage (FS) that should be recorded as overrange.  
When set to a value of 0, the overrange feature is disabled. 

 

 E(ngineering) U(nits):  Select EU or Volt. 

 dB EU Ref: is applied to displayed data when the Y-axis scale is set to dB.  
This is valid only for frequency domain data. 

Note: Data exported from eZ-Analyst is always scaled to Engineering Units.  
  This is regardless as to whether EU or V is selected. 

mV/EU* sets the scaling factor of millivolts to Engineering Units. 

EU Offset* sets the offset factor that is to be applied to the Engineering Units. 

Units Enter the measurement units you will be using. 

Location  This is a simple numbering system.  The channel number is the default value for 
location.  However, you can highlight a cell and type a different location number.  
When you press the Enter key, the value is accepted. 

Coord This is the axial direction of the transducer connected to the channel.  Make your 
selection on the popup menu that appears after clicking in the applicable cell. 

Input 
Type  

This is the type of instrument attached to the channel.  Menu 
selections include:  Acceleration, Velocity, Displacement, 
Force, Pressure, Stress, Strain, General, and Tach 
(Tachometer).   
Input Type refers to the Analog Input channel type for CH1 
through CH8.   
Note: Tachometer properties for the eight Analog Input 

channels (CH1 through CH8) are set in the FFT Setup 
tab.  Refer to that section of the document for 
additional information. 

 

 

ZonicBook/618E users - do not confuse an analog input channel (CH1 
through CH8) with a TACH Channel input (T1, T2, T3, or T4).  The later 
is discussed in the following section. 

 

Default 
Tach 

 

If “Default Tach” is selected from the tach channel combo-box [next to the Order 
Track button] on the toolbar (see following figure), then the tach channel shown 
in this column is the one that will be used for the associated analog input 
channel, when calculating orders.   

 

 

 

 

 

 

 

*Note: When in “Playback Mode” you can change EU Mode, mV/EU, and EU Offset  
to customize your playback of data.  The new settings will be applied to your 
playback session.  Upon a reload of the project the original settings will be 
restored. 

 

Section of Configuration 
Input  Channels Tab 
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Configuring Tach Channels (T1, T2, T3, and T4) 

 
Tachometer Section of the Input Channels Tab, 1st 9 Columns 

No. This column lists the available Tach channels, e.g., T1, T2.  Do not confuse these 
channels with analog input channels which can also be used for tachometer 
input. 

Active Available Tach channels are initially active.  To set unused channels to OFF, 
remove the check from the associated “Active” checkbox.   

Label This should be a meaningful name.  Highlight a cell before typing a label.  When 
you press the <Enter> key, the <Apply> button, or the <OK> button the label is 
accepted. 

Ref / Resp There are two types of channels, Reference and Response.  All channels are 
initialized as Response channels.  If you are using a force channel, then  
(1) highlight that channel’s Response/Reference cell, and  
(2) select Reference on the resulting popup menu.   

Coupling Used to select AC or DC Coupling.  For tachometer applications AC Coupling is 
almost always preferred.  DC Coupling is available to allow viewing of the DC 
signal, but is of no practical use to tachometer related triggers. 

Tach Mode Used to select one of three available modes: Voltage, Counter, or Period. 

 

If any ZonicBook Tach channel is set for Period Mode, all ZonicBook Tach 
channels may be out of phase with ZonicBook Dynamic channels.   If 
phase needs to be maintained, configure the Dynamic channels as Tach 
channels. 

Pulse / 
Rev 

Displays the number of pulses per revolution.   

Trig Level Specifies the pulse level that the RPM algorithm considers valid. 

Trig Slope Specifies whether counting is Positive or Negative.  Positive means that the 
trigger will be active on rising signal levels.  Negative means that the trigger will 
be active on falling signal levels. 

 
RPM 
Multiplier 

This column is used for entering a value to convert RPM into other units, e.g., Miles 
per Hour, Revolutions Per Second, or HZ.  The desired conversion factor is entered 
as a multiplier.  To divide, enter an appropriate decimal.  For example, divide by 2 
you would enter a value of 0.5. 
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Tachometer Section of the Input Channels Tab, 2nd 5 Columns 

  

Edge 
Detect 

Edge Detect –  Edge Detect is short for “Tach Pulse Edge Detection.”    The 
term pertains to detecting the rising or falling edge of a tachometer pulse using 
either an “Immediate” or “Delayed” mode. 
 
Immediate Edge Detection (“Before Stable”) –  “Immediate” is one of two 
Edge Detect modes.  The term is synonymous with “Before Stable.”  If 
“Immediate” edge detection is selected a tach pulse will be recognized on any 
instantaneous measurement that meets the trigger level criteria.  In this setup 
the “Delay Value” is the amount of time before the next tach pulse can be 
recognized.  
 
Delayed Edge Detection (“After Stable”) –   “Delayed” is one of two Edge 
Detect modes.  The term is synonymous with “After Stable.”  If “Delayed” edge 
detection is selected a tach pulse will be recognized when the measurement 
meets the trigger criteria for the specified duration.  In this setup the “Delay 
Value” defines the length of time that the trigger criteria must be stable before 
the tach pulse will be recognized.  If a keyway is being used as a tach trigger you 
must calculate the minimum pulse width, based on the maximum RPM rate 
expected. 

Delay 
Time 

One of several time settings between 500 ns and 25.5 ms.  The delay time is 
used in conjunction with edge detect and is used to optimize noise rejection. 

Default 
Tach 

If “Default Tach” is selected from the tach channel combo-box [next to the Order 
Track button] on the toolbar (following figure), then the tach channel shown in 
this column is the one that will be used when calculating orders.   

 

Max RPM 

and 

Max 
Orders 

Max RPM and Max Orders are used to limit the X axes scale range when 
calculating an Order Tracking display in the main function view window.  Max 
RPM and Max Orders represent the practical limits of the Order Track display that 
are constrained by the settings of Analysis frequency, Spectral lines, and the 
Nyquist Factor.  These two values interact.   Changing one will cause the other to 
change. 
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To make an optimal noise rejection setting in software . . .  
 

1. Setup the input for Voltage Mode (Select AC or DC Coupling). 

2. Take a measurement. 

3. View the Tach Signal on a TimeWaveform plot. 

4. Set the Trigger Slope [Trig Slope] to Positive (POS) or Negative (NEG). 

5. Set the Trigger Level [Trig Level] to a value between 50 and 75 % of the maximum excursion. 

6. Set Edge Detect to “Immediate” or “Delayed.”  An illustrated example making use of a  
500 ns delay follows shortly.   

You may need to experiment with Edge Detect settings to determine whether “Immediate” or 
“Delayed” works best for your application.  Optimum settings will vary, depending upon the noise 
present on the Tach input.   

7. Set the Delay Time to a pre-set value between 500 ns and 25.5 ms.  To have no delay time select 
“none.” 
 
The debounce time should initially be set as low as possible, i.e., to 500 ns or to “none.” 

If the velocity readings are jumping around, that is, they are either too high [as if there was an extra 
tach pulse] or too low [as if there was a missing pulse] increase the debounce value to higher than 
500 ns.  Some experimentation is to be expected. 

Increasing the debounce value too high will reject the tachometer pulse altogether, particularly at 
high RPM. 

 

Do not set the debounce value to higher than one-half of the minimum tach pulse 
period.  The minimum tach pulse period is that which exists during the highest 
RPM. 
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The following diagrams show typical tach pulses and appropriate comparator threshold trigger settings. 

 

 

 

 

 

 
 

Typical Tach Pulses and Appropriate Threshold Settings 
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Synopsis of Tach Modes 
When you connect a tach sensor to a tachometer designated connector, such as the 
ZonicBook/618E’s TACH BNCs (T1, T2, T3, or T4) you can select one of the following three 
modes:  Counter, Period, or Voltage.  If you connect a tachometer sensor to a direct Analog 
Signal Input channel (CH1 through CH8) then the tachometer signal will only be accepted in 
the Voltage Mode.  

 

If tachometer triggers will occur at a rate greater than or equal to the 
“scan rate divided by 10” then the Period Mode must be used. 

Counter Mode 

 
 

Counter Mode generates a Pulse of Amplitude “+1” for 
each tach trigger.  The counter mode can be used when 
the number of pulses is less than the scan rate divided 
by ten  (< scan rate / 10).   

Once you have established the phase relationship of a 
machine running near optimum, the observance of phase 
shifts can be used to signal the development of a 
mechanical problem. 

Use Counter Mode when Pulses per 
Revolution are needed. 

Counter Mode can be used for phase 
shift observance. 

 

Period Mode 

 
 

The period is the time from the rising edge of one pulse 
to the rising edge of the next pulse, or the time from the 
falling edge of one pulse to the falling edge of the next 
pulse.   

The Period Mode is used for Tachometer inputs which 
exhibit multiple pulses per revolution.  The mode 
provides accurate overall RPM without sacrificing scan 
rate.  Phase measurements are not possible when using 
period mode. 

Note: 60 seconds divided by the period [in seconds] 
equals RPM. 

Use Period Mode when multiple pulses 
are involved, such as from gear teeth. 

Period Mode cannot be used for phase 
shift observance. 

 

If any ZonicBook Tach channel is set for Period Mode, all ZonicBook Tach 
channels may be out of phase with ZonicBook Dynamic channels.   If 
phase needs to be maintained, configure the Dynamic channels as Tach 
channels. 

 

Voltage Mode 

 

Voltage Mode is used for Tachometer inputs to view 
actual input voltages from the Tach Sensor.  Voltage 
mode is useful for locating an ideal Tach Trigger Voltage 
setting.  An ideal trigger voltage is one that is in a clean 
region of a leading edge.  Note that Voltage Mode cannot 
be used for Phase measurements between Analog Inputs 
and Tachometer Inputs.  

If you connect a tachometer sensor to one of the 8 
Analog Signal Input channels (CH1 through CH8) instead 
of a TACH channel, then the tachometer signal will only 
be accepted in the Voltage Mode.  Use Voltage Mode when you need to 

determine a trigger voltage. 
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Edit Menu > Configuration > FFT Setup Tab  

 
FFT Setup Tab 

Edit Menu > Configuration > FFT Setup Tab: FFT Window Functions / Response Channels 
The FFT (Response) window is a time-domain, weighting window.  A response window is usually applied to 
data to reduce FFT leakage errors.  FFT theory assumes that the signal being analyzed is periodic in the data 
acquisition block.  When this is not the case, energy from a signal at a specified frequency can leak into 
nearby spectral bins causing spectral amplitude inaccuracies.  Applying a windowing function controls, but 
doesn’t completely eliminate, the error by multiplying each data frame by a suitable time-domain weighting 
window. This calculation reduces the amplitude/magnitude of the data near the ends of each data frame prior 
to performing the FFT and forces the data to be nearly periodic in the window, thus reducing leakage errors. 
Response window options are as follows: 

 
FFT Window Functions, Response Channels Pull-down List 

 
None:  No weighting window is applied. 
Hanning:  The Hanning window is typically used to analyze continuous signals.  It offers a reasonable trade-
off of frequency accuracy versus amplitude accuracy. 
FlatTop: Compared to the very similar 4-term “Max Flat Top,” this window also has a very low peak 
amplitude error, and its frequency resolution is somewhat better.  Its side lobes are considerably higher.  Its 
effective noise bandwidth is still almost twice that of the Hanning window, therefore this window is used 
mainly to measure accurate peak amplitudes of discrete spectral components that are known to be separated 
by several spectral lines. 

Blackman-Harris: This window function was designed to provide the minimum side lobe level of any three-
term window.  Compared with the very similar Hanning window, it has a slightly wider main lobe but much 
better dynamic range.  This window has the smallest 60 dB bandwidth of any window listed.  The Blackman-
Harris window may be preferred over the Hanning for measurements requiring better dynamic range. 
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Exponential: An exponential weighting window is equal to 1.0 at the beginning of the block and decays 
exponentially to a smaller value at the end of the block.  Exponential is used only with transient data that 
is captured with pre-trigger to assure that the initial values in all data channels are very close to zero.  
Exponential can be used with all transient excitation methods in order to force the signals to decay close 
to zero, (See Response Decay Percent,) even if the block length is not sufficient to capture all of the 
naturally occurring response.  If the data decays naturally to a low amplitude within the block, so that 
leakage is not significant, exponential windowing can improve the signal-to-noise ratio by giving reduced 
weight to the very low-amplitude data at the end of the block. 

Decay %: Decay Percent is used when an Exponential Window is applied to the Response Channel. It is 
the weighting factor present at the last block value. For example, a decay of 5% means that the 
weighting factor at the beginning of block is 100% and that the weighting factor of the last block is 5%.  
In other words, the weighting factor dropped (decayed) to 5% through the length of block. 

 
Edit Menu > Configuration > FFT Setup Tab: FFT Window Functions / Reference Channels 

The FFT Reference Window is applied to the output of a transducer to avoid collecting extraneous signals 
not meant to be included in the analysis. For example, to remove the forces from retraction of a hammer 
that played no role in the response from an impact. Possible selections are: Response, Rectangular, and 
Cosine Taper. 
 

When Response is selected, the Reference FFT window type will be the same as the Response window 
type. 

When Rectangular is selected you need to specify the Start(%) and End(%) of the rectangle as a 
percentage of the Frame Period.  In eZ-Analyst, Rectangular window is intended for modal hammer 
impact-testing, and uses an offset as a corrective factor.  The added offset ensures that the window’s first 
data point will be at the sensor’s zero magnitude (usually zero force from a modal hammer).  
 

 

If you are not performing impact-testing it is recommended that you select Response or  
Cosine Taper instead of Rectangular. 
 

 

When Cosine Taper is selected specify the Start(%), End(%), and Edge(%) of the Cosine Taper as a 
percentage of the Frame Period.  Cosine Taper is typically selected when you want to smooth the signal 
ends, such as to remove the end effects due to gating.   

 
FFT Window Functions, Reference Channels Pull-Down List 

 

Start (%):  The percent of the Frame Period at which the Rectangular and  
Cosine Taper Windowing functions start. 

Stop (%):  The percent of the Frame Period at which the Rectangular and  
Cosine Taper Windowing functions stop. 

Edge (%):  The percent of the Frame Period during which the Cosine Taper 
Windowing function tapers up and down. 
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Edit Menu > Configuration > FFT Setup Tab:  Integration Panel / Unit Conversion 

 
Integration Panel – 2 Views 

The left-hand view is with the scrollbar up, the right-hand view is with the scrollbar down. 

Integration:  
 
  

Provides the means to select integration, for example, g’s-ips-mils or  
g’s-ips-in.  Several other possibilities exist, as can be seen in the above 
images of the Integration Panel. 

 

Edit Menu > Configuration > FFT Setup Tab:  Integration Panel / HPF Int1 & Int2 
 

The High Pass Filter Integration 1 (HPF Int1) and Integration 2 (HPF Int2) are used to remove 
the low frequency effects of integration.  All data points that exist below the specified value 
are set to zero.  When “Hz” is selected for the Acquisition Analysis Frequency via radio button 
on the Analyzer Tab, “Hz” is seen as the units, when “CPM” is selected for the Acquisition 
Analysis Frequency via radio button on the Analyzer Tab, “CPM” appears as the HPF units. 

 

 
FFT Integration Panel 

 
HPF Int1 (Hz):  Enter a value for the cutoff amount for the first integration. 

 

HPF Int2 (Hz):  Enter a value for the cutoff amount for the second integration. 
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Edit Menu > Configuration > FFT Setup Tab:  Tach Setup – Analog Channels 
 

 

The “Input Type” for Analog Input channels (CH1 through CH8) can be set to 
“Tach” from the Input Channels Tab via the “Input Type” column.  Once the 
analog channels have been selected for Tach further configuration must be made 
from the FFT Tab (following figure).  

 

Do not confuse the Tach Setup of Analog Channels (CH1 
through CH8) with Tach Channels T1, T2, T3, and T4.  The 
later are configured from the Input Channels Tab. 

 

 

Reference Note: For information pertaining to tachometer inputs 
T1, T2, T3, and T4, refer to the Input Channels Tab section of this 
chapter. 

 

 

Analog Channels (CH1 through CH8) can be set to have an input type of “Tach”  
from the Input Channels Tab, as indicated in the right-hand figure above. 

 

 
Tach Setup for Analog Channels is performed within the FFT Tab 
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Tach Setup – Analog Channels Section of FFT Tab 

 
Properties for Analog Channels (CH1 through CH8) when set to “Tach” for Input Type 

Pulse/Rev Displays the number of pulses per revolution.    

Trig Level 
(Trigger 
Level) 

Specifies the pulse level that the RPM algorithm considers valid. 

Trig Slope 
(Trigger 
Slope) 

Specifies whether counting is Positive or Negative.  Positive means that the trigger 
will be active on rising signal levels.  Negative means that the trigger will be active 
on falling signal levels. 

RPM 
Multiplier 

Used to enter an RPM multiplier value.  This is useful if your tachometer is 
measuring an RPM that is proportional to another value of interest, such as in a 
gear train.  For example, you want to see the RPM for shaft “X” which is known to 
turn at 2.5 times the RPM of gear “Z;” but it is impractical for a tachometer to 
measure the RPM of the shaft by any direct means.  In this case, we would enter a 
multiplier of 2.5 for the gear’s RPM to obtain the shaft’s RPM. 

Max RPM 
and 
Max Orders 

Used for analog input channels that have been configured as tach channels.  Max 
RPM and Max Orders are used to limit the X axes scale range when calculating an 
Order Tracking display in the main function view window.  Max RPM and Max 
Orders represent the practical limits of the Order Track display that are constrained 
by the settings of Analyses frequency, Spectral lines, and the Nyquist Factor.  
These two values interact.   Changing one will cause the other to change. 
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Edit Menu > Configuration > FFT Setup Tab:  Bank Control (Modal Locations) Panel 
 

This panel relates to the Modal Locations window, which is accessed from eZ-Analyst 
Window’s pull-down menu.  The Bank Control (Modal Locations) Control Panel contains one 
check box, two radio buttons, and a location increment field.  Descriptions of each follow.  

 
Bank Control (Modal Locations)Panel 

Note: This option is only effective when the averaging mode is used. 

Auto Bank Increase 
with Automatic 
Saving Data:  

A Bank is a set of response channels.  You can have eZ-Analyst 
increment the banks automatically after each measurement, or 
you can manually increment the banks.  The number of active 
channels is used as the skip factor for bank switching. 

If the Auto Bank Increase checkbox is checked, then the bank is 
automatically incremented, but only when the automatic saving 
data option is selected at Setup Export Function Data menu. 

 
Response Increase:   If the Response Increase radio-button is selected, the reference 

channel’s location doesn’t change. The response’s location(s) are 
increased [or decreased] for next available location numbers. 

Reference Increase:  If the Reference Increase radio-button is selected, the response 
channel’s location doesn’t change. The reference’s location(s) are 
increased [or decreased] for next available location numbers. 

Location Increment: Indicates the number by which eZ-Analyst is to increment the 
response or reference location after each measurement.  

Note:   Decreasing location numbers are only available with the manual bank <Down> 
button on the Modal Locations window.  Modal Locations is accessed from the 
Windows pull-down menu. 

 
A Note About Channel Pairs 

A Channel Pair is a Reference channel and a Response channel that are used to display a dual-
channel function, such as an FRF (Frequency Response Function).  Channel Pairs are 
automatically defined when a user selects "Reference" channel type for an input channel.  For 
example, if Channels 1 and 2 were defined as reference channels, then all response channels 
would paired to those channels.  Thus,  
 
1,1 2,1 3,1 4,1 5,1 6,1 7,1 8,1  and 
1,2 2,2 3,2 4,2 5,2 6,2 7,2 8,2 
 
To export all of the data for the Channel Pairs, select the “All Ch. Pairs” radio button in the 
Export Function Data window (see chapter 3 for window details).  
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Edit Menu > Configuration > FFT Setup Tab:  Low Frequency Cutoff 
 

 
Low Frequency Cutoff Panel 

 

The Low Frequency Cutoff panel can be used to change frequency-based displays.  
 
Example: 
If you wanted to remove frequencies below 10 Hz, you would enter "10" in the numeric field.  
In the Function View display window, all frequencies below 10 Hz would be set to a value of zero.   
 
Entering a value of "0" in the numeric field disables Low Frequency Cutoff.  This means all frequencies 
will be displayed. 

 

Edit Menu > Configuration > FFT Setup Tab:  dB Voltage Reference Panel 
 

dB Voltage Reference is only valid for frequency domain data. The reference is applied to all 
channels of displayed data when the Y-axis scale is set to dB and EU/Volt mode set to Volt.  
The panel [following figure] is designed such that a specified voltage can be assigned to a 
specified dB value. 

 
dB Voltage Reference Panel 

 

 

Reference Note:    
The dB EU Reference Volt column is located in the Input Channels Tab. 
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Edit Menu > Configuration > Recording Setup Tab 

 
Recording Setup Tab 

 

 

Edit Menu > Configuration > Recording Setup Tab:  Stop Recording Panel 
 

Provide a means of setting the following parameters that pertain directly to stop recording: 
 

Recording Duration sets a “time-out” which the recording event is not to exceed.  If an 
acquisition has been triggered, the measurement will run until either (a) the amplitude-based 
Enable Stop Trigger Condition is met, or (b) the Recording Duration is met, whichever occurs 
first.  When the Recording Duration value is met, the recording event is aborted. 

 

There is a 2 gigabyte file size limitation that needs to be considered 
when specifying the recording duration [for a given channel number and 
associated analysis frequency]. 

 

Enable Stop Trigger – if the checkbox is checked, amplitude-based data can be set as a 
stop condition for the recording.  The following options are provided. 

Amplitude-Based 
Data Types 

Peak Time >= 
Peak Time < 

Spectrum >=  
Spectrum < 

at specified frequency 

 

Delay (sec) – this function is used to include [with the recording] data that follows the stop 
trigger event by the set number of seconds, as specified by the delay. 
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Maximum Duration Limit Terminating a Measurement 

 
 

 
Understanding Total Measured Data 

In this figure, the Start Recording’s PreAcq-Trigger data and the Stop Recording’s Delay data 
are both saved as part of the total measured data. 

 

Edit Menu > Configuration > Recording Setup Tab:  Scheduled Recording Panel 

The Scheduled Recording panel includes a checkbox to enable the “scheduled recording” 
function.  It also includes three text fields (see following figure).  The panel provides a means 
of setting time conditions for starting and stopping a recording. dT is the delay time in 
seconds. 

 
Scheduled Recording Panel 

 

 

When using Scheduled Recording, you need to set up the recording options 
for automatic file creation.  This is done in the Recording Setup Tab’s “File 
Name Options” panel, discussed below. 

 Edit Menu > Configuration > Recording Setup Tab:  File Name Options 

 
File Name Options Panel 
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When using the Scheduled Recording feature the following steps should be taken to ensure 
that each file will be automatically named by the program. 

From the File Name Options panel, at the upper left of the Recording Setup Tab, verify that 
the following is true.  Make changes if needed. 

• File Name Prompt – Not Checked 

• Measurement Prompt – Not Checked 

• Auto Increase – Checked 

• Date/Time – Select the “Date/Time” radio-button if you want the Filenames to 
automatically increase by a Date/Time convention, otherwise select “Number.” 

• Number – Select the “Number” radio-button if you want the Filenames to 
automatically increase by a numerical sequence (1, 2, 3, ….N) convention, otherwise 
select “Date/Time.” 

 

 
An Example of Filename Auto-Incrementing by Number 

 

Edit Menu > Configuration > Recording Setup Tab:  Comments Panel 

The comments panel can be used to enter a variety of information regarding the recording.  
For example, you may want to include the environmental conditions that existed at the time 
of the recording, the phase of the project, or a problem that is being investigated.  Note that 
the comments are saved as part of the data file. 
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Edit Menu > Configuration > Block Rejection Tab 
 

The Block Rejection Tab exists to allow the software (or user) to reject blocks of data that 
result from hammer double strikes, overloads, or simply because the data block “doesn’t look 
right.”  There are three block rejection modes: Double Hammer protects measurements 
against double hammering. Overload protects the measurement by automatically rejecting 
overloaded data, and Manual allows you to inspect a measurement and optionally reject it.  
You can select any or all of the rejection modes.  Also see: Considerations Regarding Double 
Hammer Rejection, page 4-37. 

Note:  The Block Rejection panel is only active when in “Measurement Mode.” 
When in “Playback” mode the panel fields will be grayed-out. 

 
Block Rejection Tab 

Block rejection looks at the acceptable parameters for a block, and rejects blocks that do not 
meet those parameters.  

Double 
Hammer:  

A double hammer occurs when a signal goes outside of the acceptable range that 
is set up in the Hammer Rejection section.  Click in the Double Hammer box to 
turn the Double Hammer option ON and OFF.  When the box is checked, the 
option is ON. 

Overload:  An overload is any input signal that reaches or exceeds the specified input Full 
Scale range. Click in the Overload box to turn the Overload Rejection option ON 
and OFF.  When the box is checked, the option is ON. 

Manual:  This option allows you to review each block of data before acquiring the next 
block.  When manual rejection is selected, a <Reject?> button is activated in 
the main window.  At the end of each average, if you want to reject that 
measurement, click on the <Reject?> button. eZ-Analyst will then reject the 
current frame of data.  The data and average counter will go back to the previous 
measurement.  Click in the Manual box to turn the Manual option ON or OFF.  
When the box is checked, the option is ON. 

 

Block Rejection is used in conjunction with Capturing Transient Data (Input 
Channel triggering) and Averaging.  These topics are discussed on pages 4-
11 and 4-13, respectively. 
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Edit Menu > Configuration > Block Rejection Tab:  Hammer Rejection Panel 

This panel is used to define the acceptable range for a hammer signal.  Any signal outside of 
the defined range is detected as a double hammer.  The acceptable range will appear as a 
rectangle whose boundaries are defined by high and low limits for the blocksize, and by high 
and low limits for scale.  Respectively, these are x- and y- axis limits. 

X-axis Limits, % of blocksize:  Used to set a Low point and a High point along the x-axis, 
for which the hammer impact must occur to be acceptable.  An example setting is 5% to 15% 
(of blocksize). 

Y-axis Limits, % of FS (Full Scale): Used to set a Low point and a High point along the y-
axis, for which the hammer impact must occur to be acceptable.  An example is –5.000 to 
+ 5.000 (% of Full Scale). 

Considerations Regarding Double Hammer Rejection 

There are three major interrelated components to consider when setting up a double-hammer 
rejection condition.  These are: 

• Trigger Mode and Delay 
• Force Window 
• Double Hammer Region 

 

A trigger is used to ensure time synchronous measurements across all the active channels. 

As indicated in the Trigger Panel section of this document (beginning on page 4-5), a pre-
trigger indicates that data captured before a trigger event  [the amount of which is specified 
by the delay] will be prefixed to the data following the trigger event.  Also, a trigger delay 
[in reference to the Start Trigger Condition] indicates that a specified amount of data after 
the start trigger [the amount of which is specified by the delay] will be skipped (ignored) 
before a block of data is captured. 

Double hammer reject is only meaningful with the pre-trigger specified.  Double 
hammer rejection protects the measurement from a bad hammering. 

It is desirable to set the pre-trigger to fall within the hammer region, since it is a common 
practice to set the trigger channel to an impact channel. 

Example 
In this example, a test engineer is looking for a trigger event that occurs somewhere after  
10% of the data block, but before 15% of the block.  Therefore: 
 
(1) Pre-Trigger is set for 10% Delay, using the Trigger Panel (on the Analyzer Tab). 
(2) A Rectangular Force Window is selected and set for a Start point of 9% and a Stop 

point of 15%.  This is done in the FFT Setup Tab’s FFT Window Functions Panel.   
Page 4-27 contains additional information. 

 
Selecting a Rectangular Force 

Window and Setting Points 
 for 9% and 15% 

 

Selected and set in the FFT Setup Tab.  
 A Double Hammer Event 

 

When impact testing we want to make sure that a double hammer does not occur.  Through 
trial and error we may start by setting the Double Hammer range at 12% and 14%, or 11% 
and 13% of the block.  Typically this range is fine tuned using sample acquisitions prior to 
starting a real test. 
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Edit Menu > Configuration >  Octave Setup Tab    
 

 
Octave Setup Tab 

 

Edit Menu > Configuration > Octave Setup Tab:  Processing Mode Panel 

Single Band: Single Band is the conventional mode, and as the name suggests, 
is used for single band processing.  When Single Band is selected, 
lower and upper limits can be set for the High Band Range only. 
 

Dual Band 
(Buffered 
Measurement): 

Dual Band, also referred to as “buffered measurement,” is 
provided for octave band processing such that spectral lines [at 
settings of 6400 and smaller] can cover a larger frequency 
range.  The Dual Band mode uses buffer memory when 
processing the lower frequency range. 
 
Dual band uses 32 block sizes.  This makes it possible for eZ-
Analyst to simultaneously process 32 “time segments” in the 
lower frequency range, as indicated in the following figure. 
 

 
1 Block Processed for High Band 

 

 
32 Blocks Processed for Low Band 

 



eZ-Analyst 937390 Edit Menu     4-39 

 
When eZ-Analyst was set with a limit of 6400 spectral lines, dual band processing offered the following 
benefits: 

• A wider range of octave band data 
with no increase in block size. 

 

• A much wider range of data, in 
comparison to the data from the 
Single Band mode. 

• The use of buffered data means that 
High Band and Low Band data can be 
captured simultaneously. 

• When compared to Single Band, the 
Dual Band processing mode produces 
more stable, precise data, at a lower 
range of frequency.  

  
 

 
 
 

eZ-Analyst versions 5 and higher have a spectral line limit of 25600.  This larger 
number of spectral lines allows coverage of the same frequency range using single 
band mode.  
 
Beginning with eZ-Analyst version 5.1.45, the selection for dual band octave is 
grayed-out. This is because single band mode should be used with the larger 
number of spectral lines.   
 
If you have configurations that use the dual band octave feature, then eZ-Analyst 
versions 5.1.45 and higher will continue to load and run those configurations until 
you re-save the configuration in single band mode.  

 

Edit Menu > Configuration > Octave Setup Tab:  Filter Panel 
Weighting:   Used to select no filter or one of three to obtain a dB to frequency contour that 

approximates that of the human ear.  The contours (A, B, and C) match human 
hearing at different sound intensities. 

A Weighting:  filters out more bass than do the B and C weights.  The A weight 
is used to eliminate inaudible sounds that occur at low frequencies. 

B Weighting:  used to approximate the ear for medium loud sounds. 

C Weighting: used to approximate the ear at very high sound levels.  

Filter:   Provides the means to select Analog Filter or Digital Filter. 

 

Edit Menu > Configuration > Octave Setup Tab:  Bar Type Panel 

Line:   Selecting “Line” sets the Octave Plot to appear in line format.   

Solid:   Selecting “Solid” sets the Octave Plot to appear filled-in solid, as 
opposed to a line plot. 

  
  

 

When you want to move cursors on octave plots it is best to 
use the mouse and drag-and-drop action, instead of using the 
frame annotation method. 
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Edit Menu > Configuration >                                              Preferences Tab    

 

The Preferences tab includes two panels: (a) T.E.D.S and (b) Measurement Mode. 
 

 
 
T.E.D.S. Panel 
 
If the TEDS checkbox is checked: every time eZ-Analyst is started, every channel [on each connected 
WBK18 or ZonicBook main channel] will be scanned for the presence of a TEDS compliant 
accelerometer.  Note that this “TEDS scanning” adds time to the eZ-Analyst startup.  See the following tip. 

 
Edit > Configuration > Preferences Tab – T.E.D.S. Panel 
 

 

T.E.D.S. Panel 
 

 

TIP: If your acquisition system doesn't have [or is not making use of] TEDS accelerometers, then 
leave the associated checkbox in the Preferences Tab “unchecked.”  This will allow for a faster 
startup of eZ-Analyst. 

 
 
TEDS Info  
When IEPE is selected in the Edit Menu’s “Input Channels” tab you have the option to use TEDS.  You can 
then hold down the <Ctrl> key and click the mouse button to bring up TEDS information as indicated in the 
following screen image. 
 

 

 
Example of TEDS Information 
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Measurement Mode Panel 
 

This feature, when enabled (checked) reduces the chances of accidentally overwriting your 
existing Hardware and Configuration Setup file. 

 
Edit > Configuration > Preferences Tab – Measurement Mode Panel 

 

 

Measurement Mode Panel 
 
 

In eZ-Analyst the same Hardware and Configuration Setups [that are used to Record data to disk in 
Measurement Mode] are also later used to read and analyze recorded data in Playback Mode.   
 
After data has been recorded to disk, subsequent critical Configuration changes (such as changing the 
number or selection of enabled channels, or changing the Analyzer analysis frequency or nyquist settings), 
if saved to disk, would prevent eZ-Analyst from correctly interpreting data that was previously recorded 
using that Setup.  Reversing the changes made to the Hardware Setup could restore the ability to view the 
previously recorded data, but only if ALL of the changes were returned to their original settings. 
 
The Measurement Mode preferences checkbox helps reduce the chance of accidentally overwriting your 
existing Hardware and Configuration Setup file.   The checkbox setting determines whether or not you will 
be prompted to save-to-disk the current Measurement Mode Setup when the program is either (a) closed 
while in Measurement Mode, or (b) the selection is made to switch from Measurement to Playback Mode. 
 
Unchecked  - If the checkbox is unchecked, you will not be asked to save the Hardware Setup, nor will the 
Measurement Mode Hardware Setup (along with any changes made to it) be saved to disk when the 
program is closed, or the mode switch is made.  If you are switching from Measurement to Playback Mode, 
the Configuration Setup is restored by reading the Setup from the disk. 
 
Checked -  If the checkbox is checked, and the program is either closed while in Measurement Mode, or 
the selection is made to switch from Measurement to Playback Mode, you will be asked if you want to save 
the Measurement Mode Hardware and Configuration Setup to disk. 

 

 
 

You can respond to the prompt by clicking: Yes, No, or Cancel, with the following results: 
 

o Yes -  displays the Save Analyzer Setup File dialog, allowing you to select an existing setup file 
to overwrite, or enter a new filename to create a copy of the existing configuration. 

o No - accepts the current action without saving the Hardware and Configuration Setup to disk.  

o Cancel - aborts the switching of Mode or the program shutdown. 
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From the Save Analyzer Setup File window, if you press Cancel, you will abort the Mode switch operation, or 
abort the program shutdown.    
 
However, if you press Save, one of three things will happen: 
 

(a) If you entered a new filename [that does not already exist] the Hardware and Configuration Setup  
will be saved to disk, along with a Plot Setup file that represents the current number and layout of 
display windows.  In addition, the switching of Modes [or program shutdown] proceeds. 

 
(b) If you entered or selected a pre-existing filename and the Hardware and Configuration Setup file  

already exists [but there is no recorded data present with the same name] you will be asked if you 
want to overwrite the existing Setup file.   

 
If you choose Yes, the file will be overwritten and the shutdown [or the switching of the mode] will 
proceed.  If you choose No, you will be returned to the Save Analyzer Setup File dialog box where you 
can either Cancel the operation or choose a different file name. 

 
 
(c) If you entered or selected a pre-existing filename and the Hardware and Configuration Setup file 

already exists [and there is previously recorded data file present with the same name] you will  
be warned.  See following figure. 
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The warning states that there is a possibility that overwriting the Configuration file may result in the 
inability to read the previously acquired data.  The warning dialog asks, “Do you want to Overwrite the 
existing Hardware Configuration file and possibly make the existing data unreadable?”   
 

 
Yes - If you choose Yes, the file will be overwritten and the shutdown or switching of the mode will 

proceed.   
 
No  - If you choose No, you will be returned to the Save Analyzer Setup File dialog box where you can 

either Cancel the operation or choose a different file name. 
 

 

 

Reference Note:    
 
The following topics are related to this material on the Measurement Mode panel. 

o Task Menu > Measurement Mode > Change Task Mode 
o Control Menu 
o File Menu > Exit 
o File Save / Hardware Setup, Save or Recall 
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Edit Menu >                          Output Channel Setup 
 

ZonicBook/618E and WaveBook Waveform Output …… 4-44 

640u and 640e Waveform Output …… 4-46 

 

The Output Channel window can be accessed directly from the Edit pull-down menu [when in 
the measurement mode].  In all cases, the setup is performed on a channel-by-channel basis. 
Configuration changes are accepted as soon as the <Apply> or <OK> button is clicked. 

 

ZonicBook/618E and WaveBook Waveform Output 
 

WARNING 

 

When the Signal Generator is started [in eZ-Analyst] the device that is 
connected to Source Output will receive excitation and could possibly 
cause injury to personnel.  Be aware of which device is receiving 
excitation and post adequate notice to keep individuals and physical 
objects clear of the device.   

 

 

Do not confuse the Output Source [excitation source] with source level, 
as the latter term refers to transducer bias current. 

 

The Source Output can be used as a test source for the input channels or as excitation for 
other system elements, such as the amplifier for a shaker table.  All source output parameters 
are software controlled and the actual output signal leaves the device through a front panel 
BNC connector. 

Note: The Control pull-down menu can be used to turn the Signal Generator “On.”  

In regard to ZonicBook/618E – Source Output is supported for device and for attached 
WBK18 modules. 

In regard to WaveBooks 

 
Output Channel Setup, WaveBook and ZonicBook/618E Applications 

–  Source Output is only supported when eZ-Analyst detects attached 
WBK14 or WBK18 expansion units.  

For both the ZonicBook/618E and WaveBooks, the Output Channel (Excitation Source) can be 
for either a continuously running sine wave or a swept sine wave.  
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Sine Mode (Continuous Mode) 

Sine mode refers to a continuously running sine wave of the selected amplitude and 
frequency.  To configure, select an output amplitude and a start frequency; then click <OK.>  
The selected output will begin and continue running until the <Stop> button is clicked or the 
software application is terminated.  End frequency and sweep time do not apply for this mode. 

Swept Sine Mode 

Swept Sine mode refers to a constant amplitude sine wave that is being swept in frequency 
from a selected start frequency to a selected stop frequency over a selected sweep time 
duration.  The frequency sweep characteristic can be chosen to be linear or logarithmic, and is 
distributed among 1280 discrete steps.  The transitions between steps are continuous in phase 
and in amplitude. 
 
To configure, make selections for the available parameters, and then click the <OK> button.  
Once a sweep is completed, the waveform returns to its start frequency and is swept again 
and again until stopped by the user or until the software application is terminated. 
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 640u and 640e Waveform Output  
 
eZ-Analyst provides extensive Waveform Output functionality 
when used with an IOtech 640e or 640u Dynamic Signal 
Analyzer. 

 
When connected to a Dynamic Signal Analyzer 640 Series 
device [DSA640] the Waveform Output menu selection changes 
to appear as shown in the figure at the right.   Also available is 
a toolbar button show in the following figure.   Either of these 
will display the Waveform Output Configuration Dialog Box. 
 

 
The next figure shows the DSA640 Waveform Output Configuration dialog box with the 
Wave Tab selected.  From this selection you can create simple waveforms of different 
types, with adjustable Offset, Voltage level and Duty Cycle (for Square Wave output 
only). 
 

 
The Configuration dialog box contains 
three different areas.   At the top is the 
Waveform preview window.   Below and to 
the left is the Waveform properties area.  
And to the right is the Waveform Modifier 
area. 
 
The Waveform Preview Window 
displays a REPRESENTATION of what your 
configured waveform will look like when 
you start the generator output.    This 
window will faithfully display your 
configured waveform, but it does have 
certain restrictions.   For example, a 
continuous wave runs until it is stopped.   
The preview window displays up to a 
maximum of 10 seconds of waveform 
data.   Also, high frequency waveforms will 
display aliased, unless you zoom-in to 
display a smaller segment of the wave; 
this operation is discussed later. 
 
The Waveform Properties area is were 
you can change the Type of waveform, its 
Signal Level, DC Offset, and for Square 
Waves - Duty Cycle.   Changes to these 
controls can be made while the waveform output is running.  The DSA640 Waveform Output can generate a 
maximum signal of 4 volts peak (8 volts pk-pk).    The interaction between the Offset and Vpk Level controls 
will prevent combinations of settings that would exceed the 4 volt peak output level. 
 
The Waveform Modifier area is where you can make changes that control how your configured waveform 
will be displayed.   Most of the controls in this area are disabled when the generator output is running; with 
the exception of the (Burst On Time / Sweep Time) and Burst Off Time input fields.    From the Waveform 
Modifier area you can change your waveform from a continuous wave to a burst wave, or a burst wave that 
repeats.   You can also modify the waveform envelope so that it Ramps-Up from the quiescent output level to 
the selected Vpk output, level.  Or Ramps-Down (decays) from Vpk to the quiescent level.   You can also 
easily lock the Burst / Sweep Time to the Analyzer Frame Time. 
 
 
 
 
 
 

 

DSA640 Waveform Output Configuration Dialog Box 



eZ-Analyst 937390 Edit Menu     4-47 

 
Wave Tab 
 

 
Wave Tab Selected 

As seen in the preceding screen shot, several selections are available from within the Wave Tab.  In the 
above example [on the screen image], a sine wave has been modified with a 1.0 second amplitude Ramp-Up.    
 
To add a Waveform Ramp Up or Ramp Down to a waveform: 

1) select the appropriate button [Up or Dn] 
2) from the ramp window  click the Select [Add Waveform Ramp Up] checkbox (or press the spacebar) 
3) enter the desired ramp time value (Note - this time is included in the Burst / Sweep On Time  

If Burst mode or Swept Waveform mode is selected);  
4) Click the window 3  [OK] button to accept the change, or the X button to cancel the operation.  

Note: You can use the Tab key to cycle the selection highlight through all of the controls.  You can 
also use the Enter Key to select the 3  or X buttons. 

 

 
How to modify the waveform Burst On/Sweep Time  
This section discusses how to modify the waveform Burst 
On/Sweep Time such that it will automatically track 
changes to the Analyzer Frame Time when either the 
Analysis Frequency or Spectral Line count change. 

 
Click the Lock Icon on the configuration dialog.   Then 
check or uncheck the selection to lock waveform output to 
the Frame Time.   When waveform output is locked, the 
Burst On / Sweep Time control is disabled, and the value 
displayed is the Frame Time.  
  

Ramp Up 
 
      Ramp Down 
 

             Select (3 )    
                  
                   
                   
                    Cancel (X) 
 

                     OK (3 ) 

Locking a Waveform Duration 
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Burst Repeat Mode 

With Up and Down Ramp Envelopes Applied 

The above screen image shows a waveform configuration that is set to Burst Repeat mode with both an Up 
and Down ramp envelope applied.    
 
 
The following figure shows that you can zoom into a specific segment of the waveform to display an unaliased 
view of the wave.   To zoom into the waveform simply click and drag the mouse over the desired viewing 
area . 
 

 
Zooming in on a Wave Segment 

 
You can continue to zoom into the waveform to view smaller and smaller sections of the currently displayed  
waveform segment.   
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 In the next figure we see the popup menu used to restore the waveform display to its un-zoomed state. 
 

 
A Popup Menu Allows you to “Un-Zoom” Back to Full-View  

 
Simply right click on the preview window and select Un-Zoom plot to full view from the popup menu.  
 
 

Swept Wave Tab 
 
This tab allows you to create waveforms that 
sweep in frequency.   Swept Waves have the same 
selections for Wave Type Offset and Vpk signal 
level as simple waves.  Additionally a Chirp wave 
type is available along with selections for Start 
Frequency, Stop Frequency, Sweep Function and 
Sweep Direction.  The Waveform Modifier area 
applies the same types of modifications to swept 
waves as it does for simple waves. 
 
In the figure at the right we can see that eZ-
Analyst is being configured to generate a 3 volt 
peak (Vpk) swept sine wave with zero volts DC 
offset.  The sine wave will perform a linear sweep 
from 10 Hz to 100 Hz over a period of 3 seconds.  
The output will return to zero volts for 0.5 second; 
then the sweep will repeat. 
 

 
 
 
 
Swept waves can employ either a Linear or Logarithmic sweep function.    They also can be swept in one of 
four directions: (1) Start to End frequency, (2) End to Start frequency, (3) Start to End to Start frequency, or 
(4) End to Start to End frequency.    The Chirp wave type is a Sine wave that cannot have envelope ramps 
applied to it. 
 
  

Swept Wave Tab 
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Arbitrary Tab 
 
The Arbitrary Tab allows you to import data from a file, and have it played out through the DSA640 Analog 
output.   This feature allows you to import data from either an eZ-Analyst raw time domain data file, or an 
ASCII text file that has channel data formatted in columns, 
 
As indicated in the figure [below, left], the first time you select the Arbitrary tab, waveform properties will be 
empty.  To import a file: (1) Press the Browse for file button; (2) select the file you want to import.   The 
right-hand figure shows the file selection dialog box.   

 

 
 

 
 
Raw Data (.DSC) Files  
 
If you selected an eZ-Analyst raw data file (files in the Import dialog box with a .DSC file extension), the 
Configuration dialog Arbitrary Tab will appear as shown in the next figure. 
 

 

Displaying a Waveform for a Raw Data File 

The dialog box displays information about the contents of the selected data file.  This includes the Sample 
Rate the data was acquired at, the Number of Samples in the file, a list of Channels in the file, and when a file 
is selected from the list, information about the Full Scale Range of the channel and the channel Units.  

                Arbitrary Tab, no Display                                                Selecting a File to Import 
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Also displayed is information about the samples displayed in the preview window, and input fields where you 
can change the scale and offset of the data as it will be played out of the DSA640 Analog Output. 
 
Changing the Scale and Offset values allow you to fit a signal to the desired output amplitude.  This can also 
be accomplished by right clicking the mouse in the preview window, then select the “Fit Waveform to full 
scale” item in the popup menu.   To undo changes, you can reset the Scale and Offset values to 1 and 0, or 
from the popup menu select “Reset plot Scale and Offset”. 
 
When you Import an eZ-Analyst data file, the Output Duration Secs field in the Waveform Modifiers group is 
automatically set to a value equal to the number of samples in the file, divided by the sample rate.   This is 
amount of time the waveform will be played out of the DSA640 Analog Output.   In the example shown in the 
preceding figure, this will be 1.0000 second.  If you want, you can change this value to play out the 
waveform over a different length of time.   You can also choose to play out the waveform as a repeated burst 
by Checking the Repeat Output and specifying an Off Time value. 
 
 
ASCII (.TXT) Files 
 
When the opened file has a .TXT file extension, you will be presented with another dialog box.  This is where 
you tell eZ-Analyst how to interpret the data in the ASCII file.   The next figure shows the first step needed 
for importing an ASCII file. 
 
 

 

Text Import Wizard – Step 1 of 2 

The first step to importing data from an ASCII file is to indicate if the channels are formatted in (a) fixed 
width columns padded with spaces, or (b) character delimited columns.  This is done via the “Digital data 
type” radio button.   The above figure shows delimited columns.   After clicking the radio button, select the 
first row of text that has valid channel data.  This allows you to skip over text rows that contain non-data 
content [such as channel headers and acquisition information].   You can enter the zero based row number 
directly into the entry box, or click on the desired row in the list box.  Note that only the first 100 rows of 
data [in an ASCII file] are displayed in the list box.   
 
After you have selected Delimited or Fixed width and the starting row to import, press the Next button to 
proceed to Step Two. 
 

 

Text Import Wizard – Step 2 of 2 for “Delimited” Format 

The above figure shows Step 2 of 2 for importing a delimited column ASCII data file.  In this box you select 
the type of delimiter used to separate the columns of channel data.  Tabs and commas are typical delimiters.  
After specifying the delimiter, select the channel (column) that you want to import.   

Delimited                          Start at 
               Row 
         Fixed 

         Width 

Delimiter             Import 

Types                                                                                                                           Column 
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You can enter the zero based column number into the entry box, or click on the column header of the desired 
channel.  At this point you can press the Back button to change your selection, or press Finish to start 
importing data. 
 
The next figure shows Step 2 of 2 for the Fixed width data format.  For the fixed width format, you must 
indicate how many characters wide the channel column is; then you select the channel (column number) to 
import. 
 

 

Text Import Wizard – Step 2 of 2 for “Fixed Width” Format 

  After completing these two actions, press the Finish button. 
 

 

Data Import in Progress 

Importing ASCII data can take several seconds.   While the data is being imported a progress bar is displayed 
as indicated in the above figure. 
 
When all of the data has been imported, the dialog display changes.  See following figure. 
 

Fixed column 
width 
 
Import column 

number 
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Display for Arbitrary Wave, following an ASCII Data Import 

 
The ASCII import display has the same Scale, Offset, First Samp and  Num Samps entry fields seen in the 
eZ-Analyst raw data import display.   Additionally there are entry fields for Range Selection and Acquisition 
Sample Rate.   Also displayed are the Maximum and Minimum data values in the imported data. 
 
Unlike eZ-Analyst raw data, ASCII data contains no information about how the data was acquired.   Because 
of this, some information about the data has to be manually entered by the operator.   For example,  
eZ-Analyst needs to know what the +/- Full Scale Range was when the data was acquired.   The software 
also needs to know the sample rate that was used to acquire the data. 
 
The Full Scale Range can be either manually entered, or automatically set by selecting the Maximum and 
Minimum data points imported from the file. 
 
The Waveform Modifiers operate the same for ASCII data as Raw data.   Enter the time value to playback the 
data, and make the selections needed to make the playback repeat or not. 
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Preferences Tab 
 
The Preferences Tab (following figure) is used to set the operating characteristics of certain waveform output 
functions. 
 

 

Preferences Tab 

 
The first control allows you to adjust the size of the Waveform Output Memory Buffer.   Waveforms are 
generated in the memory buffer and “played-out” through the 640 unit’s Analog Output.  As data is played-
out, eZ-Analyst is periodically interrupted to fill the buffer with more data to keep the waveform flowing.  
The smaller the buffer the less time it takes to play-out, therefore more interruptions are made to keep 
generating waveforms.   A larger memory buffer takes longer to play out, so fewer interruptions are made 
to generate waveform.    
 
Computers with lower performance processors may need to have the size of 
the memory buffer increased to reduce the number of interruptions needed for 
waveform generation.    However, a larger memory buffer means that changes 
to the output waveform such as Voltage Level, Offset, etc, will take longer to 
see the effect of the change; since these changes are applied at the end of the 
buffer and will not be seen until that part of the buffer is played out. 
 
The second control is used to set the trigger point when eZ-Analyst has been 
configured to use Waveform Output triggering.  The Trigger panel (shown at 
the right) is located in the Analyzer Tab of the eZ-Analyst Edit/Configuration 
Dialog Box.  You can set the Trigger point to occur at either the start of the  
Waveform, or if a Ramp-Up has been applied to the Waveform, at the end of  
the Ramp. 
 
Note: Preferences cannot be changed when the Waveform Output is running. 
 
  

     Trigger Panel 
 
Located in the Analyzer Tab 
of the eZ-Analyst Edit/Config- 
uration Dialog Box 
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WARNING 

 

When the Signal Generator is started [in eZ-Analyst] the device that is 
connected to Source Output will receive excitation and could possibly cause 
injury to personnel.  Be aware of which device is receiving excitation and post 
adequate notice to keep individuals and physical objects clear of the device.   

 

When the Signal Generator Button is pressed eZ-Analyst starts generating Waveforms at the DSA640 
Analog Output connector.   The Signal Generator Button changes from a flat line, to a Sine wave Icon to 
indicate that the output is running. 

 
 

 
 
 
 
 
 
 
 
If the Waveform Configuration Dialog is visible when the Signal Generator is started, the dialog shrinks in size 
to hide the preview window.   Changes made to the output waveform while the generator is running can not 
be previewed in the preview window (see following figure). 
 

 

                     

 
 
 
 
 
 
 
 
 
 
 
 
When the Signal Generator is shut off, either by pressing the Toolbar button, or from the Signal Generator 
menu selection, the memory buffer containing the output waveform must finish playing out before the output 
of the DSA640 stops and returns to zero volts.   This play-out time is controlled by the Preference setting 
(see Preferences Tab, preceding page).  While the generator is playing out the data, a status message is 
displayed in the eZ-Analyst Toolbar indicating that the generator is shutting down (following figure). 
 

 
The message is removed when the generator has finished shutting down.  At this time the Signal Generator 
can be restarted to again generate waveforms on the 640 unit’s Analog Output. 
 
  

Two Views of the Signal Generating Button 

Not Generating            Generating 

                                                                                                  Signal 
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Edit Menu >              Playback Setup Window 

 
Playback Setup Window 

 

Edit Menu > Playback Setup Window:  Source Information Panel 
Provides general file related information such as filename, file location, the number of active 
channels, analysis frequency, block size, blocks recorded, and record time.  The panel includes a 
Comments box for user remarks. 

Edit Menu > Playback Setup Window:  Playback Mode Panel 
After you open a recorded file to be played back, you have the option to change the following for 
viewing purposes: 

Spectral Lines:  This section of the Playback Mode panel is used to set the number of spectral 
lines.   Note that number of Spectral Lines stated in “Source Information” is the minimum 
number of lines you can have for the given file’s playback.   

Overlap Percent 0 - 99:  The percentage of displayed history data that will overlap subsequent 
data when we step through it.  The value can be set to any whole number from 0 to 99, inclusive.  
To understand the settings: 

o 0 – A setting of “0” results in no record overlap. 100% of each record will be displayed; 
we step through the history data 1 complete record at a time. 

o 50 – With a setting of “50” we see 50% of one data record and 50 % of the subsequent 
data record each time we step through the data. 

o 99 –  At each step-through of the history data, the display will show 99% of the data just 
viewed, and 1% of the next available history data.  This means that a setting of 99 allows 
us to step through the history data in 1% increments. 

Playback Speed – Select from one of three playback speed options:  
No Delay, Acquisition Rate, or Delay (mSec) 
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Edit Menu >                       Display Preferences 
 

 
Display Preferences 

 
Panel Function 

Plot Window 
Colors: 

Used to edit the colors of Frame Border, Plot Background, Grid Lines, and Cursors.  In 
addition, the toggle buttons with the “line/asterisk” images are used to obtain a line 
cursor or a point cursor.  

 To change a Plot Window display color: 

1. Click on the button that applies to the display characteristic, for example,  
<Plot Background>.  A Color Palette will open. 

2. Select a color by clicking on a color square, or by defining a Custom Color. 

3. Click <OK>. 

4. Repeat the steps 1 through 3 for each Plot Window color that you want to change. 

5. When finished, click <OK> in Colors [Color Palette] window. 

Freq / Order 
Track Slice: 

Applies to Frequency Track Slices and Order Track Slices.  The measurement mode will 
always use the maximum number of records; but for playback modes this panel 
determines whether:  

a) all the data records will be displayed, or 
b) the maximum stored records will be displayed.  

The user can click in the numeric field to change the number of records to be stored.   

Plot Colors:  The top four buttons in this panel are used to set colors for tachometer channels.  The 
16 additional buttons are used to set colors for traces or channels.  If you want a 
channel to remain a certain color ensure the channel radio button selected.  Click on a 
channel’s color chip to open a color palette.  Click on the desired color, then click <OK>. 
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Panel Function 

Cursors:  Sets the number of cursors and defines the Foreground, which is the color for 
 on-plot text, such as cursor values.  

Cursor 
Movement:  

Sets the cursor’s action.  Options are: Pick/Drag, Pick Only, and Drag Only. 

Pick/Drag: Makes use of both the Pick Mode and the Drag Mode. 

Pick Only: Clicking the left mouse button allows the cursor to move instantaneously 
with the band cursor.  The chosen cursor moves to the location when the mouse is 
clicked. 

Drag Only: Move the mouse pointer to the cursor location.  The pointer will change to a 
“Left and Right Arrow.”  Click and drag the cursor to the designated location. 

Peak Search Options: 

 Peak averages are evaluated by first finding a peak and then averaging the specified number of 
spectral lines on either side of the peak.  This section of the window is used to set the preferences 
regarding peak search.  Options are as follows: 

 Amplitude 
Minimum 

Used to set the Minimum threshold value for peak searching, i.e., the lowest 
value of data to be considered for the search.  “Minimum is typically set 
above the extraneous noise level. 

 Peak Width 
(Spectral Lines)  

Sets the eZ-Analyst to search data, according to a cursor-selected range 
(band).  The band takes into account the Minimum threshold value for peak 
searching, if defined.  The default setting for 3 spectral lines. This number 
specifies the number of data bins used for peak searching.  For example, “3” 
indicates that the peak value will be searched at the current cursor position 
and the ± 3 adjacent positions. 

 Sort By Select Frequency/Time or Amplitude, as applicable to your peak search. 

Pick Peak Options: 

 Spectral Width 
(Spectral Lines) 

This mode sets the system to search for a peak within the pre-defined  (data 
range) only when the cursor is moved, or clicked.  This is a manual method.  
Compare with Auto-Tracking.  

 Auto Tracking Selects Cursor-1 and/or Cursor-2 to automatically search for peaks.  The 
feature makes use of the Spectral Width, for example: “3” indicates that the 
peak value will be searched at the current cursor position and the ± 3 
adjacent positions.  The cursor automatically moves to the peak position 
within the specified range. 

 
 

 

 

 

 Reference Note: 
 Cursor types include single cursor, band cursor, peak cursor, and harmonic cursor.  
For detailed information refer to chapter 5, Interactive Features of the Plot Display 
Window. 
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Toolbar Buttons 5 

 
 

The following tables can be used to identify buttons and their functions.  An alternative to using the 
buttons is to “right-click” in a plot display, then use a resulting function menu.    

 
 

 

 
 Function Description / Comments 

1 Add New FV Window Adds a new Function View.   

2 Tile Horizontally Tiles two or more Function Views such that they are longer in the 
horizontal direction. 

3 Tile Vertically Tiles two or more Function Views such that they are longer in the 
vertical direction. 

4 Time A single-channel display function.  Displays a time domain 
waveform of sampled data scaled in either Volts or EUs. 

5 Auto-Spectrum A single-channel display function.  Displays the square of the 
magnitude of the complex (one-side) Fourier spectrum of x(t).  
Autospectra are calibrated so that if A is the peak amplitude of a 
sinusoidal signal x(t), then the autospectrum has the value A*A  
(or use A power 2)  at the sinusoidal frequency. 

6 PSD 
(Power Spectral Density) 

Power Spectral Density (PSD) displays the power of random 
vibration intensity as “mean-square acceleration per frequency 
unit.”  PSD is a single-channel display function.  It is the Fourier 
Transform of the Auto-correlation function.  This normalization 
should be used with continuous random signals. 

7 Spectrum A dual-channel display function.  Displays averaged linear 
spectrum computed as the square root of the averaged 
autospectrum. 

 



5-2    Toolbar Buttons   916994 eZ-Analyst 

 

 

 Function Description / Comments 

8 FRF A dual-channel function for the single-input, single-
output (SISO) frequency response function between 
two specified input channels.  FRF is the averaged 
cross-spectrum divided by the averaged 
autospectrum of the input (the second named 
channel).  When the FRF (#8) or the Cross (#9) 
button is clicked on; then the following buttons for 
more complex data displays become active.  These 
buttons, not shown in the above figure, will appear in 
the toolbar between buttons #15 and # 21. 

  
 

Magnitude: Plots only the magnitude of real or 
complex data. 

  
 

Phase:  Plots only the phase of complex data. 

  
 

Magnitude and Phase: Plots both Magnitude and 
Phase data. 

  
 

Real: Plots only the Real numbered data. 

  
 

Imaginary 

  
 

Real and Imaginary: Plots both Real and Imaginary 
data. 

  
 

  

Nyquist:  A Nyquist plot is another way to display real 
and imaginary data.  The real numbered data is 
plotted on the X-axis and the imaginary numbered 
data is plotted on the Y-axis with consecutive points 
joined by line segments.  From basic vibration 
theory, a Nyquist plot of a mobility function should 
trace out a circle (counter-clockwise) as the 
frequency is increased through an isolated structural 
resonance. 
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 Function Description / Comments 

9 Cross* A dual-channel display function in the frequency 
domain.  It is equal to the product of the complex 
Fourier spectrum of y(t) (the numerator or first 
named channel) times the complex conjugate of the 
Fourier spectrum of x(t) (the denominator or second 
named channel).  The special case y=x yields the 
autospectrum.  Averaging of these functions 
(frequency-domain averaging) forms the basic 
foundation on which virtually all other multichannel, 
frequency-domain analysis is built.  The cross 
spectrum is calibrated in units of (peak EUy) (peak 
EUx). 

When the Cross (#9) or FRF (#8) button is clicked 
on; then the following buttons for more complex data 
displays become active.  The buttons will appear in 
the toolbar between buttons #15 and # 21 and are 
briefly discussed in the FRF section (preceding row) 
of this table. 

10 Coherence* A dual-channel display function.  At each frequency, 
the coherence is a value between 0.0 and 1.0, which 
indicates the degree of consistent linear relationship 
between two signals during the averaging process.  A 
value of less than one indicates that phase 
cancellation occurred during cross-spectrum 
averaging, which may be due to uncorrelated noise 
on one or both signals or to a nonlinear relationship 
between signals. 

11 Octave* Many sounds, including audible noise for a 
transmission line, are broad band, having 
components that are continuously distributed over a 
range of frequencies.  The spectrum of such a sound 
can be approximated in terms of a series of octave 
band or one-third octave band pressure levels.  A 
band is designated by its center frequency, f0, which 

is the geometric mean of the upper and lower 
frequencies of the band.  (See ANSI/ASC S1.6-1984.)  
This button activates two Octave Type buttons, i.e., 
Full Octave (#16) and 1/3 Octave (#17). 

 
*   Buttons 9, 10, 11 will only be active if there is a “Reference Channel.”  A channel can be selected 

to “Reference” in the Input/Output Channels Tab via the Response/Reference column. 
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Function Description / Comments 

12 Transfer Function Activates additional buttons for the Transfer Type options.  The 6 
buttons appear in the toolbar area between buttons #15 and #21 
when the Transfer Function button is clicked on [they are not 
shown in the above figure]. The Transfer Function buttons are:   

  

 

Inertance, which is: Acceleration divided by Force. 

  

 

Mobility, which is: Velocity dived by Force. 

  

 

Compliance, also known as Receptance, which is: 
Displacement divided by Force. 

  

 

Apparent Mass, which is: Force divided by Acceleration. 

  

 

Impedance, which is: Force divided by Velocity.  

  

 

Dynamic Stiffness, which is: Force divided by 
Displacement. 

 

 

Transfer function displays assume the reference channel is a 
force channel.  You MUST define the response channels to be 
the correct type of data (acceleration, velocity, or displace-
ment) that you are acquiring.  Define these in the data type 
column of the Calibration window.  This allows the data to be 
integrated or differentiated correctly to derive the desired 
transfer function. 

13 Averaged Time A single-channel display function.  Displays a time domain 
waveform of averaged, sampled data scaled in either Volts or EUs. 

14 Negative Spectrum Reference Spectrum minus Current Spectrum displays the 
difference between the Reference Spectrum and the Current 
Spectrum when the following is specified: Linear (-),  
Negative Averaging 

15 Windowed Time Applies to the FFT Response window specified in the Miscellaneous 
Tab of the Configuration window to time data. 

16 Full Octave Extends from a lower frequency, f02 to twice the lower frequency 

(2f0).  The <Full Octave> button is only actie when the <Octave> 

button (#11) is selected. 
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 Function Description / Comments 

17 1/3 Octave Extends from a lower frequency ( f0/2) to 32 times the lower 

frequency (32 f0).  The Octave (one-third octave) band 

sound-pressure level is the integrated sound-pressure level of 
all spectral components in the specified octave or one-third 
octave band.  The <1/3 Octave> button is only active when 
the <Octave> button (#11) is selected. 

18 Graph Toolbar Opens [or closes] the graph toolbar, which consists of buttons 
1 through 17 and buttons 21 through 30. 

19 Edit Configuration Opens the Configuration Settings window. 

20 Input Channels Button Open: makes a floating window of channel buttons.  Closed: 
keeps the buttons on the toolbar. 

n/a Strip Charts There is no toolbar button for Strip Chart.   To add a Strip 
Chart: 

(a) Go to the Plots menu-bar and open the Window pull-
down menu. 

(b) Select the “Add Strip Chart” option. 

For detailed information refer to the Strip Charts section 
in chapter 6. 

21 XY Axis Grids Used to add or remove vertical and horizontal grid lines. 

22 Auto Scale XY Axis Lets the application automatically adjust the X and Y axis. 

23 Manually Scale Y Axis Lets the user manually adjust the Y-axis. 

24 Manually Scale X Axis Lets the user manually adjust the X-axis. 

25 Manually Scale X & Y Axis Lets the user manually adjust both the X and Y-axis. 

26 Cursors Cycles through the following cursor options: Cursor Off, Single 
Cursor, Dual (Band) Cursor, Harmonic, SideBand, Peak, 
FreeForm.  Use the Amnotation button (#27) to view X and Y 
values associated with the cursors. 

For detailed information refer to the Using Cursors section in 
chapter 6. 

27 Annotation Provides a means of displaying cursor values in terms of x and 
y.  Annotation can be displayed as numbers at the cursor or in 
a frame, which includes forward and backward scrolling 
arrows.  Note that the annotation color will match the  
“Foreground” color as set in Edit/Display Preferences.  Note 
that the Annotation frame will only display up to 6  
sets of cursor values. 
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 Function Description / Comments 

28 Differential Differential (also referred to as Differentiation) is for display purpose only 
and does not modify the data. Differentiation is only active when frequency 
domain data is displayed. Select single or double differentiation or none by 
continuous clicks of the button (#28).  In the plot display’s “Y-Axis” label, a 
“&” indicates single differentiation, “&&” indicates double differentiation, and 
no ampersand indicates no differentiation.  Note that both Differentiation and 
Integration are calculated by dividing each element of the function by 
(jw)^n, where j is the square root of -1; w is the product of 2 pi times the 
frequency of the block element; and n is an integer from +2 to -2. 
If the signal is displacement, then single differentiation (&) results in 
velocity, and double differentiation (&&) results in acceleration. 

29 Integral Integral (also referred to as Integration) is for display purpose only and does 
not modify the data. Integration is only active when frequency domain data 
is displayed. Select single or double integration or none by continuous clicks 
of the button (#29).  In the plot display’s “Y-Axis” label, a “~” indicates 
single integration, “~~” indicates double integration, and no ampersand 
indicates no integration.  Note that both Differentiation and Integration are 
calculated by dividing each element of the function by (jw)^n, where j is the 
square root of -1; w is the product of 2 pi times the frequency of the block 
element; and n is an integer from +2 to -2.  If the signal is acceleration, 
then single integration (~) results in velocity, and double integration (~~) 
results in displacement. 

  Note:  Engineering Units change when the instrument type is Acceleration 
and integration is implemented. 

30 Scale - RMS, 
Pk,  
Pk-Pk  

The Scale button allows the user to cycle through the following scales:   
RMS:  (Root Mean Square): The square root of the average of the square of 
the value of the function taken throughout one period.  Peak:  Zero to Peak.  
Pk-Pk: Peak to Peak.  Refer to the following illustrations. 

 
RMS 

 
 

Peak 

 
 

Peak-to-Peak 

 
 

RMS Level 
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Note:  Items 31 through 35 are located at the right end of the toolbar.  They are not shown in the 
preceding toolbar images due to the width of the complete toolbar graphic.  Pages 5-9 and 5-10 
depict the types of displays that result from using combinations of these four buttons. 
 

 

 
   31     32    33         34                 35 

 
Function Description / Comments 

31 3D Waterfall 
View 

 

Used to bring up a 3D Waterfall display. 

32 Frequency or 
Orders 
Slice View  

Brings up a display for a chosen frequency.  This is a “slice” of 
the waterfall or order tracing, taken at a given frequency (or 
order). 

33 Spectrum 
Display Split 
View  

Brings up a standard spectrum display plus allows for a second 
display, either 3D Waterfall or Frequency Slice, but not both. 

34 Order Tracking 
or Frequency 
View 

 
Order 
Tracking 

This button is used to enable the Order Tracking display mode 
or the Frequency View mode. 

The Order Tracking display mode provides a means of displaying 
data from points which are evenly spaced by RPM, instead of 
increments of time.  On the x-axis scale of the Order Tracking 
display: 1 equals shaft RPM, 2 equals 2 x Shaft RPM, 3 equals 3 
x Shaft RPM, etc.  Order Tracking presents data in the frequency 
domain.  To use Order Tracking a tachometer must be assigned 
to an enabled channel.   

Note that if the <Order Tracking> and <Slice View> buttons are 
both enabled, eZ-Analyst displays the slice view above the order 
tracking view.   The Order Tracking display can be enabled from 
either the Measurement (Real Time) mode or the Playback 
mode.   

  

 
Frequency 
View 

The Frequency View mode is the standard eZ-Analyst spectrum 
view.  When this view is enabled the button appears as shown 
to the immediate left. 

35 Tach Selection 

(for use with 
Order Tracking) 

 
This pull-down selection list of available enabled tachometer 
channels is visible on the toolbar only when Order Tracking 
(Button #34) is enabled.  The selected tach will apply to 
each enabled input channel.  Select “Default Tach” when you 
want to assign each channel to its default tachometer [as 
determined in setup configuration]. 

Note:  Buttons 31, 32, and 33 are enabled for most single-display spectral function views (FV).  They are 
never enabled for time function views as the x-axis must be in frequency.  Any two of these three 
functions can be displayed at the same time.  See table on followig page in regared to button 
combinations and resulting displays. 

In regard to button # 34, to enable Order Tracking click the button after verifying the following: 
o at least one tachometer is assigned to a channel 
o the tach channel is enabled 
o no dual-function window is open, e.g., no FRF (see item # 8).   
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Selecting Displays 
 

Configuration* Buttons Status Example Display 

 

31   32   33      34 

Display Selected: 
Frequency Slice 

31 – 3D Waterfall View 

32 -  Slice View 

33 – Split View 

34 – Order Tracking, or
        Frequency View 

OFF 

ON 

OFF 

Frequency 

 
Frequency Slice View Display 

 

31   32   33      34 

Displays Selected: 

Waterfall and 
Frequency 

31 – 3D Waterfall View 

32 -  Slice View 

33 – Split View 

34 – Order Tracking, or
        Frequency View 

ON 

Grayed-Out 

ON 

Frequency 

 
3D-Waterfall and  

Frequency Display 

 

31   32   33      34 

Displays Selected: 

Waterfall and 
Frequency Slice 

31 – 3D Waterfall View 

32 -  Slice View 

33 – Split View 

34 – Order Tracking, or
        Frequency View 

ON 

ON 

Grayed-Out 

Frequency 

 
3D-Waterfall and  

Frequency Slice View Display 

 

31   32   33      34 

Display Selected: 
Waterfall 

31 – 3D Waterfall View 

32 -  Slice View 

33 – Split View 

34 – Order Tracking, or
        Frequency View 

ON 

OFF 

OFF 

Frequency 

 
3D-Waterfall Display 

 
*You must have at least one cursor selected for slice display.
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Configuration* Buttons Status Example Display 

 

  31   32   33     34 

Display Selected: 

Order Slice View 

31 – 3D Waterfall View 

32 -  Slice View 

33 – Split View 

34 – Order Tracking, or 
        Frequency View 

Grayed-Out 

ON 

OFF 

Order 
Tracking 

 
Order Slice View Display 

 

  31   32   33     34 

Displays Selected: 

Order Tracking and 
Order Slice View 

31 – 3D Waterfall View 

32 -  Slice View 

33 – Split View 

34 – Order Tracking, or 
        Frequency View 

Grayed-Out 

ON 

ON 

Order 
Tracking 

 
Order Tracking and 

Order Slice View Display 

 

  31   32   33     34 

Display Selected: 

Order Tracking 

31 – 3D Waterfall View 

32 -  Slice View 

33 – Split View 

34 – Order Tracking, or 
        Frequency View 

Grayed-Out 

OFF 

Grayed-Out 

Order 
Tracking 

 
Order Tracking and 

Order Slice View Display 

 

 *You must have at least one cursor selected for slice display. 
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Interactive Features of the Plot Display Window 6 

Introduction ……6-1 

Adding and Removing Channels …… 6-1 

Using Cursors …… 6-2 

Additional Functionality …… 6-6 
Copy …… 6-6 
Strip Charts…… 6-7 
XLS Overlay …… 6-8 
Displaying Channel Pairs …… 6-10 
Changing the Display Range ….. 6-10 

Changing Format, Scale, and Grid …… 6-12 

 
 

Introduction 

To change a plot’s display characteristics; it must be the “focus plot.”   For focused plots you 

can use toolbar buttons [listed in the following table]; or use the mouse or key commands to 
make changes to the way in which the data is displayed. 

Focus can refer to the window that is in focus, as well as to a plot that is in focus.  When 
multiple plot windows are open, one is always the “focus window.”   When a window does not 

have focus, its title bar is dimmed.  To change the “focus window,” simply click on title 
bar of the window of interest. 
 

Clicking the “Graph Toolbar” button will bring up a buttons toolbar, which provides a means of 
quickly implementing various plot display functions.  An alternative to using the buttons is to 
“right-click” in a plot display, then use the resulting function menu.  When the graphic toolbar 

is open, clicking the button again will close it.  The buttons are identified and explained in the 
chapter section entitled Using the Toolbar Buttons. 
 

 
 

 
Graphic Toolbar Button 

 

Adding and Removing Channels 

 

To add a channel to a plot . . . 
With your mouse, click and drag a white 
channel box into the plot area. 

To remove a channel from a plot . . . 

With your mouse, click and drag a channel 
box from the right of the plot into the plot 

area. 

 

 

To ADD a channel, click-on the desired 

“channel box” and drag it into the plot region. 

To REMOVE a channel, click on the  

desired “channel box” in this area 

and drag it into the plot region. 
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Using Cursors 

In eZ-Analyst cursors can appear as vertical lines that indicate an X Y axis intersect via an 
asterisk (*), or can appear as an asterisk alone.  Line and Point settings are made from the 

Display Preferences window (following figure) which is accessed from the Edit Pull-down 
menu.  The window also allows you to change settings for cursor colors, the number of 
cursors to be used in Peak and FreeForm modes, and select the desired type of cursor 
movement. 

Display Preferences Window, Areas Affecting Cursors 

 

 

The graph toolbar, discussed in chapter 5, includes a button, which permits the user 
to cycle through cursors by function.  Each click of the button cycles to another type 
of cursor function: No cursor, Single, Dual (Band), SideBand, Peak, and FreeForm. 

Note: Another method of choosing a cursor, as opposed to using the cursor button, 
is to right-click on the plot region and select “cursor” from the resulting pop-
up window. 

 

 

The toolbar includes an annotation button which is similar in appearance to the 
cursor button.  The annotation button cycles through the following: No annotation, 
frameless annotation, and framed annotation.   

 

 

Tip: If annotations or cursors are not visible, check the color settings in the Display 

Preferences window to ensure that you are not making use of, for example, a white 
foreground on a white background.   

 
 

Cursor-1, 2, and 

nX boxes are 

used to set cursor 

colors. 

 
 
 
 
 
 
 
Sets the 

Annotation 

frame color. 

The “Line / Point” toggle 

buttons are use to set the 

cursor’s appearance to a full 

line with an X Y intersect point, 
or to a single intersect point. 

 

 

 

Sets the Annotation text color.  

If you do not see the 

annotation, check the color 

setting, it is likely the same as 

your background or frame color. 



eZ-Analyst 988191 Interactive Plot Display    6-3 

Analysis of a Cursor Annotation Frame 

 

 

Close Annotation Frame   

Move Cursor* 
 

 

Second Channel 
(The bold indicates it 
is the channel being tracked) 

 

 

Harmonic Cursors 
(for second channel) 

 

 

  

* The “Move Cursor” pointers can be used to move the cursor one unit in the indicated direction, as follows: 

    a) For Frequency Plots: one spectral line per click. 
    b) For Time Plots: one sample per click. 

 

Points to note: 

 

The highlighted channel will be tracked in slice view; thus if channels are changed during 
tracking, the resulting display will be misleading as there will be no distinction between 
channels.  For example, displayed data for channel 2 could erroneously be interpreted as 
data for channel 1 and visa versa. 

 

 

For Order Tracking, it is highly recommended that you enter the order value manually via 
keystroke, as opposed to dragging or jogging the cursor.  Manual keystroke entry will 
result in better accuracy for Order Tracking. 

 

If desired, you can use scientific notation to enter a cursor value. 

After entering the new value, press the PC keyboard’s <Enter> key to accept the new value and close the 

cursor frame. 

After entering the new value, if you decide that you want to keep the value as it was, press the PC keyboard’s 
<Esc> key to close the cursor frame without accepting the new value. 

 

 

Type of Cursor(s) 
 
Channel Identification 
 
Channel Main Cursor 
  (Right-click to enter a value) 
   Brings up box for value entry 
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You can “Right-Click” in the Plot Region and then select a desired cursor function.  In the following 

figure, a Harmonic cursor is being selected. 

 

Selecting a Cursor Type 

 

 Illustrated examples of different cursor types and related “X” and “Y” annotations follow. 

 

Cursor Off – Turns all cursors off. 

Single Cursor – Provides a single cursor that applies to one channel.  To change the channel 
that the cursor applies to, simply click on the desired channel’s channel box (or its plot line). 

 

 

 

Dual Cursors (also referred to as Band Cursor) – Provides two cursors that apply to one 
channel.  Note that if the second cursor is not seen it is either at the far left of the x-axis or 

the same color as the plot background.  Both cursors can be repositioned. 

 

Dual Cursor (Band Cursor) 

 

SideBand – Used for one channel trace.  Results in several cursors spaced at even intervals 

on both sides of the primary cursor.  With the use of Annotation button values will be shown 
for all cursors. 

Click on the channel 

that you want to 

assign the cursor to. 
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Side Band Cursors 

 

Harmonic – Used for one channel trace.  Results in several cursors positioned to the right of 
the primary cursor and at intervals that are at twice the x-axis value of the primary cursor.  
For example:  When the primary cursor is at 100 Hz, the first harmonic cursor will be at 200 
Hz, the second at 400 Hz, the third at 600 Hz, etc.  Moving the primary cursor to 400 Hz 
would result in the first harmonic cursor residing at 800 Hz, the second at 1200 Hz, etc.   
With the use of Annotation, values will be shown for all cursors. 

 

The Main Cursor & 5 Harmonic Cursors  

 

Peak – Used for one channel trace.  This selection will set up to 20 cursors (according to the 

cursor setting in Display Preferences) and automatically position them to the highest peaks 
on the trace.  Note that the Annotation frame will only provide X and Y values for up to 6 
cursors. 

 

FreeForm – Used for one channel trace.  This selection will set up to 20 cursors (according 
to the cursor setting in Display Preferences).  The user can move the freeform cursors to any 
desired points on trace.  Note that the Annotation frame will only provide X and Y values for 
up to 6 cursors. 
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Additional Functionality 

Copy  [No associated toolbar button] 

 

 

To Open the Copy Menu:  Press “D” + “C,” 
then release the keys.  The Copy selection 
will be highlighted. Press “Enter.” 
Next, use the down arrow key to select the 
item you desire to copy: Data, Plot 
Window, or Screen, then press “Enter.” 

You can paste the copied item into other 
applications.  For example, plotted data 
can be copied into Notepad, Word, or 
Excel for use in reports or in the case of 
Excel further calculations. 

The plot window and full screen can be 

copied and then pasted into any 
application that accepts graphics, such as 
MSPaint or Word. 

 

Plot Window Data  
Copied and Pasted into Word 

 

 

  

  

 

When you want to export data from windowed time plots, you 

should use the export function in lieu of the copy function. 
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Strip Charts   [No associated toolbar button] 

 

Upper Plot Display - Strip Chart with 4 Traces for 1 Channel  
Lower Plot Display - Time Function View 

 

To add a strip chart, open the Window pull-down menu and select “Add Strip Chart.”   

A strip chart has two display modes.  These are  
Single-Channel and Multi-Channel. 

To select the strip chart’s mode: 

1. Right-click within the strip chart. 

2. Position the mouse-cursor over the text “Display 
Mode.” 

3. Select Single Channel of Multi-Channel, as desired.  

 

Single Channel – When this mode is selected the strip chart will show 4 traces for a single 
channel.  The traces are for maximum values, minimum values, the mean, and RMS.  The top 
plot display in the preceding figure illustrates the single channel mode. 

Multi-Channel – When this mode is selected the strip chart will show one or more channels, 
as determined by the user.  When in multi-channel mode, only traces of the maximum values 

for each channel will be displayed.  An example of a strip chart with two channels follows. 

 
Strip Chart, Multi-Channel Mode 
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Overlays of XLS Files 

eZ-Analyst allows you to overlay up to 15 Excel (XLS) files within a function view, providing that 
the following conditions are met. 

 Only one channel is displayed. 

 The data type is in agreement with that in the view; e.g., if the original channel is 
octave then the channels for the overlay must include octave. 

 The channel numbers must be in agreement; e.g., if the original channel is channel 2, 

then the XLS files for the overlay must also include channel 2. 

Traces are overlaid along the Z-axis such that overlay 01 is always directly over the original 
trace and the higher trace numbers are always layered on top of the lower ones.  (See figure). 

The Concept of Trace Overlays 

 

To overlay one or more Excel files: 

1.  “Right-Click” on the channel button. (See following figure). 

2.  Select “Overlay XLS File.”  The “Select Microsoft Excel. XLS Worksheets for Plot 
Overlays” dialog will open.  The dialog box is depicted on the following page. 

3.  Browse for the applicable files.  Remember that the file’s data type and channel number 
must match that of the channel in the function view.  However, if they do not, you will 
be notified by a message box. 

 

Preparing to Overlay XLS Files for Channel 1 

 

 

After an Excel Overlay has been made, making changes to differential 

settings, integral settings, Hz or CPM axis will not result in an update to 
account for the changes. 

  

Overlay files only work on 2-dimensional plots.  They cannot be applied to 
Display 988191 eZ-Analyst 

 
Waterfalls. 
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Selecting and Arranging XLS Files for Overlay Order 
 

4.  Select and open the desired XLS files.  Then arrange them in the preferred ranking 
order.  The following notes apply. 

 Counting the original, up to 16 traces can be displayed; i.e. the original plus 
up to 15 overlays. 

 If an XLS file is compatible, it will overlay onto the display. 

 If an XLS is of the wrong type, wrong channel number, or would cause you to 
exceed the limit of 16 displays, a message box will inform you of the situation. 

 Traces can be moved up or down in ranking order in the “Selected XLS files 
list.” This is accomplished with the <Move Up> and <Move Down> buttons.  

See preceding figure.   

 XLS files can be added to or deleted from the “Selected XLS files list” list via 
the associated buttons. 

 The <Reset List> button clears the list of XLS files and allows you to create a 
new list. 

5.  After you have completed your selection and have positioned the XLS filed in the 

desired order, click the <Ok> button. 
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Displaying Channel Pairs  

A channel pair is a reference channel and a response channel used to display a dual channel function, such 
as an FRF.   

In the Input channel configuration panel, set at least one channel as a reference channel.  After you click OK 
and look at the channel buttons in the main window, you will notice that each reference channel now has a 
bold number.  One of them also is underlined.  That channel will be used as the reference channel for any 
dual function displays.   

To change to another reference channel, right click on the channel of interest.  It will now be underlined. 

 

All channels are response channels, even those that have been designated as 

reference channels. 

 

Changing the Display Range 

To change the maximum or minimum range value:  Left-click on upper or lower scale value that is to be 
changed, then enter the new value.  An example follows. 

 

 

 

To change the X-Axis:  Hold down the <Ctrl> key, at the same time, left-click and drag the mouse cursor 

horizontally on the plot.  Two vertical cursor lines will define the new x-axis end points. 

  

 

In this example, the cursor and PC 

keyboard were used to change the 
maximum scale value from 3.000 
volts to 3.800 volts.  
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To change the Y-Axis:  Hold down the <Alt> key, at the same time, left-click and drag the mouse cursor 
vertically on the plot. Two horizontal cursor lines will define the new Y-axis end-points.  

  

 

To simultaneously change the X & Y Axes:  Hold down the <Ctrl> and <Alt> keys, at the same time, 
left-click and drag the mouse cursor diagonally on the plot.  A rectangle will define the new area of the plot. 
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Changing the Plot’s Format / Scale / Grid   

Right-Click on the plot’s border to open a popup menu (see figure).  If you want to change the 
y-axis, right-click on the plots left border.  If you want to change the x-axis, right-click on the 

plot’s bottom border. 

 

 

Changing the plot Format, Scale, or Grid affects the display only. 
It does not change the real data. 

 
 

Format   

The Format menu allows you to change the axis format of the plotted data.  Choices are 
Linear, Log, and dB (valid on for the y-axis). 

Scale 

The Scale menu allows you to change the plot scale to AutoScale, FixedScale, or Manual.   
AutoScale ensures that all the captured data is visible on the plot. 

Grid   

The Grid menu allows you to place and remove grid lines from the graph of plotted data.  You 
can also turn the grid on and off by pressing the “G” hot key. 
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Waterfalls, Order Tracking, & Slice Views                           7  

 
Note: Applies to most single-display spectral views. 

 

 

3D Waterfalls …… 7-2  

Order Tracking …… 7-7 

Selecting Displays …… 7-8  

Using Spectrum Cursors …… 7-11 

   

 
 

3D Waterfall Plot 

 

 

TIP: To enhance 3D waterfall performance you can do one or more of the 
following: 

o increase PC processor speed 

o increase PC memory 

o display fewer waterfalls 

o use fewer spectral lines 

o lower the number of records 

o use fewer frequency slices 
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3D Waterfalls 
The following features apply to the 3D Waterfall displays for each spectral FV that supports the waterfall 
function.  More detailed information follows shortly. 

o Display rotations via degrees of latitude and longitude.  Includes six user-definable menu 
presets for customizing waterfall views. 

o 3D plot cursor to display the value at a designated x, y, z plot coordinate. 

o Configurable number of spectrum records. 

o Automatically tracks changes made to the display’s scale and axis. 

o Includes Auto and Log scaling. 

o Decimation of spectrum records.  

o Tracking of averaged spectrum records. 

o 3D display of spectrum single, dual, harmonic, sideband, and free form cursors. 

o Highlighted spectrum of current record in playback mode. 

o Individual control of 3D surface plot and cursor trace transparency. 

o Choice of 3 color modes for 3D surface plot. 

 

 
The Waterfall configuration dialog is accessed by right clicking the mouse over the 3D Waterfall plot.  This 
brings up the Waterfall context menu (right-hand figure).  The menu allows you to display the Spectrum 
Waterfall Configuration dialog box.  It also lets you select the default plot rotation or any one of up to six 
user-defined chart rotation settings. 

The Spectrum Waterfall Configuration dialog lets you control how individual Waterfall and Frequency 
Slice data views will appear and behave.  Each Function View window can have its own Waterfall and 
Slice data views. 

 

                  Waterfall Configuration Menu                                     3D Waterfall Display 
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Spectrum Waterfall Configuration Dialog Box 

 

The dialog box is composed of 4 panels: (1) Size & Position, (2) Plot Appearance, (3) Display Preferences, 
and (4) Waterfall Rotation Presets.  A discussion of each follows. 

 

Size & Position Panel 

Use this group of controls to set the plot rotation, appearance, and operation.   

Latitude and Longitude inputs allow you to set or view the current rotational position of the 3D Waterfall 
plot.  With the configuration dialog visible you can rotate the waterfall using your mouse.  Latitude and 
Longitude values [from 0 to 359 degrees] track the position of the waterfall. 

Just below the Latitude and Longitude inputs is the waterfall surface plot setting for Transparency %.   
The range of percentage values runs from 0 to 100.  A value of “0” (zero) results in no transparency. 

The Display Records parameter controls the number of records that are cascaded together in the waterfall.  
A large number of records produce more resolution in the waterfall, but is offset by a reduction of 
performance in updating the plot.   You can adjust the eZ-Analyst waterfall record setting between 10 and 
256 records per plot. 
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The Skip Count setting allows you to decimate the data that would be displayed in the waterfall plot.  A 
Skip Count setting of 3 only displays every third record.   A Skip Count value of 1 displays every record.  

In addition to the Skip Count, you must select [by radio button] to have a count that 
is either “One based skip” or “Zero based skip.”  Selecting “One based skip” 
results in plotting the first record followed by a skip of the number of records 
indicated in the Skip Count numeric field.  For example, a One based skip count of 

“3” will plot the 1st, 4th, 7th, 10th …etc records.   A Zero based skip count plots records that are multiples of 
the Skip Count.   For example, a Zero based skip of “3” will plot the 3rd, 6th, 9th, 12th  …etc records. 

There are two parameters that control the appearance of the Frequency Slice traces that are drawn in the  
3D Waterfall plot.   These are: Line Width and Transparency %.   Line Width is the thickness of the traces 
in pixels.  Transparency % controls the opaqueness of the lines.  A value of “0” means no transparency. 

The Size & Position panel includes two buttons.  The <Set Default Rotation> button sets the plot rotation 
to the default value.  The <Set Above Default Values> button applies default values to the Size & Position 
panel numeric fields. 

All settings in the Size & Position panel operate immediately on the waterfall plot, with the exception of 
Display Records, Skip Count & Skip Count Base selection settings. 

 

Plot Appearance Panel 

The Plot Appearance group provides three options that allow you to choose how you 
would like the 3D Waterfall surface plot to be drawn.  You have your choice of 
viewing the plot as a Color Spectrum, Color Shading, or Wire Frame. 

 

The Color Spectrum selection draws the plot as a rainbow of colors from violet at the lowest value to red 
at the highest. 

Color Shading draws the plot as a color gradient from darkest at the lowest value to 
lightest at the highest.  The color used for the gradient is the color of the channel in the  
Spectrum plot.   

Wire Frame plotting renders the plot as a grid of black lines. 

 

Display Preferences Panel 

This group of settings allows you to control various aspects of how the 
3D Waterfall plots behave. 

The Log Scale check box switches the Waterfall plot Logarithmic 
display mode on and off. 

The Auto Scale check box switches the Waterfall plot in or out of the 
automatic scaling mode.  When the check box is unchecked, you can 
enter the upper and lower manual scale limit values that will be applied 
when Auto scaling is not in effect.  

Show Waterfall Frequency Slices will show or hide the Spectral line 
plots in the Waterfall plots.  The Frequency Slices are defined by the spectral lines associated with the 
cursors that are positioned in the Spectrum plot window.   Turning off the Frequency Slice plots can 
improve performance when rendering the Waterfall. 

Frequency Slices use cursor colors will change the colors of the Frequency Slice plots in the Waterfall.  
When left unchecked, the slice plots use the channel colors as defined in the eZ-Analyst preferences dialog.   
When checked, the slice plots will assume the colors of the cursors as they appear in the Spectrum plot 
window. 
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Show Waterfall 3D Cursor will show or hide the Waterfall plot 3D 
cursor.  The 3D cursor appears as a point in the plot that can be dragged 
anywhere in the 3D space occupied by the virtual box that makes up the 
waterfall plot.  Any point in this space will represent a value at a specific 
Record number and Spectral Line.  If the 3D cursor is made visible, the 
mouse pointer will change to a hand when the pointer is hovering over 
the cursor.  You can then click and drag the cursor to a specific Record 
and Spectral line.   If you just click on the cursor, you can then use the 
Up, Down, Left and Right arrow keys to position the cursor within the 
waterfall plot. 

 

Reset on start of measurement  applies to Measurement mode only.  It will automatically clear any 
previous plot data from the waterfall and frequency slice plots when you get new data by pressing the 
Single, Continuous or Record buttons. 

Auto Skip when averaging readings  is another Measurement mode only property.  If you want the 
waterfall plot to automatically skip the same number of records that you have selected in the Averaging 
group of the Analyzer Tab in the Configuration dialog, check this option.  When selected, if averaging is 
used the waterfall plot also automatically sets Zero based skipping. 

 

Waterfall Rotation Presets Panel 

This feature allows you to define up to six custom named waterfall plot rotation settings.  The names 
assigned to the rotation presets will appear in the popup context menu that is displayed when you right 
click the mouse with the pointer over a waterfall plot. 

 
To assign a waterfall rotation setting to a named preset, perform the following steps: 

1. Right click the mouse over a waterfall plot, and select Waterfall Configuration … 

2. With the waterfall configuration dialog visible click and drag the waterfall plot to the desired 
rotational position.  

You will notice that the waterfall plot Longitude and Latitude position settings track the 
movement of the waterfall plot in the configuration dialog.   

3. If you find it difficult to drag the 3D plot close to the rotational position that you want, you 
can type in the absolute value of Longitude and Latitude into the number entry fields. 

4. Click the mouse pointer in one of the Rotation Preset name fields. 

5. Type in the name that you want to assign to the preset. 

6. Click the <Set Preset> button (see preceding figure) to assign the preset. 

7. To make this rotation preset persist, you must either press the dialog box <Apply> button, or 
press <OK> to close the dialog to save your settings.  
 

Note:  The rotation presets are global to all waterfall configurations.  This is unlike the other 
settings in the dialog that are unique to a single waterfall plot. 



7-6    Waterfalls, Order Tracking, and Slice Views 878193 eZ-Analyst  

In addition to the Waterfall configuration dialog, several Waterfall and Frequency Slice plot options can be 
accessed via keystrokes.  This is done as follows: 

1. Click on the Waterfall plot or Frequency Slice plot to make it the active control. 

2. Click on the designated key to obtain the desired result, as follows: 

[A] –  to toggle in or out of Autoscale mode.  

[L] –  to toggle in or out of the Log display mode. 

[G] – to turn grids “on” or “off” in a Frequency Slice plot.  When the grids are  
turned off the left and right arrow keys will reposition the cursor. 

 

There are four ways in which you can use your PC mouse to alter your view of the 3D Waterfall Plot.  
These include two methods of zooming in or out, one method of repositioning the plot, and one method of 
rotating the plot.  The following illustrate each function. 

There are 2 methods of zooming in or out:  

1st Zoom Method: Hold down the <Alt> key and 
rotate the mouse wheel forward to zoom out, or 
rotate the wheel towards you to zoom in.  

2nd Zoom Method:  Hold down the <Alt> key  and 
drag the mouse up to zoom out, or down to zoom in. 

 

To reposition the plot: 
Hold down the <Shift> key and drag the mouse.  
This moves the plot to a new position. 

To rotate the waterfall plot: 
Drag the mouse to achieve the desired  
angle of view. 
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Order Tracking 
The Order Tracking display mode provides a means of displaying data from points which are evenly spaced by 
RPM, instead of increments of time.  On the x-axis scale of the Order Tracking display: 1 equals shaft RPM, 2 
equals 2 x Shaft RPM, 3 equals 3 x Shaft RPM, etc.  Order Tracking presents data in the frequency domain.  To 
use Order Tracking a tachometer must be assigned to an enabled channel.   

 
Order Tracking Display 
one Window with two views 

If the <Order Tracking> and <Slice View> buttons are both enabled eZ-Analyst displays the slice view above the 
order tracking view, as indicated in the figure.  Order Tracking display can be enabled from either the Measurement 
(Real Time) mode or the Playback mode.   

To enable Order Tracking click the associated button (see figure) after verifying the following: 
o at least one tachometer is assigned to a channel 
o the tach channel is enabled 
o no dual-function window is open   

Only if these conditions are met can you enable the Order Tracking mode. 

When you enable the mode a Tach Selection Listbox appears to the right of the button.  The pull-down list shows all 
tachometers that are assigned and enabled.   From the list, select “Default Tach” or an available Tach Channel.  
When you have more than one input channel and each is assigned to a different default tachometer, select the 
“Default Tachs” option, if you want to maintain default tachometer assignments.  These are assigned in the 
configuration setup.  Selecting “Channel N” from the list will assign all displayed input channels to that tachometer, 
regardless of the default assignments. 
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Selecting Display Options 
Most single-display spectrum function views (FV) offer access to toolbar buttons for selecting optional spectral 
displays.  To access available spectral view options: 

1. Open the desired spectral function view. 
2. Select a Spectrum Display mode. 
3. Click the applicable toolbar button(s). 
Note:  If the buttons are disabled, then the function view does not support the optional spectral view 

feature.  For example: Time, Octave, and Windowed function views do not support the features. 

A review of the related toolbar buttons follows.  Note that the display examples and the status of the 4 associated 
buttons, which were discussed in Chapter 5, are being repeated in this chapter for convenience. 

 
Function Description / Comments 

31 3D Waterfall 
View 

 

Used to bring up a 3D Waterfall display. 

32 Frequency or 
Orders 
Slice View  

Brings up a display for a chosen frequency.  This is a “slice” of the 
waterfall or order tracking, taken at a given frequency (or order). 

33 Spectrum 
Display Split 
View  

Brings up a standard spectrum display plus allows for a second 
display, for example: a 3D Waterfall display or a Frequency Slice. 

34 Order Tracking 
or Frequency 
View 

 
Order 
Tracking 

This button is used to enable the Order Tracking display mode or 
the Frequency View mode. 

The Order Tracking display mode provides a means of displaying 
data from points which are evenly spaced by RPM, instead of 
increments of time.  On the x-axis scale of the Order Tracking 
display: 1 equals shaft RPM, 2 equals 2 x Shaft RPM, 3 equals  
3 x Shaft RPM, etc. 

Order Tracking presents data in the frequency domain.  To use 
Order Tracking a tachometer must be assigned to an enabled 
channel.   

Note that if the <Order Tracking> and <Slice View> buttons are 
both enabled, eZ-Analyst displays the slice view above the order 
tracking view.   The Order Tracking display can be enabled from 
either the Measurement (Real Time) mode or the Playback mode.  

  

 
Frequency 
View 

The Frequency View mode is the standard eZ-Analyst spectrum 
view.  When this view is enabled the button appears as shown to 
the immediate left. 

Note:  Buttons 31, 32, and 33 are enabled for most single-display spectral function views (FV).  They are 
never enabled for time function views as the x-axis must be in frequency.  Any two of these three 
functions can be displayed at the same time.  See table on followig page in regared to button 
combinations and resulting displays. 

In regard to button # 34, to enable Order Tracking click the button after verifying the following: 
o at least one tachometer is assigned to a channel 
o the tach channel is enabled 
o no dual-function window is open, e.g., no FRF.   
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Configuration* Buttons Status Example Display 

 

31   32   33      34 

Display Selected: 
Frequency Slice 

31 – 3D Waterfall View 

32 -  Slice View 

33 – Split View 

34 – Order Tracking, or
        Frequency View 

OFF 

ON 

OFF 

Frequency 

 
Frequency Slice View Display 

 

31   32   33      34 

Displays Selected: 

Waterfall and 
Frequency 

31 – 3D Waterfall View 

32 -  Slice View 

33 – Split View 

34 – Order Tracking, or
        Frequency View 

ON 

Grayed-Out 

ON 

Frequency 

 
3D-Waterfall and  

Frequency Display 

 

31   32   33      34 

Displays Selected: 

Waterfall and 
Frequency Slice 

31 – 3D Waterfall View 

32 -  Slice View 

33 – Split View 

34 – Order Tracking, or
        Frequency View 

ON 

ON 

Grayed-Out 

Frequency 

 
3D-Waterfall and  

Frequency Slice View Display 

 

31   32   33      34 

Display Selected: 
Waterfall 

31 – 3D Waterfall View 

32 -  Slice View 

33 – Split View 

34 – Order Tracking, or
        Frequency View 

ON 

OFF 

OFF 

Frequency 

 
3D-Waterfall Display 

 
*You must have at least one cursor selected for slice display.
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Configuration* Buttons Status Example Display 

 

  31   32   33     34 

Display Selected: 

Order Slice View 

31 – 3D Waterfall View 

32 -  Slice View 

33 – Split View 

34 – Order Tracking, or 
        Frequency View 

Grayed-Out 

ON 

OFF 

Order 
Tracking 

 
Order Slice View Display 

 

  31   32   33     34 

Displays Selected: 

Order Tracking and 
Order Slice View 

31 – 3D Waterfall View 

32 -  Slice View 

33 – Split View 

34 – Order Tracking, or 
        Frequency View 

Grayed-Out 

ON 

ON 

Order 
Tracking 

 
Order Tracking and 

Order Slice View Display 

 

  31   32   33     34 

Display Selected: 

Order Tracking 

31 – 3D Waterfall View 

32 -  Slice View 

33 – Split View 

34 – Order Tracking, or 
        Frequency View 

Grayed-Out 

OFF 

Grayed-Out 

Order 
Tracking 

 
Order Tracking and 

Order Slice View Display 

 

 *You must have at least one cursor selected for slice display. 
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Using Spectrum Cursors 
   

 
Selecting Harmonic Single Cursor 

 
 

 
Selecting Annotation for Cursors 

 
Cursors can be displayed with or without annotation.  If annotation is desired it can be displayed directly on 
the cursor, or it can be displayed in the cursor frame.  In the upper right-hand figure, annotation has been 
selected for display on the cursors.  In this scenario the annotation appears on the cursor, near the point 
where the cursor intersects the waveform. 
 
In the second example [following figure] the annotation has been placed into the cursor frame.  Information 
in the frame appears in a hierarchical tree view.   The left most node is the Channel node.  This provides 
information about the channel.  Under the Channel node is the Main cursor node.  This node represents one 
of the two main cursors that can be viewed in the Spectrum plot.   Under the Main cursor node are the 
Secondary cursor nodes.   In the above example, the Main cursor is located on Spectral Line 100, and the 
harmonic cursors are on the multiples of 100.    

 

Annotation in a Frame 
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If you select the Main cursor node, you can use the Left & Right arrow buttons to move the cursor in the Spectrum 
plot.    Selecting the topmost node in the tree [the one labeled Status View] will automatically expand or collapse all 
of the nodes underneath.  Clicking the “X” button will close the Cursor Frame and set cursor annotations to None. 

The cursor frame can be re-sized and re-positioned as follows. 

 

To move the frame, place the mouse pointer over this area.  The cursor will 
change, allowing you to drag the frame to a new location. 

 

 

 

To re-size the frame, place the mouse pointer over the lower right corner of the 
frame.  The cursor changes shape and allows you to drag the frame dimensions 
to the desired new size.  
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Appendix A - Keyboard Controls for eZ-Analyst       A  
 

This appendix consists of several hot key tables for the benefit of those who prefer to use keys in 
place of mouse/cursor interaction with a GUI.  However, for certain functions, such as changing axis 
scales, a mouse will be needed.  Mouse use is pointed out in the tables, when applicable.   

 
Record / Playback Control 

Keys Function Comments 

p Play Forward ----- 

<Shift> + p Play Backward ----- 

o Step Forward and Record ----- 

<Shift> + o Step Backward and Record ----- 

H Halt Playback ----- 
 

Measurement, Scope, and Generator Control 

Keys Function Comments 

H Halt the measurement ----- 

R Start recording ----- 

S Start Scope Mode (Measurement) ----- 

W Turn the signal generator On ----- 
 

Menu and Window Control 

Keys Function Comments 

Alt + E … 

 

        … C 

 

        … D 

                            
… P 

Opens the Edit Menu. ----- 

Opens the Configuration Window. 
After pressing Alt + E to access the Edit 
Menu, press C. You will need a mouse to 
access all panels.  Also, see Ctrl +M. 

Opens the Display Preferences Menu. 
After pressing Alt + E to access the Edit 
Menu, press D. 

Opens the Playback Setup window. 

After pressing Alt + E to access the Edit 
Menu, press P.  Use the Tab and arrow keys to 
make selections within this window.  Then hit 
<Enter>. 

Alt + F Opens the File Menu. ----- 

Alt + W Opens the Window Menu. You will need a mouse to make selections. 

Ctrl + M Opens the Configuration window. 
You will need a mouse to access all panels.  
An alternative to Ctrl + M is to press C when 
the Edit Menu is open. 

Ctrl + O Opens the Open File Dialog window. 
From within the window, use the Tab and 
arrow keys. An alternative to Ctrl + O is to 
press O when the File Menu is open. 

Ctrl + P 
Presents the Print Dialog window. An alternative to Ctrl + P is to press P when 

the File Menu is open. 

Ctrl +  D 
Presents the Display Menu, also 
referred to as the Plot Display 
Characteristics Menu. 

Refer to the following table for control options 
related to the Display Menu.  
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Display Menu Control 

Keys Function Comments 

D Opens the Plot Display Character-
istics Menu 

Option:  “Right-clicking” the mouse, while the cursor 
is over the plot will also open this menu. 

 

 

D + C  
(3 functions) 

Used to open the Complex Type 
Display Menu. 
This option is only available when a 
function with complex data is displayed.  
Menu choices are: Magnitude, Phase, 
Real, Imaginary, Magnitude + Phase,  
Real + Imaginary, and Nyquist 

Press D + C; release, then press <Enter>.  The 
Complex Type Display Menu will open. Use the arrow 
keys to highlight the type of display, then press 
<Enter>.  

Used to open the Copy Menu. 
Menu choices are: Data, Plot Window, 
Screen. 

Press D + C; release, then use the arrow key to 
select Copy.  After selecting Copy, press <Enter>.   

Used to open the Cursor Menu. 
Menu choices are: Single Cursor,  
Band Cursor, or Cursor Off. 

Press D + C; release, then use the arrow key to 
select Cursor.  After selecting Cursor press 
<Enter>.  

D + F Opens the Display Functions Menu. 
Note that right-clicking on the plot will 
also open this menu. 

Use arrow keys to highlight your selection, then 
press <Enter>.  In some cases you can select the 
first letter of an option to select it. 

D + I Opens the 
Integration/Differentiation Menu. 

Use arrow keys to highlight your selection, then 
press <Enter>. 

D + L Opens the Label / List Menu. Use arrow keys to highlight your selection, then 
press <Enter>. 

D + O Opens the Octave Menu. Use arrow keys to highlight your selection, then 
press <Enter>. 

D + S Opens the Scale Type Menu. 
Menu choices are RMS, Peak, Pk-Pk. 

Use arrow keys to highlight your selection, then 
press <Enter>. 

D + T Opens the Transfer Type Menu. Use arrow keys to highlight your selection, then 
press <Enter>. 

 
 

Plot Display Controls  (Note) 

Keys Function Comments 

Mouse-Click 
Bottom Border 

Change the X-axis in regard to format, 
scale, and grid. 

Right-click on the plot’s bottom border to access a 
menu for changing the X-axis in regard to Format, 
Scale, and Grid. 

Mouse-Click 
Left Border 

Change the Y-axis in regard to format, 
scale, and grid. 

Right-click on the plot’s left border to access a menu 
for changing the Y-axis in regard to Format, Scale, 
and Grid. 

, (comma) Moves the primary cursor left along the 
trace. 

When in Band Cursor mode, the comma moves the 
primary cursor to the left.  

. (period) Moves the primary cursor right along 
the trace. 

When in Band Cursor mode, the period moves the 
primary cursor to the right. 

< Moves the secondary cursor left along 
the trace. 

When in Band Cursor mode, the “<”  moves the 
secondary  cursor to the left. 

> Moves the secondary cursor right along 
the trace. 

When in Band Cursor mode, the “>”  moves the 
secondary  cursor to the right. 

<Shift> Peak search. Press the <Shift> key while depressing the left 
mouse button to search for peaks along the trace. 

Note:  Also see the Display Menu Control Table.                                                                              Continued 
 

 

Reference Notes: 

o For more detailed information, which includes graphics, refer to chapter 5, Interactive 
Features of the Plot Display Window. 

o For Slice View key functions see the last table in this appendix. 
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Plot Display Controls     (Note) 

Keys Function Comments 

A Turns Auto-scale On. ----- 

Alt Expands or contracts the Y-Axis. (a) While holding down the <Alt> key, place the 
cursor at the desired start point of the Y-axis, 
(b) click the left mouse button, (c) drag the 
mouse vertically until the cursor is at the new 
end point of the scale. 

b Bank up. ----- 

<Shift> + b Bank down. ----- 

C Toggles the cursor On or Off; or cycles the 
cursor options as follows (if Band Cursor is 
selected): Adds a Cursor, Adds a second 
Cursor, turns both cursors Off. 

 

When Band Cursor is selected, the “C” key 
cycles through On (add a cursor), add a second 
cursor, and Off. 

Ctrl  Expands or contracts the X-Axis. (a) While holding down the <Ctrl> key, place 
the cursor at the desired start point of the X-
axis, (b) click the left mouse button, (c) drag the 
mouse horizontally until the cursor is at the new 
end point of the scale. 

Ctrl + Alt Simultaneously expands [or contracts] 
both the X and Y axes. 

(a) While holding down both the <Ctrl> and 
<Alt> keys, place the cursor at the desired start 
point on the plot, (b) click the left mouse button, 
(c) drag the mouse diagonally until the cursor is 
at the new end point of the scale. 

 

F2 or Z 
(2 functions) 

Zooms in or out. When you depress one of these keys, while 
dragging with the right mouse button depressed, 
you will zoom in or out, according to the cursor-
defined region.  

Pan along the X-axis, Y-axis, or both. By depressing one of these keys, while dragging 
with the left mouse button depressed, you can 
pan in the direction of the drag. 

F3 Zoom in or out. Use F3 with the left mouse button to zoom in 
our out. 

G Turns Plot Grid On or Off. Toggles the grid to On or Off. 

L Changes the Scale to Linear or to Log. Toggles the scale to Linear or to Log. 

R Start Recording ----- 

S Start Scope Mode (Measurement) ----- 

X Presents the X-Axis Menu ----- 

Y Presents the Y-Axis Menu ----- 

Z or F2 Zooming or Panning. See “F2.” 

Note:  Also see the Display Menu Control Table. 
 
 
 

 

Reference Notes: 

o For more detailed information, which includes graphics, refer to chapter 5, Interactive 
Features of the Plot Display Window. 

o For Slice View key functions see the last table in this appendix. 
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Slice View Control                 Note that the use of keys in this table assumes that the Slice View has focus. 

Keys Function Comments 
<Home> Resets the Playback record 

pointer to the first record. 
 

----- 

A Autoscale / Manual Scale Toggles between Autoscale and Manual scale.  Manual 
scale values are the ones you enter into the Value Input 
boxes near the ends of the X & Y axes.  The Value Input 
boxes [for minimum or maximum values] open when you 
click to the left or below the plot window. 

L Linear Scale / Log Scale Toggles between Linear (Lin) and Log scaling. 
 

 
R Reset Resets the plot display window and the playback record 

pointer to the first record. 
 

, (comma) Move Left, 1 Record Moves the record pointer one record to the left. 
 

. (period) Move Right, 1 Record Moves the record pointer one record to the right. 
 

+ Zoom-in Zooms in to the display in the area around the record 
pointer. 
 

- Zoom-out Zooms out from the display. 
 

<Ctrl> Manual Zoom Hold down the <Ctrl> Key then click and drag the mouse 
in the plot window to zoom in on the area covered by the 
drag operation. 

Mouse 
Click 

Y and X axes, Scale 
minimum and maximum 

To change the x or y scale values of the Slice View 
display: Click the mouse with the cursor positioned in the 
x or y axis border region.  You must click near the 
maximum or minimum value of the associated axis scale.  
A value box will open.  Key in the newly desired minimum 
or maximum value for x or y.  Repeat for other axes 
values as desired. 
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Glossary  

 

 

Accelerometer 
A type of transducer that produces an output voltage proportional to acceleration. 

Acquisition 
A collection of scans acquired at a specified rate as controlled by the sequencer. 

Analog Signal 
A signal of varying voltage or current, resistance, temperature such as the output of a sensor. 
Many analog signals are in the form of sine waves.  

Apparent Mass 
Force/Acceleration.  A transfer type that is the reciprocal function of Inertance.  Apparent 
Mass is derived by taking the inverse of the magnitude, and multiplying the phase angle by “-
1.” 

Auto-Spectrum Function 
A single-channel display function.  Displays the square of the magnitude of the complex (one-
side) Fourier spectrum of x(t).  Autospectra are calibrated so that if A is the peak amplitude of 
a sinusoidal signal x(t), then the autospectrum has the value A*A  (or use A power 2)  at the 
sinusoidal frequency. 

Averaged Time Function 
A single-channel display function.  Displays a time domain waveform of averaged, sampled 
data scaled in either Volts or Engineering Units (EUs). 

Bank 
A set of response channels. 

Blackman-Harris 
An FFT window function.  This window function was designed to provide the minimum side 
lobe level of any three-term window.  Compared with the very similar Hanning window, it has 
a slightly wider main lobe but much better dynamic range.  This window has the smallest 60 
dB bandwidth of any window listed.  The Blackman-Harris window may be preferred over the 
Hanning for measurements requiring better dynamic range. 

Channel 
A single input, or output for the acquisition device.  In a broader sense, an input channel is a 
signal path between the transducer at the point of measurement and the data acquisition 
system.  A channel can go through various stages (buffers, multiplexers, or signal conditioning 
amplifiers and filters).  Input channels are periodically sampled for readings.  An output 
channel from a device can be digital or analog. Outputs can vary in a programmed way in 
response to an input channel signal. 

Coherence Function 
A dual-channel display function.  At each frequency, the coherence is a value between 0.0 and 
1.0, which indicates the degree of consistent linear relationship between two signals during 
the averaging process.  A value of less than one indicates that phase cancellation occurred 
during cross-spectrum averaging, which may be due to uncorrelated noise on one or both 
signals or to a nonlinear relationship between signals. 

Compliance, also referred to as Receptance 
Displacement/Force. The transfer type function is calculated by dividing the cross spectrum of 
the channel pair by the auto spectrum of the reference (force) channel. 

CPM 
Cycles per Minute. 60 CPM is equal to 1 Hz. 
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Cross Spectrum Function, or Cross Function 
A dual-channel display function in the frequency domain.  It is equal to the product of the 
complex Fourier spectrum of y(t) (the numerator or first named channel) times the complex 
conjugate of the Fourier spectrum of x(t) (the denominator or second named channel).  The 
special case y=x yields the auto spectrum.  Averaging of these functions (frequency-domain 
averaging) forms the basic foundation on which virtually all other multi-channel, frequency-
domain analysis is built.  The cross spectrum is calibrated in units of (peak EUy) (peak EUx). 

Crosstalk 
An undesired transfer of signals between system components or channels.  Crosstalk often 
causes signal interference, more commonly referred to as noise. 

dB 
Decibels.  A logarithmic unit of amplitude for noise or vibration.  While there are several 
definitions to dB, in our application we are using dB to express the ratio of the magnitudes of 
two quantities equal to 20 times the common logarithm of the ratio. 

 dB = 20 log (x/dBEUref) 
In this equation, “x” refers to the value of the voltage being measured and “dBEUref” 
refers to the reference voltage.  

Decay % 
Decay %, also referred to as Response Decay Percent, is used when an Exponential Window is 
applied to the FFT Response Channel. It is the weighting factor present at the last block value. 
For example, a decay of 5% means that the weighting factor at the beginning of block is 
100% and that the weighting factor of the last block is 5%.  In other words, the weighting 
factor dropped (decayed) to 5% over the length of block. 

Digital 
A digital signal is one of discrete value, in contrast to a varying signal.  Digital data is 
represented by combinations of binary digits (0s and 1s). 

Dynamic Stiffness 
Force/Displacement. A transfer type that is the reciprocal function of Receptance.  Dynamic 
Stiffness is derived by taking the inverse of the magnitude, and multiplying the phase angle 
by “-1.” 

EU 
Engineering Unit. 

Excitation 
Some transducers  [e.g. strain gages, thermistors, and resistance temperature detectors 
(RTDs)] require a known voltage or current input in order for the sensor to operate.  This 
known input is called the Excitation. 

Exponential Weighting Window 
An exponential weighting window is equal to 1.0 at the beginning of the block and decays 
exponentially to a smaller value at the end of the block (see Decay % ).  Exponential is used 
only with transient data that is captured with pre-trigger to assure that the initial values in all 
data channels are very close to zero.  Exponential can be used with all transient excitation 
methods in order to force the signals to decay close to zero, even if the block length is not 
sufficient to capture all of the naturally occurring response.  If the data decays naturally to a 
low amplitude [within the block], so that leakage is not significant, exponential windowing can 
improve the signal-to-noise ratio by giving reduced weight to the very low-amplitude data at 
the end of the block. 

Fast Fourier Transform (FFT) 
An efficient technique for calculating the frequency of components in a time-domain waveform 
based on digitized voltage measurements.  The result is a display of amplitude versus 
frequency and phase versus frequency. 

Fast Fourier Transform (FFT) Reference Window is applied to the output of a transducer 
to avoid collecting extraneous signals caused by an excitation device, such as an impulse 
hammer.  Possible selections are:  Response, Rectangular, and Cosine Taper. 
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Fast Fourier Transform (FFT) Response Window 
The FFT (Response) window is a time-domain, weighting window.  A response window is 
usually applied to data to reduce FFT leakage errors.  FFT theory assumes that the signal 
being analyzed is periodic in the data acquisition block.  When this is not the case, energy 
from a signal at a specified frequency can leak into nearby spectral bins causing spectral 
amplitude inaccuracies.  Applying a windowing function controls, but doesn’t completely 
eliminate, the error by multiplying each data frame by a suitable time-domain weighting 
window. This calculation reduces the amplitude/magnitude of the data near the ends of each 
data frame prior to performing the FFT and forces the data to be nearly periodic in the 
window, thus reducing leakage errors. Response window options include Flat-Top, Blackman-
Harris, and Hanning. 

Flat-Top Window, also written as Flattop Window 
An FFT window function that provides accurate measurement of peak-amplitude.  Compared to 
the very similar 4-term “Max Flat Top,” this window also has a very low peak amplitude error, 
and its frequency resolution is somewhat better.  Its side lobes are considerably higher.  Its 
effective noise bandwidth is still almost twice that of the Hanning window, therefore this 
window is used mainly to measure accurate peak amplitudes of discrete spectral components 
that are known to be separated by several spectral lines. 

Free Run (Free Running) 
A state in which a data acquisition device acquires the next block of data when it has finished 
the previous block.  Free Run is a continuous collection of data, with a constant display 
update. 

Frequency-Domain 
A domain where amplitudes are graphed in relation to frequency.  Also see Time-Domain. 

Frequency Slice 
A 2-dimensional plot of amplitude versus time.  A frequency slice consists of the amplitude 
values of a specific frequency of multiple records.  The plot can be seen in a 2-dimensional 
Frequency Slice Window; or optionally, can be selected for viewing within a 3D Waterfall plot. 

FRF (Frequency Response Function) 
A dual-channel function for the single-input, single-output (SISO) frequency response function 
between two specified input channels.  FRF is the averaged cross-spectrum divided by the 
averaged autospectrum of the input (the second named channel). 

FSV (Full Scale Volts) 
Maximum FSV refers to the high-end limit for the input voltage. Minimum FSV is the low-end 
limit for the input voltage. 

g 
Acceleration due to gravity.  In relation to earth’s gravity,  
1 g = 980 cm/sec2, or 32.2 ft/sec2. 

Gain 
The degree to which a signal is amplified (or attenuated) to allow greater accuracy and 
resolution; can be expressed as ×n or ±dB. 

Hanning 
An FFT window function.   The Hanning window is typically used to analyze continuous signals.  
The Hanning function reduces leakage and provides a relatively good compromise between 
frequency resolution and amplitude accuracy. 

Hz 
Hertz, one cycle per second.  Also, see CPM. 

Impedance 
Force/Velocity.  A transfer type that is the reciprocal function of Receptance.  Impedance is 
derived by taking the inverse of the magnitude, and multiplying the phase angle by “-1.” 

Inertance 
Acceleration/Force. The transfer type function is calculated by dividing the cross spectrum of 
the channel pair by the auto spectrum of the reference (force) channel. 
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Integration/Differentiation 
Integration/Differentiation is for display purpose only and does not modify the data.  It is only 
active when frequency domain data is displayed.  Select single or double integration, single or 
double differentiation or none.  Make your selection on the popup menu.  Differentiation and 
Integration are calculated by dividing each element of the function by (jw)^n, where j is the 
square root of -1; w is the product of 2 pi times the frequency of the block element; and n is 
an integer from +2 to -2. 
 n = 2 is double integration 
 n =  1 is single integration 
 n =  0 has not effect 
 n =  -1 is single differentiation 
 n = -2 is double differentiation. 

If the signal is acceleration, then single integration (Int1) results in velocity, and 
double integration (Int2) results in displacement. 
If the signal is displacement, then single differentiation (Diff1) results in velocity, and 
double differentiation (Diff2) results in acceleration. 

Isolation 
The arrangement or operation of a circuit so that signals from another circuit or device do not 
affect the isolated circuit.  Isolation usually refers to a separation of the direct link between 
the signal source and the analog-to-digital converter (ADC). Isolation is necessary when 
measuring high common-mode voltage. 

Leakage 
Leakage refers to an error in the FFT process due to the use of finite time blocks that do not 
match at the blocks’ ends.  At lower amplitudes, leakage results in a smearing of frequency 
lines.  FFT window functions, such as Hanning, can be used to minimize the error that is 
introduced by leakage. 

Linearization 
Some transducers produce a voltage in linear proportion to the condition measured.  Other 
transducers (e.g., thermocouples) have a nonlinear response.  To convert nonlinear signals 
into accurate readings requires software to calibrate several points in the range used and then 
interpolate values between these points. 

Mobility 
Velocity/Force. The transfer type function is calculated by dividing the cross spectrum of the 
channel pair by the auto spectrum of the reference (force) channel. 

Nyquist Plot 
A Nyquist plot is one method used to simultaneously display real and imaginary data.  The 
real numbered data is plotted on the X-axis and the imaginary numbered data is plotted on 
the Y-axis.  Line segments are used to join consecutive points.  From the perspective of  
basic vibration theory, a Nyquist plot of a mobility function should trace out a circle  
(counter-clockwise) as frequency is increased through an isolated structural resonance. 

Octave 
The interval between two frequencies, where one frequency is twice the value of the other.  
For example, frequencies of 500 Hz and 1 kHz are one octave apart; and 1 kHz and 2kHz are 
one octave apart.  Many sounds are broad band, having components that are continuously 
distributed over a range of frequencies.  The spectrum of such a sound can be approximated 
in terms of a series of octave band or one-third octave band pressure levels.  A band is 
designated by its center frequency, f0, which is the geometric mean of the upper and lower 

frequencies of the band.  (See ANSI/ASC S1.6-1984.) 

PSD Function 
Power Spectral Function.  A single-channel display function.  It is the Fourier Transform of the 
Auto-correlation function.  This normalization should be used with continuous random signals. 

Receptance, also referred to as Compliance 
Displacement/Force. The transfer type function is calculated by dividing the cross spectrum of 
the channel pair by the auto spectrum of the reference (force) channel. 
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Response Decay Percent 
See Decay %. 

Sample (reading) 
The signal value that is observed on a channel at an instant in time.  When triggered, the 
analog-to-digital converter [of the data acquisition device] reads the channel and converts the 
sampled value into a digital representation. 

Scan 
A series of measurements across a pre-selected sequence of channels. 

Spectral Plot 
A plot of a record of data in the frequency domain. 

Spectrum Function 
A dual-channel display function.  Displays averaged linear spectrum computed as the square 
root of the averaged autospectrum.  This function is calibrated in peak engineering units (EU). 

Time-Domain 
A domain where amplitudes are graphed in relation to time.  Also see Frequency-Domain. 

Time Function: 
A single-channel display function.  Displays a time domain waveform of sampled data scaled in 
either Volts or Engineering Units (EUs). 

Transfer Type Functions 
Functions that are calculated by dividing the cross spectrum of the channel pair by the auto 
spectrum of the reference (force) channel.  The following are transfer type functions: 
Inertance (acceleration/force), Mobility (velocity/force), and Receptance or Compliance 
(displacement/force).  Reciprocal functions can be derived by taking the inverse of the 
magnitude, and multiplying the phase angle by “-1.”  Apparent Mass (force/acceleration), 
Impedance (force/velocity), and Dynamic Stiffness (force/displacement) are reciprocal 
functions of Inertance, Mobility, and Receptance, respectively. 

Note: Transfer function displays assume that the reference channel is a force channel.  
You MUST define the response channels to be the correct type of data 
(acceleration, velocity, or displacement) that you are acquiring.  These are 
defined in the data type column of the Calibration window.  This allows the data 
to be integrated or differentiated correctly to derive the desired transfer function. 

Trigger 
An event to start a scan or mark an instant during an acquisition.  A trigger can be a TTL 
signal, a specified signal level, a button manually or mechanically engaged, or a software 
command. 

Unaveraged Spectrum 
A display function of the magnitude of instantaneous unaveraged spectrum. 

Waterfall Plot 
A 3-dimensional view of multiple spectral plots. 

Windowed Time 
Time data determined by the FFT Response under the FFT Setup tab (of the Edit menu’s 
Configuration Settings window).  See  Fast Fourier Transform (FFT) Response Window. 
The FFT (Response) window is a time-domain, weighting window.  
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